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Understanding iFIX

The Understanding iFIX manual is intended for all iFIX®   users. It provides an overview of the structure 
and functions of iFIX,   the iFIX WorkSpace, and the iFIX Help and electronic books.

Reference Documents
For related information on subjects discussed in this manual, refer   to the following documents:

 l Setting  up the Environment

 l Building  a SCADA System

 l Implementing  Alarms and Messages

 l Configuring  Security Features

 l Using  Electronic Signatures

 l Creating  Pictures

 l Writing  Scripts

 l Trending  Historical Data

 l Mastering  iFIX

Introduction to iFIX

iFIX®   is a Windows-based HMI/SCADA component of the GE family of software   automation products. 
Based on open, component-based technology, iFIX is   designed to allow easy integration and inter-
operability between your plant   floor and business systems. It includes functional and architectural fea-
tures   that reduce the design time for automation projects, allow simple system   upgrades and 
maintenance, provide seamless integration with third-party    applications, and increase productivity.

The SCADA portion of iFIX provides monitoring, supervisory control,   alarming, and control functions. It 
guarantees the absolute integrity   of data and provides complete distributed networking capabilities. 

The HMI portion of iFIX is the window into your process. It provides   all the tools you need to develop pic-
tures that operators can use to monitor   your process.

This manual covers several fundamental concepts in iFIX:

 l For information on   the structure and capability of iFIX, refer to the System   Architecture and the 
System Functions   chapters. 

 l For information on   the iFIX WorkSpace, refer to the Using   the iFIX WorkSpace chapter. 

 l For information on   managing your nodes, refer to the Managing   iFIX Nodes chapter. 

 l For information on   the electronic books, refer to the Using   the Electronic Books chapter. 

 

iFIX Components 

© 2024 General Electric Company. All rights reserved. 1

env.chm::/envcover.htm
dbb.chm::/dbbcover.htm
alm.chm::/almcover.htm
sec.chm::/seccover.htm
esig.chm::/esigcover.htm
drw.chm::/drwcover.htm
vba.chm::/vbacover.htm
trend.chm::/htdcover.htm
adv.chm::/advcover.htm


At the heart of iFIX is an enabling technology that provides a distributed   architecture. iFIX is built on 
standard technologies, such as ActiveX,   OPC, VBA, and Component Object Model (COM), to provide 
easy integration   of third-party applications across wide area networks and the Internet.  The iFIX platform   
hosts a number of GE and third-party application components, some   of which are illustrated in the fol-
lowing figure. 

iFIX Platform

An important component of iFIX is the iFIX WorkSpace. This interface   organizes all system com-
ponents into one integrated development environment   (IDE). The iFIX WorkSpace allows you to nav-
igate through, access,   and manipulate all the components of your system. 

The iFIX WorkSpace includes two fully-integrated environments   known as configuration and runtime. 
The configuration environment provides   all of the graphic, text, data, animation, and charting tools neces-
sary   to create displays that are attractive, organized, and easy to use and   understand. The run-time 
environment provides the means necessary to view   these displays in real-time. Switching between the 
run-time and configuration   environments allows you to quickly test changes to displays while real-time   
alarming and data acquisition continue.

It is important to note that while you are in the configuration environment,   there is no interruption to your 
process. All the functions that control   and monitor your system, such as alarming, reporting, and 
scheduling,   continue to run in the background. For more information on creating and   viewing displays in 
the iFIX WorkSpace, refer to the Creating  Pictures manual. 

Using iFIX with Other GE Applications

iFIX works with the following GE software applications, as well   as many third-party applications. 

Proficy Historian

Proficy Historian is a high performance data archiving system   designed to collect, store, and retrieve 
time-based information efficiently.   

GE Batch Execution

GE Batch Execution is the high-performance automation application   that lets you model your plant, man-
age recipes, execute batches, create   electronic batch records, and generate reports based on any batch 
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process.   With Batch Execution, you'll have the tools necessary to reduce cycle   time, increase flex-
ibility, comply with regulatory demands, and track   batch production.

GE Plant Applications

Equipment use and downtime are typically tracked and reported as key   performance indicators in man-
ufacturing companies. GE Plant Applications   allows you to accurately report equipment efficiency, and 
extends your   ability to analyze, understand, and address each source of downtime.

View - Machine Edition

The View - Machine Edition OPC Server can provide data directly   into iFIX. You can display this data in 
your iFIX pictures, as you would   with any other OPC data. 

 

Enabling Technologies 

As the solutions required by end users and system integrators become   more complex, it becomes 
increasingly difficult to anticipate the individual   needs of each customer. With this in mind, we incor-
porated the following   industry-standard technologies into iFIX to provide a development environment   
that you can tailor to meet your specific requirements: 

 l OLE   for Process Control (OPC)

 l Visual   Basic for Applications (VBA)

 l ActiveX

 

OLE for Process Control (OPC) 

OPC is a software standard designed to provide automation applications   with easy access to industrial 
plant floor data. We have led the development   of OPC through our active role in the founding of the OPC 
Task Force,   a consortium of leading industrial automation suppliers formed to speed   the development of 
an OLE-based communication standard. The goal of OPC   is to define a standard interface based on 
Microsoft's Component Object   Model (COM) technology that allows greater interoperability between 
automation   and control applications; control devices; and business and office applications.   

Using OPC, the iFIX WorkSpace can communicate directly with   any OPC server. You can add an OPC 
server to your iFIX node using the   Data Server Installer program. This utility, located in the Tools sub-
folder   of your iFIX Windows program folder, lets you add, modify, and   remove OPC servers from the list 
of data servers available to iFIX. For   more information about the Data Server Installer, refer to the Data 
Server Installer Dialog Box topic. 

If you need to communicate with a remote OPC server, specify the machine   where the remote server 
resides in the Machine Name field when you add   an OPC Server using the Data Server Installer. Altern-
atively, you can    also use the OPC Client driver to communicate with a remote OPC server.   This driver 
lets you communicate with any local or remote OPC server and   store the information in the process data-
base.
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Visual Basic for Applications (VBA) 

VBA is a powerful scripting tool that is fully integrated into iFIX   to let you quickly and easily automate 
operator tasks and create automation   solutions. VBA scripts can be as simple or complex as you need 
them to   be, allowing you to add custom functionality and extend iFIX as needed   to accommodate your 
automation strategy. Its powerful and easy-to-use   development environment allows you to reuse exist-
ing Visual Basic code.   

VBA replaces the scripting engine used in previous versions of FIX to   provide a complete, integrated 
development environment that is familiar   to millions of developers already using Visual Basic. It 
provides virtually   unlimited power and extensibility for accessing other iFIX components   and external 
objects and data. The GE implementation of VBA provides:

 l Access to all exposed   properties, methods, and events for iFIX objects 

 l Support for multiple   data sources, including the iFIX process database, any OPC server, prop-
erties   of other objects, and SQL databases 

 l ODBC support 

 l Support for ActiveX   controls 

 l Script Authoring   Wizards and iFIX commands to help you write scripts for common tasks 

 l Secure Containment™ for third-party   ActiveX controls 

The iFIX WorkSpace provides access to the Visual Basic Editor   (VBE), a built-in editor and debugger 
that allows you to view, halt, suspend,   and resume active scripts. In the VBE, you can write scripts for 
all iFIX   objects, create VBA forms, access any available data source, display objects   using the Object 
Browser, and debug your scripts. You can also use VBA   to write scripts for toolbar buttons and write 
scripts for entries in   the Scheduler. 

iFIX exposes a global library of common global subroutines that can   be easily changed in one place. It 
provides full support for thousands   of commercially available objects and ActiveX controls. 

This implementation of VBA includes a powerful find and replace   feature, a high speed persistence fea-
ture that greatly reduces file retrieval   time, and an enhanced cut and paste feature that copies all forms, 
modules,   and scripts associated with a selected object. These enhancements significantly   reduce devel-
opment time and increase your system's overall performance.   The unique architecture of iFIX has also 
allowed us to dramatically increase   the speed and performance of VBA. 

ActiveX 

ActiveX is a set of programming technologies created by Microsoft that   enables software components 
created in different languages to interact   with one another in a networked environment. It evolved from 
the OLE development   standard, which in recent years has expanded far beyond the concepts of   object 
linking and embedding that formed the original acronym. iFIX is   a container for ActiveX controls.
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Like OLE, ActiveX is built on the COM programming model to support the   full integration of software 
components. It supports Distributed COM (DCOM)   for the transparent integration of those same com-
ponents across distributed   networks, including the Internet and intranets. However, ActiveX has been   
optimized for size and speed to allow developers to use subsets of the   complex OLE interface to create 
highly interactive applications. ActiveX   allows any OCX (ActiveX control) developed by a third-party to 
behave   just like any object created by GE.

To protect your system from possible problems with ActiveX controls,   iFIX provides Secure Con-
tainment. Unlike most systems that support ActiveX   controls, if an ActiveX control crashes while iFIX is 
running, it is sealed   off and your system continues to run normally. With Secure Containment,   there is 
no loss of data or interruption to your control process. 

System Architecture

This chapter describes the system architecture of iFIX. It includes   information about:

 l Understanding   the iFIX Nodes

 l Universal   Data Access

 l Scan,   Alarm, and Control Program

 l Scheduler

 l Distributed   Networking

 l Alarming

 l Security

 

Understanding the iFIX Nodes 
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iFIX Node Types

A node is any computer running iFIX. An actual node can be any of the node types described in the fol-
lowing section. To learn more about iFIX nodes, refer to the chapter Managing iFIX Nodes.

Nodes in iFIX

There are several types of nodes available using iFIX. 

Type Description
Local 
and 
Remote 

When working with a distributed iFIX system, local   refers to the node on which you are cur-
rently working and remote refers   to any node that you need a communication link to access.

Stand 
Alone 

When working with a centralized iFIX SCADA system,   stand alone refers to a node that per-
forms all functions. Stand alone   nodes do not use a network. 

SCADA A SCADA Server (or SCADA node) runs the data acquisition   and management component of 

Types of Nodes 
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Server iFIX. Usually, a SCADA node resides on the   plant floor and has direct connections to the pro-
cess hardware.

Blind 
SCADA 
Server 

A blind SCADA Server (or blind SCADA node) uses no   graphics display. This configuration 
frees up more of a computer's resources   for data acquisition and network management func-
tions. Graphics can be   viewed using an iClient.

Run-
time 

A run-time node does not let you modify graphic displays   or the process database. Pre-con-
figured files are installed on these nodes   so that you can monitor the process, change process 
settings, and acknowledge   alarms.

iClient An iClient (or view node) is the most common type   of node. View nodes display the real-time 
graphics that come with iFIX.   The term view node means that the node runs the graphics dis-
play program,   but the node can run other applications, as well.

iClient 
Read 
Only

The iClient Read Only has the same functionality as   an iClient, except that you cannot write to 
the iFIX database or to OPC   servers. You also cannot construct SQL Insert or Update com-
mands in an   iClient Read Only node. You can, however, write to a relational database.   The iCli-
ent Read Only is similar in functionality to PlantTV®   for FIX, with the added benefit of 
leveraging the iClient features, such   as the event scheduler, VBA, and ActiveX controls.

Universal Data Access 

Typically, a plant is controlled through a network of sensors and controls   connected to I/O devices, such 
as programmable logic controllers (PLCs).   Although this type of system provides the automatic control 
that keeps   the plant running, it is often difficult for plant personnel to see what's   actually going on in the 
control process at any time. iFIX solves this   problem by making data from various sources available to 
plant workers   and managers in formats that are useful and easy to understand. 

A data source includes the data you want to access and the information   needed to get that data. The 
data sources available with iFIX include   tags, I/O addresses, object properties, historical data, picture 
properties,   VBA events, global variables, and expressions. 

With the open architecture of iFIX, data can be accessed from a wide   variety of sources using OLE, 
OPC, ActiveX, and ODBC. With comprehensive   client and server support for these object technologies, 
iFIX is able   to read data from and write data to the following sources:

 l Third-party applications   

 l Other iFIX databases   

 l I/O drivers 

It is this ability to access data universally that gives iFIX its remarkable   power and versatility.

OLE, OPC, and ActiveX Support 

iFIX includes comprehensive OLE, OPC, and ActiveX client and server   support as the foundation for 
providing an integrated plug and solve architecture.   This technology is the primary mechanism that lets 
you easily integrate   third-party objects and controls into iFIX and embed iFIX objects into   other applic-
ations. 

OLE Automation server support allows you to expose the properties of   iFIX components. For example, it 
allows you to generate pictures without   accessing the software's user interface. 
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Open Database Connectivity (ODBC) Support 

ODBC support allows iFIX to access data from a database using Structured   Query Language (SQL) as a 
standard language. Each database management   system (DBMS) requires an ODBC driver, which is a 
dynamic-link library   (DLL) used to gain access to a data source. 

Among the database management systems used by iFIX are Microsoft Access   (local install only), 
Microsoft SQL Server, and Oracle. Refer to the Using SQL manual and Writing  Scripts manual for more 
information on ODBC support.

I/O Drivers 

GE provides a wide variety of high-performance I/O drivers that   support best-selling and specialty I/O 
devices. We also offer the OPC   Toolkit, a plug-in component to iFIX that lets you easily write high per-
formance,   reliable I/O servers that communicate between your process hardware and   your iFIX, OLE 
Automation, and OPC client applications. 

High performance I/O drivers provide such capabilities as automatic   communication error detection, 
reporting, and recovery; built-in datascopes;   and support for redundant communications. Receiving 
information from third-party   servers is also supported, but typically does not offer any of the high   data 
integrity of a high-performance I/O driver from GE.

Data Flow 

The flow of process data is summarized as follows: 

 1. iFIX reads data from various data sources.   

 2. Internal iFIX database access functions read the data from local or remote databases and trans-
fer it to the requesting software applications. This transfer occurs without any operator inter-
action. For example, the Scan, Alarm, and Control (SAC) program processes the data and 
transfers the data to the process database or the Historical Chart presents the data directly to 
you.   

Data may also be written to the data sources by executing these steps in reverse. 
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Typical Data Flow Diagram

Process Database 

The iFIX process database is a representation of the process created   by linking together blocks of pro-
cess control logic. The process database   consists of blocks and chains. A block (also called a tag) is a 
coded   set of process control instructions provided by GE that perform   a specific task. Most blocks can 
hold only one data point. Each block   requires you to provide several parameters. In general, there are 
two   types of blocks:

Primary   blocks –   start a logical chain and provide the scheduling for the chain. Typically   have a scan 
time and handle all input and output from the database.

Secondary   blocks –   take data from the upstream block and perform some type of action or calculation.

A chain is a series of connected blocks that create a control or monitoring   loop. For example, in a par-
ticular control loop, you need to read a data   point, manipulate it with a standard formula, and write it out. 
The chain   that executes this control strategy might consist of an Analog Input block   connected to a Cal-
culation block connected to an Analog Output block.   

In iFIX, calculations needed for scaling or combining multiple I/O data   points can also be handled dir-
ectly in the graphics dynamic links. The   following figure displays both control strategies.
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Database Control Strategies

For complete information on creating and maintaining a database, refer   to the Building a SCADA System 
manual. 

Scan, Alarm, and Control Program 

The Scan, Alarm, and Control program (SAC) is a system application that runs on a SCADA node. This 
program is responsible for executing the logic of the database chains. SAC performs the following func-
tions:

 l Retrieves data from various data sources   

 l Translates the data into the format expected by the database   

 l Checks the data against the alarm limits and generates alarm messages   

 l Executes the control logic   

 l Detects exceptions   

 l Makes requested writes to the database   

Each database chain also contains the information that determines whether SAC processes the chain 
based on time-based, exception-based, or one-shot processing. A node can perform both time-based 
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and exception-based processing simultaneously. This feature gives you the ability to use the best pro-
cessing strategy for each data point in your system.

Time-Based Processing 

Most applications work by acquiring and calculating data at regular intervals, defined in seconds, 
minutes, or hours. iFIX can perform any combination of time-based processing. This allows you to bal-
ance system resources between data that needs to be acquired quickly and data that can be acquired 
over longer intervals.  

SAC can perform time-based processing in:

 l Subseconds (0.05 seconds to 0.95 seconds)   

 l Seconds   

 l Minutes   

 l Hours   

The frequency with which SAC retrieves data is called the scan time. For more information on scan 
times, refer to the Building a SCADA System manual.

Exception-Based Processing 

Often, it is more efficient to process data after key events occur, such as the changing of a set point or 
the closing of a contact. Processing that is triggered by events rather than time is known as exception-
based processing. 

Exception-based processing is essential for true distributed SCADA applications that monitor a large 
number of I/O devices. For example, an oil field may be monitoring pipelines through a large network of 
remote terminal units (RTUs). The data from the RTUs changes infrequently, so there's no need to 
acquire data at a fixed interval. However, when the data does change, oil field operators need to know 
about it immediately. iFIX senses the changed value and processes it immediately.  

SAC can perform exception-based processing on the following events:

 l Data changes in the database.   

 l Unsolicited messages from the process hardware.   

 l Operator actions.   

 l Instructions from software applications.   

One-Shot Processing 

When the first block in a chain has a scan time of zero, SAC processes the chain only when the primary 
block goes on scan. This is known as one-shot processing.

Scheduler 
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There are certain tasks that you will want to perform at a specified   time or interval or when a change 
occurs in the process. To schedule these   tasks, you will need to define the time or event that triggers the 
action   that you want to occur. The Scheduler is a iFIX application that runs   in the foreground or back-
ground, monitoring the system and triggering   actions based on timers or events. It can be run as a ser-
vice under Windows,   allowing you to log in and out of a Windows node without affecting or   triggering 
scheduled events regardless of whether or not the iFIX WorkSpace   is running. 

The spreadsheet design of the Scheduler lets you easily create and edit   schedules in the configuration 
environment and view the status and statistics   in the run-time environment. It provides you with the abil-
ity to create   as many schedules as you need to organize your work logically and efficiently,   and to run 
multiple schedules at the same time. Within each schedule you   can create as many tasks, known as 
entries, as you need to run as often   as you require. The Scheduler can trigger actions based on five 
events.   These events can use most available data sources as a trigger. Time-based   entries are not tied 
to data sources, and actions are triggered based   on a monthly, daily, continuous, or one-shot basis. 

Script Authoring Experts are provided for common events, such as opening   a picture, running a report, or 
closing a contact. These Experts prompt   you for information pertinent to the operation, generate a Visual 
Basic   script, and tie the script to the appropriate event. For complete information   on using the Scheduler, 
refer to the Scheduler   section in the Mastering iFIX manual. For more information on VBA scripting,   refer 
to the Writing Scripts manual.

Distributed Networking

iFIX networking design incorporates two basic principles: true distributed   processing and on-demand 
data transfer. The following sections provide   more information on:

 l Distributed   Processing

 l On   Demand Data Transfer

 l Centralized   Processing

 

Distributed Processing 

Many systems operate in a hierarchical fashion that leave individual computers vulnerable to system fail-
ures anywhere on the network. The architecture of iFIX allows plants to distribute critical functions 
among all nodes on the network. 

In a distributed processing network, each node independently executes the tasks assigned to it. One 
advantage of this strategy is that nodes can be taken off-line without bringing the whole network down. 
When a node looks for data from an off-line node, the networking application notifies the requesting 
node, so that the node handles the missing data gracefully. Even though each node has integrity as an 
independent station, nodes can also access data anywhere on the network. For example, an iClient can 
display a picture with links to many different SCADA nodes without requiring additional configuration 
work or the need to have a local copy of the database.

Sessions 

With iFIX, you can selectively configure which nodes can access data from a SCADA node on the net-
work. A communication link between two nodes over a network is called a session. When a node 
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establishes a session with a SCADA node, data and alarms can be sent between the nodes. The fol-
lowing figure illustrates session communication.

Network Session
Dynamic Connections 

You can also configure your node to automatically make connections online to remote SCADA nodes 
that are not specifically configured on your node. These connections, called dynamic connections, are 
described in more detail in the Configuring Remote Nodes section in the Setting up the Environment 
manual.

On Demand Data Transfer 

Most industrial automation software systems require every node that uses data from a SCADA node to 
have a copy of the entire database stored locally. The resulting network traffic can use significant sys-
tem resources. To conserve system resources for local tasks, iFIX reads and writes data on demand 
and only moves requested data over the network.

File Storing and Sharing 

Using iFIX and the built-in file sharing capabilities of Windows, you can store data that is needed by sev-
eral nodes in one convenient location. Using the Windows Explorer, you can establish a networked drive 
connection to any other node in your local network. Once established, you have instant access to any 
shared files on that node, including databases, pictures, schedules, and other important iFIX files. 
Access to shared iFIX files by other computers can be controlled by implementing Windows security fea-
tures. Refer to your Windows documentation for more information on file sharing and security.
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Centralized Processing 

Some applications only need one node to perform the required functions. It is easy to convert a dis-
tributed node to a stand alone node or a stand alone node to a distributed node. iFIX operates just as 
smoothly in a single computer environment as it does in a distributed computer environment. The fol-
lowing figure shows a distributed and centralized process.

Distributed and Centralized Processing

Alarming 

iFIX has a sophisticated system for generating, displaying, and storing   alarms and messages. You may 
selectively route alarms and messages to   the following:

 l Any node on the network.   

 l Printers connected   to a node. 

 l Disk-based files.   

 l Alarm summary displays.   
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 l Alarm history windows.   

 l Relational databases.   

For more information, refer to Alarm   Routing.

On a local node, the programs that perform these alarm functions are   called alarm tasks. iFIX also 
provides built-in support for the following   functions:

 l Acknowledging remote   alarms. 

 l Suspending alarms   (for example, during startup). 

 l Delaying alarms.   

 l Triggering scripts   based on alarms. 

 l Filtering alarms   based on type, priority, sender, etc. 

Types of Alarms and Messages 

iFIX generates one type of alarm and four types of messages:

Block Alarm – database blocks generate alarms when block values fall outside pre-defined limits, 
when a change of state occurs, or when communication errors occur. 

Event Message– blocks can also send messages to printers and the alarm history file to indicate that an 
event occurred at that block. These messages do not appear in operator displays and do not require 
operator acknowledgment.

Operator Message– applications generate messages that create a history of important operator 
actions. These include messages that are generated by electronic signatures.

SystemMessage– applications generate alarm messages that track system alerts and problems.

Application Message– applications, such as Recipe, can also send messages to printers and the 
alarm history file to provide records of activity on that application.

Alarm Routing 

iFIX uses a selective alarm configuration based on alarm areas, which are physical or functional divi-
sions of your plant. An unlimited number of alarm areas are provided to serve as distribution points for 
alarms and messages. Each of these alarm areas can be custom named to easily identify it within your 
system. The first 16 alarm areas in iFIX are labeled A through P by default. Each alarm area can then be 
routed to send alarms and messages to selected alarm destinations.  

For example, suppose you have two production lines and want to show all the alarms generated on 
these lines. You also want to show a separate alarm whenever the level of the tank in either production 
line falls below a certain level. One way to do this is to create two separate alarm areas called LINES 
and TANKS. Assign all the blocks that monitor these production lines to LINES and only the blocks that 
monitor the tanks to TANKS, as shown in the following figure. If an alarm occurs on either line, but not in 
the tanks, only NODE1 would receive the alarm.
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Alarm Areas

For detailed information about alarm routing refer to the Implementing Alarms and Messages manual.

Operator and Application Message Routing 

Operator and application messages can be independently routed to alarm areas. This feature allows you 
to separate operator and application messages from alarms.  

SCADA nodes act as alarm servers and distribute alarms and messages over the network. Other nodes 
act as alarm clients and receive alarms. When you set up a SCADA node to distribute alarms over the 
network, it sends the alarms and messages to every node that has a session established with it.  

A non-SCADA node that generates operator messages and system alarms directs those messages to 
its respective SCADA nodes.

Security 

iFIX provides a powerful and sophisticated user-based security system which allows you to protect 
against unauthorized:

 l Access to iFIX applications.   

 l Access to critical application functions.   

 l Access to operator display files (pictures) and recipes.   

 l Write access to database blocks.   

Security Areas 

To protect database blocks from unauthorized writes, iFIX employs security areas. You can think of a 
security area as a group of database blocks with the same security level. Operators with rights to a par-
ticular security area can write to any database block that is a member of that security area.  

The following figure illustrates how iFIX uses security areas. 
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Security Areas

In this example, there are two security areas known as LINE1 and LINE2. All four database blocks 
shown belong to LINE1, but only the two database blocks on the right belong to LINE2. The Engineering 
group is assigned rights to LINE1 and the Operations group is assigned rights to LINE2. Since all data-
base blocks belong to LINE1, the Engineering group can write to all four database blocks. The Oper-
ations group is assigned rights to LINE2, but not to LINE1. Therefore, the Operations group can only 
write to the two database blocks on the right.  

Security Application 

The Security application consists of two parts: Security Configuration   and Login. For complete inform-
ation on configuring security and logging   in, refer to the Configuring Security Features   manual.

Security Configuration

The Security Configuration program allows you to do the following:

 l Enable or disable   security on a node. 

 l Create and edit user   and group accounts. 

 l Establish automatic   login at startup. 

 l Assign users rights   to use programs and program functions, as well as write access to database   
blocks. 

 l Assign user names   and passwords. 

 l Assign security area   names. 

© 2024 General Electric Company. All rights reserved. 17

sec.chm::/seccover.htm


NOTE: You can assign   security protection to individual pictures in the iFIX WorkSpace and recipes   in Recipe 
Builder.
Login

Once a node has security protection, operators must access the Login   program and enter their user 
name and password. After logging in, operators   can access the protected features of the node to which 
they have rights.
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Using the iFIX WorkSpace

The iFIX WorkSpace is your starting point for using iFIX. It   provides an integrated and flexible con-
figuration environment that lets   you create and modify documents for the local node. As part of this envir-
onment,   the iFIX WorkSpace also launches and is integrated with iFIX applications,   eliminating the need 
to switch to other programs. Instead the   iFIX WorkSpace provides a work area with all the necessary 
tools to add   a picture, create a schedule, or change a script.

Using the iFIX WorkSpace, you can also integrate ActiveX documents   from other programs, such as 
Word and Excel, with your iFIX files. Like   iFIX documents, ActiveX documents appear in the work area 
that the   iFIX WorkSpace supplies. And if you create your own custom ActiveX documents,    the 
WorkSpace automatically displays the menus and toolbars that these   documents define when you open 
them.

You can display a hierarchical view of your files with the iFIX   WorkSpace. This view serves as a nav-
igational tool to help you locate   iFIX documents and acts as a launch pad for iFIX and third-party applic-
ations.

The iFIX WorkSpace also lets you access the Visual Basic Editor   (VBE). This editor lets you integrate 
Visual Basic for Applications (VBA)   scripts into your iFIX files. By writing a VBA script, you can cus-
tomize   and automate the behavior of iFIX. For example, you can write a script   to handle custom run-time 
data entry instead of using the data entry mechanisms   provided with iFIX.

But the iFIX WorkSpace is not only a configuration tool. It   also provides a run-time environment as well 
that lets operators display   and run your iFIX documents. This environment lets you enable security   
restrictions that lock operators into a pre-defined set of pictures.

This chapter discusses how to use the iFIX WorkSpace and navigate   the system tree. It also explains 
the available options and describes   the two iFIX WorkSpace environments.

Understanding the iFIX WorkSpace

Before you begin using the iFIX WorkSpace, you should understand   certain key concepts. Within the 
WorkSpace are the system tree and the   work area. 

Before you use either one, you should use the System Configuration Utility   (SCU) to properly configure 
the nodes on which you will use the WorkSpace.   To learn more about the SCU, refer to the Setting  up 
the Environment manual. 

Starting the iFIX WorkSpace 

After you install and configure iFIX, you can begin using the iFIX WorkSpace. 

In Configure Mode

By default, the WorkSpace starts when you start iFIX. This is because   the WorkSpace is configured to 
run as a startup task, by default. When   the iFIX WorkSpace opens in the default mode, it starts in con-
figure mode.
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You can also start the WorkSpace in configure mode by clicking Start    and pointing to Programs, iFIX, 
and then the iFIX   WorkSpace.

Additionally, you can start the iFIX WorkSpace in configure   mode using this command line:

WORKSPACE "C:\My Path\Filename.grf" 

Use this command to open a specified picture on startup. For more information    on configuring startup 
tasks, refer to the iFIX  Background Tasks section.

In Run Mode

You can start the iFIX WorkSpace in run mode by using additional command   line parameters.  For   
example, here you use the /fo command to specify a picture that you want   to open in run mode:

WORKSPACE /fo "C:\My Path\Filename.grf" 

For more information, refer to the Command   Line Parameters for the iFIX WorkSpace section. 

Once you start the WorkSpace, you can toggle between configure mode   and run mode by using the 
Ctrl+W shortcut, or by clicking WorkSpace and   then Switch to Run (or Switch to Configure) (Classic 
view) or on the Home   tab, in the WorkSpace group, click Switch to Run (or Switch to Configure)   (Ribbon 
view).

Command Line Parameters for Starting the iFIX WorkSpace 

You can start the iFIX WorkSpace (WorkSpace.exe) in run mode, from a   command line, by using the 
parameters listed in the following table. To   open a specific picture within the WorkSpace use the 
/FileOpen or /FO   command. Additionally, you can use other command line parameters to specify   the 
size of the WorkSpace window, and whether the menu and status bar   display when the WorkSpace 
opens. For example:

workspace /fo "C:\Program Files (x86)\Proficy\iFIX\PIC\filename.grf" /WL 50 /WT 100 /WB 700 /WR 800 /MT n

Be aware that if you use these command line parameters to open an iFIX   WorkSpace picture on startup, 
the command line parameters override the   settings defined in the StartUp Pictures tab of the User Prefer-
ences dialog   box. These settings also override any configured Window Properties (Title   Bar, Resizable, 
Always on Top fields) in the Picture Preferences tab of   the User Preferences dialog box. It does not 
change the User Preferences;   it just overrides them.

NOTE: Do not   use startup commands after the iFIX Workspace is already running.

List of Command Line Parameters

The following table lists the command line parameters available for   starting the iFIX WorkSpace.

Parameter Alternative Description
/FileOpen file-
name

/FO file-
name

Opens a specified iFIX picture in run mode, where filename   is 
the path and file name of the picture you want to open. 

Use the full path when specifying the picture name to open. 
Use quotes   to surround a path with spaces. For example: 

workspace /fo "C:\Program Files (x86)\Profi-
cy\iFIX\PIC\filename.grf"

iFIX WorkSpace Command Line Parameters
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If you do not specify a file name, the Open dialog box appears 
when   the WorkSpace opens, so you can browse and select a 
file to open.

NOTE: When   you use the /FileOpen command line para-
meter, the WorkSpace starts up    without using the settings 
saved in the UserPreferences.ini file. Instead,   the 
WorkSpace starts with the attributes provided by the com-
mand line   parameters of the /FileOpen command. 

/WindowLeft num /WL num Indicates the x-coordinate of the screen's top left corner, 
where num is the number of pixels between   the left-side of 
the desktop screen and the left-side of the Workspace   win-
dow you open. 

/WindowTop num /WT num Indicates the y-coordinate of the screen's top left corner, as a 
positive   number, where num is the number   of pixels between 
the top of the desktop screen and the top of the Workspace   
window you open. 

/WindowBottom 
num 

/WB num Indicates the y-coordinate of the screen's bottom right corner, 
as a   positive number, where num is   the number of pixels from 
the top of the desktop screen to the bottom   of the Workspace 
window you open. 

/WindowRight 
num 

/WR num Indicates the x-coordinate of the screen's bottom right corner, 
where   num is the number of pixels from   the left-side of the 
desktop screen to the right-side of the Workspace   window 
you open. 

/MenuAndTitleBar 
(y|n) 

/MT (y|n) Indicates whether the WorkSpace hides or displays the main 
menu and   title bars in the window when it opens. 

Use y to show the title bar and menus. Use n to hide the title 
bar and   menus. 

/StatusBar (y|n) /SB (y|n) Indicates whether the WorkSpace hides or displays the 
status bar when   it opens. 

Use y to show the status bar. Use n to hide the status bar. 
/Help /? Displays a help dialog with all the supported options for the 

/FileOpen   command. 

For example, this command would display the help dialog 
box:

workspace /?

Example

This example uses the command-line options to open the iFIX WorkSpace   in run mode:

workspace.exe /FO "C:\Program Files (x86)\Proficy\iFIX\PIC\ChartGroupDemo.grf" /WL 50 /WT 100 /WB 700 /WR 800 /MT n

In this example, the iFIX Workspace displays the picture's top left   corner at 50 pixels across, 100 pixels 
down. The width of the WorkSpace   is 750 pixels (WindowRight - WindowLeft). The height of the 
WorkSpace   is 600 pixels (WindowBottom-WindowTop). 
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The following figure illustrates the WindowTop, WindowLeft, WindowBottom,   and WindowRight values 
for this example.

   

Shut Down the iFIX WorkSpace with a VBA Script 

When the iFIX WorkSpace is open in run mode, one way to shut down the WorkSpace is through a VBA 
command script using the Quit Method. This method is helpful when you restrict other portions of the 
WorkSpace, such as the title bar and menus, that you would normally use to exit the WorkSpace applic-
ation in run mode.

For instance, if Environment Protection is enabled with menu and title bar restrictions, you may want to 
provide a button that shuts down the WorkSpace in run mode.

Be aware that if security is enabled, the logged-in user must have the WorkSpace Runtime Exit security 
feature.

For more information about configuring security features, refer to the Application Features section of the 
Configuring Security Features manual.

TIP: You can also shut down the WorkSpace in run mode by using the ALT+F4 keyboard shortcut, provided 
your Environment Protection and security is configured to allow the user to shut down the WorkSpace.

Example

The following script uses the Quit method from a push button in an iFIX   picture. The push button 
includes a caption "Close Window" within   the picture. When the Close Window button is clicked in run 
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mode, the   script displays a message box indicating whether you want to close the   WorkSpace. Click 
Yes to close the WorkSpace window.

Private Sub CommandButton1_Click()
Dim lAccess As Long
Dim Msg, Style, Title, Response
Msg = "Are you SURE you want to exit the workspace?"
Style = vbYesNo + vbQuestion
Title = "Workspace Exit"
Response = MsgBox(Msg, Style, Title)
If Response = vbYes Then
Application.Quit 3
End If
End Sub 

NOTE: It is not   required to include a message box with a confirmation when you create   this script. You can 
use the Quit method without a message box.

Understanding the System Tree 

Your main navigational tool for locating files is the system tree. This   tool appears as a hierarchical dis-
play of folders, as the following figure   shows. By opening and closing folders, you can locate and display 
your   documents in one step. 

iFIX WorkSpace   System Tree 
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The system tree also acts as a program launcher. By double-clicking   an application in the system tree, 
you can start any iFIX or third-party   application.

Understanding the Work Area 

The work area, shown in the following figure, is the window that displays   your iFIX and ActiveX doc-
uments. Whenever you open a document, the   iFIX WorkSpace displays the file in the work area and 
automatically activates   the tools needed to modify it.

iFIX WorkSpace

For example, when you double-click a picture, it appears in the work   area window and all the tools asso-
ciated with modifying a picture become   active. It's almost as if you started a separate graphics program 
and   opened the picture. This feature makes creating and modifying iFIX documents   fast and easy 
because you do not need to leave the iFIX WorkSpace   or search for the appropriate application to 
launch. All of the tools   you need are built-in and ready to use.

Using the Virtual Keyboard
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iFIX provides a virtual alpha-numeric keyboard that installs with iFIX   installation. This keyboard allows 
you to work in touch-screen environments   or to use a mouse to enter passwords and other data. When 
you activate   the virtual keyboard, it is available by clicking the following button:   
   

This button is on the right side of the current window's title bar.   Clicking the button brings up the key-
board, as shown in the following   figure. 

Virtual Keyboard

To resize the keyboard and configure keyboard options:

 l Use the SzUp and   SzDn buttons to resize the keyboard to one of the twelve available sizes.   

 l Use the minimize   button to dock the keyboard on the right side of the current application   win-
dow's title bar. 

 l Use the Kybd, Help,   Edit, Info, Num, Win, Mag, Macro and Calc buttons to toggle display of   the 
options. 

 l Click and drag any   non-button area of the keyboard to move the keyboard on your desktop.   

 l Access the Help and   the tutorial for the virtual keyboard, as well as general setup and con-
figuration   information, through the Menu button on the keyboard. 

To use the virtual keyboard, you must have a valid hardware key for   iFIX 3.0 or higher. If you are using 
Terminal Server, each licensed client   has access to a copy of the virtual keyboard. 
Activating the Keyboard

It is recommended that you activate the virtual keyboard by adding it   to your Windows Startup folder. 
 To activate the virtual keyboard   from the Windows Startup folder: 

 1. In your iFIX   directory, right-click on the MYTSOFT.EXE file and select Copy. 

 2. In Explorer, navigate   to the C:\Documents and Settings folder. 

 3. Drill down to the following folder:   
C:\Users\Administrator\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup
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 4. Right-click the white   space area of the Startup folder, and select Paste Shortcut. 

 5. If you want, rename   the shortcut. 

The next time you start your computer, the   keyboard will activate automatically.

NOTES:
 l If you   want to start the virtual keyboard when you start iFIX on Windows XP machines,   in the SCU in 

the Task Configuration dialog box, add the Mytsoft2.exe   application (startup mode Normal). The next 
time you start iFIX, the My-T-Soft   virtual keyboard appears. 

 l If you   want to display the My-T-Soft startup screen when you start iFIX, in the   SCU in the Task Con-
figuration dialog box, add the MTSOPEN.EXE application   (startup mode Normal). The next time you 
start iFIX, the My-T-Soft screen   appears and you can click Run My-T-Soft to launch the virtual key-
board.   Do not add MYTSOFT.EXE to the startup task list in the SCU. If you do   so, errors display when 
you start iFIX. 

 l For Windows   XP, you can also use Mytsoft2.exe. 
 l The MTSTUTOR   program can only be run as an Administrator. When logged on as another   user, 

including an Administrator with a different user name, you must   right-click the shortcut and choose 
"Run as Administrator."

 l Be aware   that if you try to run DVTKINST.EXE more than once a unzipping error message   will appear. 

 

Locating Classic View Menu Commands in Ribbon View

If you are switching from using Classic view to Ribbon view, you will   notice that the location of many of 
the commands is different. As an aid,   use the following table to determine the locations of Classic view 
menu   items in Ribbon view.

Classic View Menu Item Ribbon View Location
File New Picture WorkSpace button, select New, or

Home tab, New group
Schedule WorkSpace button, select New, or

Home tab, New group
Dynamo Set WorkSpace button, select New, or

Home tab, New group
Others WorkSpace button, select New, or

Home tab, New group
Open WorkSpace button
Close WorkSpace button
Save WorkSpace button
Save As WorkSpace button
Print WorkSpace button
Recent File WorkSpace button, Recent Documents list
Exit WorkSpace button
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Edit Undo Home tab, Editing group
Cut Home tab, Clipboard group
Copy Home tab, Clipboard group
Copy as Bitmap Home tab, Clipboard group
Paste Home tab, Clipboard group, Paste list
Paste Special Home tab, Clipboard group, Paste list
Delete Home tab, Editing group
Duplicate Home tab, Editing group
Select All Home tab, Editing group
Find and Replace Home tab, Editing group
Animations Tools tab
Picture Home tab, Editing group, Properties list, or

Format tab, Picture group, Edit Picture
WorkSpace Switch to Run Home tab, WorkSpace group

System Tree Home tab, WorkSpace group, Show/Hide list, or
View tab, Show/Hide group

Status Bar Home tab, WorkSpace group, Show/Hide list, or
View tab, Show/Hide group

Toolbox Home tab, WorkSpace group, Show/Hide list
Visual Basic Editor Home tab, WorkSpace group, or

Tools tab
User Preferences Home tab, WorkSpace group, Settings list
Toolbars Home tab, WorkSpace group, Settings list
Full Screen Home tab, WorkSpace group
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Object Resize Right-click object
Rotate Right-click object
Fill Style Solid Format tab, Styles group, Fill Style gallery

Hollow Format tab, Styles group, Fill Style gallery
Horizontal Format tab, Styles group, Fill Style gallery
Vertical Format tab, Styles group, Fill Style gallery
Downward 
Diagonal

Format tab, Styles group, Fill Style gallery

Upward Diag-
onal

Format tab, Styles group, Fill Style gallery

Cross Hatch Format tab, Styles group, Fill Style gallery
Diagonal 
Cross Hatch

Format tab, Styles group, Fill Style gallery

Gradient Format tab, Styles group, Fill Style gallery
Edge Style Solid Format tab, Styles group, Edge Style gallery

Dash Format tab, Styles group, Edge Style gallery
Dot Format tab, Styles group, Edge Style gallery
Dash Dot Format tab, Styles group, Edge Style gallery
Dash Dot Dot Format tab, Styles group, Edge Style gallery
No Edge Format tab, Styles group, Edge Style gallery
Inside Frame Format tab, Styles group, Edge Style gallery

Background 
Style

Opaque Format tab, Styles group, Background Style gal-
lery

Transparent Format tab, Styles group, Background Style gal-
lery

Fade Type Linear Format tab, Styles group, Fade Type gallery
Reflected Format tab, Styles group, Fade Type gallery
Radial Format tab, Styles group, Fade Type gallery
Concentric Format tab, Styles group, Fade Type gallery

View Zoom 50% Format tab, Picture group, or
View tab, Zoom group

100% Format tab, Picture group, or
View tab, Zoom group

150% Format tab, Picture group, or
View tab, Zoom group

200% Format tab, Picture group, or
View tab, Zoom group

Zoom to Fit View tab, Zoom group 
Default View View tab, Picture group, View list
Full View View tab, Picture group, View list
Fit Picture to Window View tab, Picture group, Window list
Fit Window to Picture View tab, Picture group, Window list
Update Window Location View tab, Picture group, Window list
Refresh View tab, Picture group, View list
Color Selections Format tab, Styles group
Property Window View tab, Window group
Screen Regions View tab, Picture group
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Insert OLE   Object Insert tab, Objects/Links group, Object/Links list
Rectangle Insert tab, Shapes group, Shapes list
Rounded Rectangle Insert tab, Shapes group, Shapes list
Oval Insert tab, Shapes group, Shapes list
Line Insert tab, Shapes group, Shapes list
Polyline Insert tab, Shapes group, Shapes list
Polygon Insert tab, Shapes group, Shapes list
Arc Insert tab, Shapes group, Shapes list
Chord Insert tab, Shapes group, Shapes list
Pie Insert tab, Shapes group, Shapes list
Text Insert tab, Shapes group, Shapes list
Chart Standard 

Chart
Insert tab, Charts group

Line Multiline   
Chart

Insert tab, Charts group

SPC   - X-Bar 
Chart

Insert tab, Charts group

SPC   - R-
BarChart

Insert tab, Charts group

SPC   - S-Bar 
Chart

Insert tab, Charts group

Histogram 
Chart

Insert tab, Charts group

Bitmap Insert tab, Objects/Links group, Object/Links list
Datalink Insert tab, Objects/Links group, Object/Links list
Pipe Insert tab, Objects/Links group, Object/Links list
Current Time Insert tab, Objects/Links group, Object/Links list
Current Date Insert tab, Objects/Links group, Object/Links list
Alarm Summary Insert tab, Objects/Links group, Object/Links list
Push Button Insert tab, Objects/Links group, Object/Links list
Portal Control Insert tab, Objects/Links group, Object/Links list
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Format Bring to Front Format tab, Arrange group
Send to Back Format tab, Arrange group
Group Format tab, Arrange group
Align Top Format tab, Arrange group, Arrange list

Bottom Format tab, Arrange group, Arrange list
Vertical 
Center

Format tab, Arrange group, Arrange list

Left Format tab, Arrange group, Arrange list
Right Format tab, Arrange group, Arrange list
Horizontal 
Center

Format tab, Arrange group, Arrange list

Flip Horizontal Format tab, Arrange group, Flip list
Vertical Format tab, Arrange group, Flip list

Space 
Evenly

Horizontal Format tab, Arrange group, Space Evenly list
Vertical Format tab, Arrange group, Space Evenly list

Make Space 
Even

Height Format tab, Arrange group, Make Space Even list
Width Format tab, Arrange group, Make Space Even list
Both Format tab, Arrange group, Make Space Even list

Snap to Grid Format tab, Arrange group, Grid list
Grid Settings Format tab, Arrange group, Grid list
Snap Objects to Grid Format tab, Arrange group, Grid list

Window Cascade View tab, Window group
Tile Horizontal View tab, Window group
Tile Vertical View tab, Window group
Close All View tab, Window group
Switch Windows View tab, Window group

Help iFIX 
WorkSpace 
Help

Electronic 
Books

Help button

Glossary Help button
GE on the 
Web

Home WorkSpace button, Options, Resources page
Tech Support WorkSpace button, Options, Resources page
Register WorkSpace button, Options, Resources page

iFIX 
WorkSpace 
Help

Electronic 
Books

Help button

Glossary Help button
About WorkSpace button, Options, Resources page

 

Using the System Tree 

The system tree provides a hierarchical view of the files on the local   node. When you first start the iFIX 
WorkSpace, the system tree   shows the local node name at the top of the tree and the following folders   
and applications: 

System Tree 
Item

Description

Alarm His- Lets you display the last 200 alarms and messages   received by the local com-
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tory puter.
Database 
Manager

Lets you create and modify process databases. 

Documents 
folder

Lets you create any Word and Excel documents. If you   save these documents 
in the Application path, they appear in the system   tree. Only Word files with the 
extension .DOC and Excel files with the   extension .XLS appear. 

Dynamo 
Sets folder

Contains Dynamo sets.

FIX Recipes 
folder

Contains your control and master recipes. 

Globals 
folder

Contains global variables, user-defined variables,   and threshold tables.

Help & 
Information 
folder

Contains iFIX Help and electronic books.

I/O Drivers 
folder

Contains I/O drivers configured for the local node.

Mission Con-
trol

Lets you monitor background tasks. These tasks include: I/O Control, Auto 
Alarm Manager, Alarm ODBC services,   and the Scan, Alarm, and Control 
(SAC) program.

Pictures 
folder

Contains your pictures.

Reports 
folder

Contains reports generated by your reporting package.   

Schedules 
folder

Contains your schedules.

Security 
folder

Contains the Security Configuration and Login programs.   These programs let 
you define your security configuration and login to   the local node once security 
is enabled.

System Con-
figuration

Lets you configure the local node.

If your computer has Batch Execution or greater installed, you   will also see the following items: 

System Tree Item Description
Batch Execution Books Opens the Batch Execution electronic books.
Batch Execution Con-
figuration

Lets you configure Batch Execution.

Batch Execution Equip-
ment

Contains your equipment database.

Batch Execution Recipes Contains the Batch Execution procedures, unit procedures,   and 
operations.

Understanding System Tree Paths 

Associated with each application and folder in the system tree is an   iFIX path. These paths show where 
the files reside on your computer and   are defined in the System Configuration Utility (SCU). 
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To learn how to change an iFIX path, refer to the Setting  up the Environment manual.

Showing and Hiding the System Tree

By default, the system tree is docked on the left side of the screen.   You can dock it on the other side of 
the screen by dragging it. Likewise,   if you want more screen space for your pictures and schedules, you 
can   set the system tree to float on top of your open documents by dragging   it away from the sides of the 
screen. You can resize the system tree while   it floats by dragging its edges.

When the system tree is docked, you can only resize its width, as the   following figure shows.

Resizing the System Tree

If resizing the system tree does not give you the space you need, you   can hide the tree completely. 

Navigating the System Tree 

You can move up and down the system tree by selecting items with the   mouse or by using the following 
keys: 

Use To...
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the...
Up arrow 
key

Move up the system tree.

Down 
arrow 
key

Move down the system tree.

Page Up 
key

Move up through the system tree quickly. If you have   resized the system tree, you can move 
over the visible portion of the   system tree with the Page Up key.

Page 
Down 
key

Page down through the system tree quickly. If you   have resized the system tree, you can 
move over the visible portion of   the system tree with the Page Up key.

Left 
arrow 
key

Close a folder.

Right 
arrow 
key

Open a folder.

Home 
key

Move to the top of the tree.

End key Move to the bottom of the tree.

Opening and Closing Folders

Opening and closing folders is similar to using Windows Explorer, as   the following figure shows:

© 2024 General Electric Company. All rights reserved. 33



Right-Clicking the System Tree 

You can right-click any item in the system tree to display a pop-up menu. The contents of the menu 
depends on the item you select. For example, the pop-up menu of the Picture folder lets you create a 
new picture and display the folder's path. The pop-up menu of a rectangle, on the other hand, lets you 
edit the object's scripts, change the object's properties, and modify the object by cutting, copying, past-
ing, deleting, and duplicating it.

Dragging and Dropping Files 

With the iFIX WorkSpace, you can copy and move objects by dragging   and dropping them into open doc-
uments. In general, you can drag an object,   such as a Dynamo object, from an open picture, an open 
Dynamo set, or the system tree   and drop it into:

 l An open picture.   

 l An open Dynamo set.   

 l A user-defined global   file. 
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For more information on Dynamo objects, refer to the Creating  Pictures manual. For information on user-
defined variables and the   global page, refer to the Writing Scripts   manual.

Starting Applications from the System Tree 

You can start any application in the system tree by double-clicking   its icon. The iFIX WorkSpace starts 
the associated application   and, when possible, displays the application in the workarea.   In some cases, 
the application opens in its own window on top of the iFIX WorkSpace.

Understanding WorkSpace Environments 

The WorkSpace provides both a configuration and a run-time environment.   The configuration envir-
onment provides all necessary development tools,   including access to toolbars and the files in the sys-
tem tree. In addition,   any process-monitoring background tasks that may be running, such as your   I/O 
drivers and enabled alarm services, continue   to run while the configuration environment is active.

The run-time environment, on the other hand, is designed for operators.   With this environment, operators 
can display pictures and monitor your   process. Typically, the run-time environment is configured to 
restrict   operator access to other parts of iFIX by hiding menu bars and disabling   the ability to task 
switch.

You can toggle between the two environments to test and run your pictures   and schedules. As you 
switch environments, the status bar updates. In   the configuration environment, the text Configure 
appears. When you switch   to the run-time environment, the text changes to Run.

Documents open in one environment remain open even when you switch to   the other environment. For 
example, if you have two pictures and one schedule   open in the configuration environment, these files 
remain open when the   run-time environment becomes active. If you close one of the pictures   in the run-
time environment and switch back, the picture that you closed   is now closed in the configuration envir-
onment. The other picture and   the schedule both remain open. 

You cannot switch to the configuration environment in the iFIX   WorkSpace while a script is running. Sim-
ilarly, you cannot exit the application.   Once the script completes, you can switch environments and exit 
normally.

The same restrictions apply to scripts running in pictures. You cannot   close a picture until all running 
scripts complete.

Switching to the run-time environment also hides the system tree, if   it is displayed, and your toolbars. 
Switching back reverses the process.

NOTES: To improve performance,   close unnecessary, open documents before switching between envir-
onments   to test a picture.  

Displaying the WorkSpace Full-Screen 

You can display the WorkSpace full-screen in either or both of its environments.   Displaying the 
WorkSpace full-screen lets you see the exact same scale   and display sizes that operators will exper-
ience.
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When you display the WorkSpace full-screen, it hides its menu bar and   any docked toolbars. Floating 
toolbars remain visible. The WorkSpace also   hides the system tree in the configuration environment if it 
is docked.   In the run-time environment, the system tree and all toolbars are always   hidden.

Enabling Environment Protection 

You can restrict operator access to the menu bar and pop-up menus, and   prevent task switching by 
enabling environment protection. Once enabled,   environment protection takes effect when you switch to 
the run-time environment.   

For a detailed description of environment protection and how to enable   it, refer to the Setting Up the 
Environment manual.

Disabling Error Dialog Boxes 

If an error occurs in the run-time environment, an error dialog box   displays requiring user intervention. 
You can disable error dialog boxes   for particular errors by editing the FILTEREDERRORS.INI   file in the 
Local path. For example, you may want to suppress the error   dialogs when network sessions are lost. In 
order to do this, add the error   codes you want filtered in the INI   file as follows:

;To add an error code to be filtered increment the count and set
;the Error equal to the return code
 
[ErrorCodes]
Count = 4
Error1 = 1620
Error2 = 1914
Error3 = 1915
Error4 = 8517

In this example, all typical network session errors are suppressed.   

After you edit the FILTEREDERRORS.INI   file, restart the WorkSpace to ensure your changes take 
effect.

Disabling Proficy Historian Errors in the WorkSpace 

To suppress the Proficy Historian errors, you need to edit the filterederrors.ini   file found in the C:\Pro-
gram Files (x86)\Proficy\iFIX\local   path and add the Historian error codes you want filtered.

 To edit the filterederrors.ini   file: 

 1. Add a new section   [iHistErrorCodes]   if it is not already present in the .ini file. 

 2. Add a new key Count   = the number of error codes you want to suppress. 

 3. Add a new key iHistError   and set it equal to the return code. 

Examples

If you want to suppress two Historian errors, you would modify the filterederrors.ini   file as follows:

[iHistErrorCodes]
Count =2
iHistError1 = -3
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iHistError2 = -2

If you want to suppress additional errors, increment the key value of   Count as follows:

Count = 3 

Add a new iHistError3, and set it equal to the error code.

Historian Server Connection Time-out

During a failed write attempt to the Proficy Historian Server, the iFIX   WorkSpace becomes inactive. You 
can control how long this lasts by setting   the number of seconds you allow for the connection time-out. 
The default   is 90 seconds.

To configure the time-out, add this setting to the FixUserPreferences.ini   file in the iFIX Local folder:

[Historian]
TimeoutSecs=10

Here, the time-out is set to 10 seconds. The valid range is 5 to 300   seconds, though not enforced.

Working with Documents 

Once the iFIX WorkSpace starts and the system tree appears,   you can create and open documents. 
The iFIX WorkSpace Standard   toolbar provides buttons for creating new pictures, schedules, and 
Dynamo   sets. In Classic view, you can create other types of ActiveX documents   with the New com-
mand from the File menu. Or, in Ribbon view, you can access   these functions by clicking the 
WorkSpace button and selecting New. 

 

Opening Documents 

To open a document, double-click the document's icon in the system tree.   The iFIX WorkSpace activ-
ates the associated tools or starts the   required application depending on the selected document. 

If you want to open a document that is not in the system tree, click   the Open button from the Standard 
toolbar (Classic view) or click the   WorkSpace button and click Open (Ribbon view) and select the file 
you   want to open.

Deleting and Renaming Documents 

You can delete or rename any closed document in the system tree by right-clicking   it and selecting 
Delete or Rename from the pop-up menu. 

When you rename a document, the iFIX WorkSpace prompts you for   the new name. Once you enter a 
name, it appears in the system tree. 

IMPORTANT:   Only 31 characters are allowed when renaming (and naming) files in the   Documents folder in 
the system tree in the iFIX WorkSpace. 

Using Word and Excel in the WorkSpace
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Using the iFIX WorkSpace, you can integrate documents from Word   and Excel with your iFIX files. 
When you open the documents, they appear   in the iFIX WorkSpace. 

In Classic view, you can perform all of the functions associated with   each application directly in the 
WorkSpace. However, in Ribbon view, there   are some limitations. They include:

 l Global commands,   which are those that apply to any open document, such as Print, are not   
accessible. However, all formatting commands are available.

 l When working in Full   Screen mode, you must have a picture open so that you can activate it,   
which allows you to access the WorkSpace menu and keyboard shortcuts.

Understanding Toolbars

With the iFIX WorkSpace, you can customize the toolbars provided   with iFIX. You can also create cus-
tom toolbars and toolbar buttons, and   share them among multiple computers. This section explains how 
to complete   these tasks. 

NOTES:

 l Although hidden by default,   you can access and use toolbars in Ribbon view. To access a toolbar in   
Ribbon view, on the Home tab, in the WorkSpace group, click Settings,   and then click Toolbars.

 l In Ribbon view, toolbars   cannot be docked. 

 l In Ribbon view, if you   open a MS Word or Excel document in the WorkSpace, some of the menu items   
associated with those documents will not appear in the WorkSpace. If you   need to edit an MS Word or 
Excel document, we recommend that you do in   so in Classic view.

Toolbars provides buttons for common operations. For example, the Standard   toolbar, shown in the fol-
lowing figure, lets you create, open, and print   documents.

iFIX WorkSace Standard Toolbar             

The Application toolbar also lets you complete common tasks. The buttons on this toolbar allow you to 
launch iFIX applications without the system tree and to access information from the iFIX electronic 
books and the GE web site.
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Application Toolbar

The other WorkSpace toolbar, the Utilities toolbar, lets you complete   common database operations 
without Database Manager, as the following   figure shows. You can update the connection between a pic-
ture's I/O points   and the process database. This process is called resolving your pictures..

Utilities Toolbar

Showing and Hiding Toolbars 

You can show or hide any toolbar by selecting or deselecting   it from the Toolbars dialog box in the con-
figuration environment. Switching   to the run-time environment hides all toolbars displayed in the con-
figuration   environment.

Understanding Toolbar Owners 

All toolbars are owned by an application or a document. The toolbar's owner defines when the toolbar 
appears. For example, WorkSpace toolbars appear while the WorkSpace runs, picture toolbars appear 
only while the WorkSpace displays one or more pictures, and Scheduler toolbars are available when you 
open a schedule. If you switch from a picture to a schedule, the WorkSpace hides the picture toolbars 
and displays the Scheduler toolbars.

NOTE: Picture toolbars are available to all pictures and Scheduler toolbars are available to all schedules. 
You cannot assign specific toolbars to individual pictures or schedules. 
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Customizing Toolbars 

The iFIX WorkSpace provides toolbars with buttons that provide   access to frequently-used functions, 
such as creating pictures and starting   iFIX applications. You can customize the toolbars by arranging or 
removing   these buttons as needed. Typically, you should remove buttons that you   do not need. For 
example, if you set up a workstation dedicated to creating   pictures and Dynamo objects, you may want 
to remove the New Schedule button   from the Standard toolbar.

Once you remove a button, you can always add it back. Adding a button   requires you to select a toolbar 
category. A toolbar category is a logical   grouping of buttons. For example, the Standard category con-
tains the buttons   on the Standard WorkSpace toolbar and the CreateObjects   category contains the but-
tons on the Shapes toolbar. 

The iFIX WorkSpace provides many toolbar categories from which   you can select buttons. These cat-
egories cannot be renamed or deleted.   Likewise, the buttons in these categories cannot be modified or 
deleted.   However, you can modify any button you add to a toolbar. The WorkSpace   treats the added but-
ton as a copy of the original and lets you modify   the new button in the toolbar with the Visual Basic 
Editor. Any changes   to the copy do not affect the original.

Docking Toolbars

In addition to adding, removing, and arranging buttons, you can customize   a toolbar by enabling or dis-
abling a toolbar's docking option. When enabled,   this option lets you dock a toolbar by dragging it to any 
edge of the   screen. To keep the toolbar floating regardless of its screen position,   you can disable the 
option. 

NOTE: In Ribbon   view, toolbars cannot be docked.

Resetting Toolbars

You can restore any standard iFIX toolbar to its default state using   the Reset button. Typically, these 
toolbars should be reset if you have   customized the standard toolbars and you want to undo these 
changes. When   you reset a toolbar, the WorkSpace:

 l Deletes any custom   buttons you have added. 

 l Adds any standard   buttons you have deleted. 

 l Resets the toolbar's   docking option back to its default state. This means if you reset a toolbar   
that has the docking option disabled, the WorkSpace enables the option.   

 l Moves the toolbar   back to its default screen position. Consequently, if you reset a floating   toolbar 
that is docked by default the toolbar, the WorkSpace docks the   toolbar when you reset it. 

NOTE: Resetting a standard   toolbar does not affect any custom toolbar you have created.

Creating Toolbars 

While you can customize the toolbars supplied with the iFIX   WorkSpace, you cannot modify their prop-
erties. In addition, WorkSpace   toolbars cannot be renamed or deleted. To eliminate these restrictions,   
you can create your own toolbars. 
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Creating a toolbar is similar to customizing one. Both tasks require   you to click and drag the buttons you 
want onto your toolbar. However,   when you create a toolbar, you also define its properties. These prop-
erties   include the toolbar's owner and name.

The owner identifies the document or application that owns the toolbar.   This owner must be active for 
the toolbars it owns to appear. For example,   picture toolbars appear while you have one or more pictures 
open. If you   subsequently open a schedule, the WorkSpace hides the picture toolbars   and shows the 
Scheduler toolbars. The iFIX WorkSpace, pictures,   and schedules are the available owners.

A toolbar name conforms to VBA naming conventions. These rules require   the first character to begin 
with a letter, prohibit the use of a space,   period (.), exclamation mark (!), or the characters @, &, $, # in   
the name. The name is limited to 31 characters. In addition, toolbar   names cannot match the name of 
any other toolbar, category, picture, schedule,   or Dynamo set. 

However, it is possible to create a toolbar with the name of a closed   document. Similarly, you can save 
a picture or schedule with the name   of a hidden toolbar. When either situation occurs, the WorkSpace 
can only   open one of these items at a time. For example, if you open a picture   named ALARMS.GRF,   
the WorkSpace cannot show a toolbar named Alarms. You must close the picture   first. Once the toolbar 
is displayed, you cannot open the picture until   you hide the toolbar.
Creating Toolbars with VBA

iFIX does not contain the automation interfaces necessary to create   toolbars. Do not use VBA to create 
toolbars in the WorkSpace. Doing so   causes unpredictable results.

NOTE: The WorkSpace   saves the position of top left corner of the each floating and docked   toolbar on the 
screen. If you move a toolbar outside the 800x600 portion   of the screen, you may not be able to see it if you 
reduce the screen   resolution or move the toolbar to another computer. Consequently, it is   recommended that 
you keep your toolbars within the 800x600 portion of your screen.

 In addition, the iFIX WorkSpace does not wrap docked toolbars.   Consequently, if you dock a large toolbar, it 
appears as a long line of   buttons. Depending on the toolbar's size, some buttons may not be visible   and may 
move other toolbars beyond the visible portion of the screen.

Creating Buttons 

You can create custom buttons with the iFIX WorkSpace. Typically,   these buttons provide custom fea-
tures. For example, you could create a   button to launch a custom application.

Creating a button requires you to create a category for it. Remember,   categories supplied with the iFIX 
WorkSpace cannot be modified.

You can create a new category by entering a name for it. Like toolbar   names, category names must con-
form to VBA conventions. These rules require   that the first character begin with a letter, prohibit the use 
of a space,   period (.), exclamation mark (!), or the characters @, &, $, # in   the name, and limits the name 
to 255 characters. In addition, category   names cannot match the name of another toolbar, category, pic-
ture, schedule,   or Dynamo set.

However, it is possible to create a category with the name of a closed   document. Similarly, you can 
save a picture or schedule with the name   of an existing category. When either situation occurs, the 
WorkSpace can   only display one of these items at a time. For example, if you open a   picture named 
OVERVIEW.GRF, the category Overview does not appear in the   WorkSpace category list. To display 
it, close the picture. When you finish   modifying the category, you can re-open the picture.
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You can make button categories appear in the Task Wizard by including   the text "tasks" to the end of the 
name. For example, a category   called Sample displays in the Task Wizard when you create a category 
with   the name SampleTasks; the category's buttons also appear as tasks you   can perform.

Once you create a category, you can add custom buttons to it. Each button   you add has properties that 
you can configure. These properties include   the button's name, description, and ScreenTips. You can 
also edit the   button's script. For more information on writing scripts for custom buttons,   refer to the Writ-
ing Scripts manual. 
Modifying Buttons

When you drag a button to a toolbar, the iFIX WorkSpace duplicates   the button and its properties. 
However, no association exists between   the two buttons. As a result, if you modify either button, the 
other is   not updated. However, if you modify the button in the category, all future   buttons you create with 
it will contain your changes. 

Sharing Toolbars and Toolbar Buttons 

You can share any custom toolbar among your iFIX nodes. Using the WorkSpace,   you can share them 
by:

 l Importing a toolbar's   TBX file. 

 l Copying a toolbar   category's TBC file. 

Typically, you import a toolbar when you want to add toolbars created   by a toolbar developer but you do 
not want others to reuse the toolbar's   buttons. Copying a toolbar category, on the other hand, is done 
when you   want to create one or more toolbars locally from the buttons in the toolbar   category.

Each TBX and TBC file defines a toolbar or a toolbar category, respectively.   These files reside in the 
Local path on the source computer. You can share   the TBX and TBC files by copying them to the target 
computer's Local path.   When sharing toolbars, you must subsequently import the TBX file with   the 
WorkSpace. Toolbar files (*.TBX, *.TBC, *.XBT, ASSOCIATION.DAT) saved   as read-only cannot be 
used in the iFIX WorkSpace. 

NOTE: If you use a   toolbar button to launch a custom ActiveX control, the OCX must be installed   and 
registered on the target computer.

Using Experts and the Task Wizard 

iFIX provides many Experts that automate the configuration of objects   in pictures or the creation of an 
object's script. For example, the Foreground   Color Expert can dynamically change the foreground color 
of an object.   The Enable Alarm Expert, on the other hand, adds a script to the selected   object. The script 
enables alarms for the data source you specify.

You can access many Experts from picture toolbars (Classic view) or   on the Tools tab in the Animations 
and Tasks/Experts group (Ribbon view)   or the Toolbox. However, with the Task Wizard, you can 
access every Expert   through an easy-to-use menu that does not require toolbars. Consequently,   if your 
toolbars occupy valuable screen space, you can hide them without   losing functionality.

You can also use multiple Experts to create a scripted command sequence   with the Multiple Command 
Script Wizard.  The   script can be triggered by a mouse click on an object, a Scheduler entry,   or a key-
board macro.
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For more information on Experts, the Task Wizard, and the Multiple Command   Script Wizard, refer to 
the Creating  Pictures ebook. 

Locating Toolbar Functions in Ribbon View

In Ribbon view, all functions, with the exception of Translation and   Migration, are available directly from 
the Ribbon. This makes the use   of toolbars, in Ribbon view, virtually unnecessary. 

The following sections detail the locations of the various toolbar functions   in Ribbon view.

 l Application   Toolbar

 l CAD   Toolbar

 l Chart   Group Toolbar

 l Dynamo   Toolbar

 l Edit   Toolbar

 l Expert   Toolbar

 l Web_HMI Toolbox Toolbar

 l Shapes   Toolbar

 l Standard    Toolbar

 l Toolbox   Toolbar

 l Tools   Toolbar

 l Utilities   Toolbar

 l VisiconX   Toolbar

 

Locating Application Toolbar Functions in Ribbon View

The following table details the location of the various   Application functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Application   toolbar. 
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Function Ribbon View Location
Key Macro Editor Applications tab, Utilities group
Tag Group Editor Applications tab, Utilities group
Database Manager Applications tab, Process Database group
System Configuration Utility Applications tab, System & Security group
Security Configuration Utility Applications tab, System & Security group, Security 
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list
Security Login Applications tab, System & Security group, Security 

list
Mission Control Applications tab, Utilities group
Alarm History Applications tab, Utilities group
Cross Reference Tool Applications tab, Utilities group, Utilities list
Electronic Books Help button
GE Home Page WorkSpace button, Options, Resources page
Technical Support WorkSpace button, Options, Resources page
Silence Alarm Horn Applications tab, Utilities group, Utilities list
Startup Profile Manager Applications tab, Utilities group, Utilities list
OPC UA Configuration Applications tab, System & Security group

Locating CAD Toolbar Functions in Ribbon View

The following table details the location of the CAD   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the CAD toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
CAD Extend Lines Format tab, Picture group, Drawing Tools list

Trim Lines Format tab, Picture group, Drawing Tools list
Convert Lines to 
Polyline

Format tab, Picture group, Drawing Tools list

Make Lines Hori-
zontal

Format tab, Picture group, Drawing Tools list

Make Lines Vertical Format tab, Picture group, Drawing Tools list
Convert Lines and 
Polylines to Pipe

Format tab, Picture group, Drawing Tools list

Modify Pipe Format tab, Styles group, Pipe Styles gallery
Add Connection Point Format tab, Picture group, Drawing Tools list
Delete Connection 
Point

Format tab, Picture group, Drawing Tools list

Line Connector Tool Format tab, Insert group, Connectors list
Right Angle Line Con-
nector Tool

Format tab, Insert group, Connectors list

Pipe Connector Format tab, Insert group, Connectors list

Locating Chart Group Toolbar Functions in Ribbon View
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The following table details the location of the Chart   Group toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Chart Group   toolbar. 
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Chart Group Apply Chart Group 

Wizard to Chart
Tools tab, Charts Group, Chart Groups list

Apply Chart Group 
File

Tools tab, Charts Group, Chart Groups list

Configure Chart 
Group Files

Tools tab, Charts Group, Chart Groups list

Locating Dynamo Toolbar Functions in Ribbon View

The following table details the location of the Dynamo   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Dynamo toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Dynamo Build Dynamo Tools tab, Dynamos Group, Dynamos list

Quick Dynamo 
Updater

Tools tab, Dynamos Group, Dynamos list

Dynamo Updater Wiz-
ard

Tools tab, Dynamos Group, Dynamos list

Convert Dynamo 
Sets

Tools tab, Dynamos Group, Dynamos list

Quick Dynamo Con-
verter

Tools tab, Dynamos Group, Dynamos list

Dynamo Converter 
Wizard

Tools tab, Dynamos Group, Dynamos list

Locating Edit Toolbar Functions in Ribbon View

The following table details the location of the Edit   toolbar functions in Ribbon view.

NOTES:
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 l The following   table includes only the default functions available on the Edit toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Edit Copy Home tab, Clipboard group

Cut Home tab, Clipboard group
Paste Home tab, Clipboard group, Paste list
Undo Home tab, Editing group

Locating Expert Toolbar Functions in Ribbon View

The following table details the location of the Expert   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Expert toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Expert Fill Tools tab, Animation group, Animations list

Rotate Tools tab, Animation group, Animations list
 Position   Tools tab, Animation group, Animations list
Scale Tools tab, Animation group, Animations list
Visibility Tools tab, Animation group, Animations list
Edge Color Tools tab, Animation group, Animations list
Foreground Color Tools tab, Animation group, Animations list
Background Color Tools tab, Animation group, Animations list
Data Entry Expert Tools tab, Tasks/Experts group
Create Picture Tools tab, Tasks/Experts group, Picture list
Open Picture Tools tab, Tasks/Experts group, Commands list
Close Picture Tools tab, Tasks/Experts group, Commands list
Replace Picture Tools tab, Tasks/Experts group, Commands list
Open Digital Tag Tools tab, Tasks/Experts group, Commands list
Close Digital Tag Tools tab, Tasks/Experts group, Commands list
Toggle Digital Tag Tools tab, Tasks/Experts group, Commands list
Acknowledge Alarm Tools tab, Tasks/Experts group, Commands list
Alarm Horn Tools tab, Tasks/Experts group, Commands list
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Locating Web_HMI Toolbar Functions in Ribbon View

The Web_HMI group is available in Ribbon View and allows you to select to:

 l Toolbox - toggles the display of the Web_HMI Toolbox.
 l Export Picture - lets you select one or more pictures to export to a folder for later viewing in Oepra-

tions Hub.

The following table details the location of the Web_HMI Toolbox      toolbar functions in Ribbon View. For 
more information this toolbar function, refer tothe Creating High Performance Picturees e-book.

NOTES:
 l The following       table includes only the default functions available on the Web_HMI Toolbox toolbar.      
 l Although       hidden by default, you can access and use toolbars in Ribbon view. To        access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,      click Settings, and then click Toolbars.
 l You can       also open a toolbar from the WorkSpace tree, by opening the Project Toolbar      Files folder and 

double-clicking the toolbar you want to open.

Toolbar Function Ribbon View Location
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Web_HMI 
Toolbox

Object Selection Tool Not available
Cut Home tab, Clipboard group
Copy Home tab, Clipboard group
Paste Home tab, Clipboard group, Paste list
Rectangle Insert tab, Shapes group, Shapes gallery
Rounded Rectangle Insert tab, Shapes group, Shapes gallery
Oval Insert tab, Shapes group, Shapes gallery
Chord Insert tab, Shapes group, Shapes gallery
Polygon Insert tab, Shapes group, Shapes gallery
Pie Insert tab, Shapes group, Shapes gallery
Arc Insert tab, Shapes group, Shapes gallery
Line Insert tab, Shapes group, Shapes gallery
Polyline Insert tab, Shapes group, Shapes gallery
Line Connector Tool Insert tab, Connectors group
Right Angle Line Connector Insert tab, Connector group
Text Insert tab, Objects/Links group, Objects/Links list
Datalink Stamper Insert tab, Objects/Links group, Objects/Links list
Bitmap Insert tab, Objects/Links group, Objects/Links list
Color Format tab, Styles group
Toggle Grid Format tab, Arrange group, Grid list
Space Evenly Vertical Format tab, Arrange group, Space Evenly list
Space Evenly Horizontal Format tab, Arrange group, Space Evenly list
Align Top Format tab, Arrange group, Align list
Align Left Format tab, Arrange group, Align list
Align Bottom Format tab, Arrange group, Align list
Align Right Format tab, Arrange group, Align list
Align Horizontal Center Format tab, Arrange group, Align list
Align Vertical Center Format tab, Arrange group, Align list
Group Format tab, Arrange group
Ungroup Format tab, Arrange group
Bring to Front Format tab, Arrange group
Send to Back Format tab, Arrange group
Set Layer Format tab, Picture group, Layers list
Display Layers Format tab, Picture group, Layers list
Fill Expert Tools tab, Animation group, Animations list
Rotate Expert Tools tab, Animation group, Animations list
Foreground Color Expert Tools tab, Animation group, Animations list
Visibility Expert Tools tab, Animation group, Animations list
Undo Home tab, Editing group
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Locating Shapes Toolbar Functions in Ribbon View

The following table details the location of the Shapes   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Shapes toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Shapes Object Selection Tool N/A

Rectangle Insert tab, Shapes group, Shapes gallery
Line Insert tab, Shapes group, Shapes gallery
Oval Insert tab, Shapes group, Shapes gallery
Arc Insert tab, Shapes group, Shapes gallery
Rounded Rectangle Insert tab, Shapes group, Shapes gallery
Polygon Insert tab, Shapes group, Shapes gallery
Polyline Insert tab, Shapes group, Shapes gallery
Chord Insert tab, Shapes group, Shapes gallery
Pie Insert tab, Shapes group, Shapes gallery
Pipe Insert tab, Shapes group, Shapes gallery
Text Insert tab, Objects/Links group, Objects/Links list
Chart Insert tab, Charts group
Bitmap Insert tab, Objects/Links group, Objects/Links list
Datalink Stamper Insert tab, Objects/Links group, Objects/Links list
Alarm Summary Insert tab, Objects/Links group, Objects/Links list
Push Button Insert tab, Objects/Links group, Objects/Links list
Variable Insert tab, Objects/Links group, Objects/Links list
OLE Object Insert tab, Objects/Links group, Objects/Links list
Timer Insert tab, Objects/Links group, Objects/Links list
Event Insert tab, Objects/Links group, Objects/Links list
Time Insert tab, Objects/Links group, Objects/Links list
Date Insert tab, Objects/Links group, Objects/Links list

Locating Standard Toolbar Functions in Ribbon View

The following table details the location of the Standard   toolbar functions in Ribbon view.

NOTES:
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 l The following   table includes only the default functions available on the Standard toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Standard Open WorkSpace button

Close WorkSpace button
Save WorkSpace button
Print WorkSpace button
Open Picture Folder Home tab, WorkSpace group
New Picture Home tab, New group 
New Schedule Home tab, New group 
New Dynamo Set Home tab, New group 
Full Screen Home tab, WorkSpace group
Switch to Run Home tab, WorkSpace group
Visual Basic Editor Home tab, WorkSpace group
Task Wizard Tools tab, Tasks/Experts group, Tasks/Experts dia-

log box launcher

Locating Toolbox Toolbar Functions in Ribbon View

The following table details the location of the Toolbox   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Toolbox toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbox Function Ribbon View Location
Object Selection Tool Not available
Cut Home tab, Clipboard group
Copy Home tab, Clipboard group
Paste Home tab, Clipboard group, Paste list
Time Insert tab, Objects/Links group, Objects/Links list
Date Insert tab, Objects/Links group, Objects/Links list
Rectangle Insert tab, Shapes group, Shapes gallery
Rounded Rectangle Insert tab, Shapes group, Shapes gallery
Oval Insert tab, Shapes group, Shapes gallery
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Chord Insert tab, Shapes group, Shapes gallery
Polygon Insert tab, Shapes group, Shapes gallery
Pie Insert tab, Shapes group, Shapes gallery
Pipe Insert tab, Shapes group, Shapes gallery
Arc Insert tab, Shapes group, Shapes gallery
Line Insert tab, Shapes group, Shapes gallery
Polyline Insert tab, Shapes group, Shapes gallery
Text Insert tab, Objects/Links group, Objects/Links list
Push Button Insert tab, Objects/Links group, Objects/Links list
OLE Object Insert tab, Objects/Links group, Objects/Links list
Datalink Stamper Insert tab, Objects/Links group, Objects/Links list
Alarm Summary Insert tab, Objects/Links group, Objects/Links list
Variable Insert tab, Objects/Links group, Objects/Links list
Timer Insert tab, Objects/Links group, Objects/Links list
Event Insert tab, Objects/Links group, Objects/Links list
Chart Insert tab, Charts group
Bitmap Insert tab, Objects/Links group, Objects/Links list
Color Format tab, Styles group
Font Format tab, Font group
Toggle Grid Format tab, Arrange group, Grid list
Space Evenly Vertical Format tab, Arrange group, Space Evenly list
Space Evenly Horizontal Format tab, Arrange group, Space Evenly list
Align Top Format tab, Arrange group, Align list
Align Left Format tab, Arrange group, Align list
Align Bottom Format tab, Arrange group, Align list
Align Right Format tab, Arrange group, Align list
Align Horizontal Center Format tab, Arrange group, Align list
Align Vertical Center Format tab, Arrange group, Align list
Group Format tab, Arrange group
Ungroup Format tab, Arrange group
Bring to Front Format tab, Arrange group
Send to Back Format tab, Arrange group
Set Layer Format tab, Picture group, Layers list
Display Layer Format tab, Picture group, Layers list
Foreground Color Expert Tools tab, Animation group, Animations list
Fill Expert Tools tab, Animation group, Animations list
Rotate Expert Tools tab, Animation group, Animations list
Position Expert Tools tab, Animation group, Animations list
Scale Expert Tools tab, Animation group, Animations list
Visibility Expert Tools tab, Animation group, Animations list
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Create Picture Expert Tools tab, Tasks/Experts group, Picture list
Open Picture Expert Tools tab, Tasks/Experts group, Commands list
Close Picture Expert Tools tab, Tasks/Experts group, Commands list
Replace Picture Expert Tools tab, Tasks/Experts group, Commands list
Refresh Rate Expert Tools tab, Tasks/Experts group, Picture list
Data Entry Expert Tools tab, Tasks/Experts group
VisiconX Data Control Insert tab, VisiconX group, VisiconX list
VisiconX Grid Control Insert tab, VisiconX group, VisiconX list
VisiconX List Box Control Insert tab, VisiconX group, VisiconX list
VisiconX Combo Box Con-
trol

Insert tab, VisiconX group, VisiconX list

Undo Home tab, Editing group

Locating Tools Toolbar Functions in Ribbon View

The following table details the location of the Tools   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the Tools toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
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Tools Align Top Format tab, Arrange group, Align list
Align Left Format tab, Arrange group, Align list
Align Bottom Format tab, Arrange group, Align list
Align Right Format tab, Arrange group, Align list
Align Horizontal 
Center

Format tab, Arrange group, Align list

Align Vertical Center Format tab, Arrange group, Align list
Group Format tab, Arrange group
Ungroup Format tab, Arrange group
Bring to Front Format tab, Arrange group
Send to Back Format tab, Arrange group
Space Evenly Ver-
tical

Format tab, Arrange group, Space Evenly list

Space Evenly Hori-
zontal

Format tab, Arrange group, Space Evenly list

Color Format tab, Styles group
Font Format tab, Font group
Toggle Grid Format tab, Arrange group, Grid list
Set Layer Format tab, Picture group, Layers list
Display Layer Format tab, Picture group, Layers list
Refresh Rate Expert Tools tab, Tasks/Experts group, Picture list

Locating Utilities Toolbar Functions in Ribbon View

The following table details the location of the Utilities   toolbar functions in Ribbon view. 

NOTES:  
 l The following   table includes only the default functions available on the Utilities toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
Utilities Add Database Block Applications tab, Process Database group, Blocks 

list
Modify Database 
Block

Applications tab, Process Database group, Blocks 
list

Database Save Applications tab, Process Database group
Database Reload Applications tab, Process Database group
Resolve Files Application tab, Utilities group, Utilities list
Export Picture Application tab, Utilities group, Utilities list
Find Mouse Coordin- Application tab, Utilities group, Utilities list
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ates
Save Files with 
Thumbnail Prefer-
ences

Application tab, Utilities group, Utilities list

Locating VisiconX Toolbar Functions in Ribbon View

The following table details the location of the VisiconX   toolbar functions in Ribbon view.

NOTES:
 l The following   table includes only the default functions available on the VisiconX toolbar.   
 l Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 

Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars.
 l You can   also open a toolbar from the WorkSpace tree, by opening the Project Toolbar   Files folder and 

double-clicking the toolbar you want to open.

 

Toolbar Function Ribbon View Location
VisiconX VisiconX Data Con-

trol
Insert tab, VisiconX group, VisiconX list

VisiconX Grid Control Insert tab, VisiconX group, VisiconX list
VisiconX List Box 
Control

Insert tab, VisiconX group, VisiconX list

VisiconX Combo Box 
Control

Insert tab, VisiconX group, VisiconX list

Understanding the Ribbon

Beginning with iFIX 5.0, you can choose either Classic view or Ribbon   view for your user interface. 

The Ribbon contains all of the commands associated with the menus in   Classic view, as well as almost 
all of the options previously only available   on the toolbar. Not only does this make toolbars almost unne-
cessary in   Ribbon view, it makes the Ribbon easier to use than Classic view. 

Ribbon Structure

The Ribbon is organized in tabs. Each tab contains groups, as the following   figure illustrates.
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iFIX Ribbon - Tabs and Groups

Tabs –   includes the following:

 l Home
 l Insert
 l Tools
 l Format
 l View
 l Applications
 l Administration

Groups –   for the illustrated tab, includes the following:

 l Clipboard
 l WorkSpace
 l New
 l Editing

 

Quick Access   Toolbar and WorkSpace Button

The Ribbon has a customizable Quick Access toolbar, which allows you   to easily access the com-
mands you use most often with just the click of   the mouse. The Quick Access toolbar is located in the 
upper left corner   of the toolbar, as seen in the following figure.
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iFIX Ribbon - WorkSpace Button and Quick Access Toolbar

WorkSpace button

Quick Access Toolbar –   default commands include the following:

 l Switch modes
 l Save
 l Activate Visual   Basic Editor
 l Full Screen
 l Create a new   picture

The WorkSpace button, illustrated in the preceding figure, provides   access to commands as well as 
options for customizing the user interface.   

Understanding the Quick Access Toolbar

The Quick Access toolbar provides a way to quickly execute frequently   used commands. The Quick 
Access toolbar is customizable, allowing you   to add as many or as few commands to the toolbar as you 
want.

In the following figure, commands have been added to the Quick   Access toolbar, indicated by the num-
ber one. Typically, the five default   commands that appear on toolbar are those listed in the toolbar list,   
indicated by number two. 

iFIX Ribbon - Quick Access Toolbar
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Commands added to the Quick Access Toolbar

Customize Quick Access Toolbar list. Commands that   appear on the Quick 
Access Toolbar by default are listed above the command   separator.

To use the commands on the Quick Access toolbar, click the desired command   on the toolbar or click 
the Customize Quick Access Toolbar list and click   one of the default commands listed there. 

Understanding the WorkSpace Button

The WorkSpace button, located in the upper left corner of the WorkSpace,   provides access to com-
mands located on the File menu in Classic view,   such as New, Open, and Save. It also provides access 
to further options,   such as ways to customize the user interface in Ribbon view, or contact   Technical 
Support. 

 

Understanding KeyTips

In Ribbon view, KeyTips replace underlined menu letters as indicators   of keys to press to invoke a com-
mand. They appear when you press the ALT   or F10 key.

The following figure the illustrates KeyTips. Each KeyTip   corresponds to the command, tab or button to 
which it is closest. 

To access a command, tab or button, press <ALT>+<KeyTip>.   For example, to access the Admin-
istration tab using the KeyTips illustrated   in the following figure, you would press <ALT>+<D>. 

iFIX Ribbon - KeyTips

The Ribbon at Run Time

In run mode, you can access the Ribbon, which displays the Historical   tab and the Global Time Control, 
as seen in the following figure. By default,   the Ribbon is minimized in run mode, which allows for a larger 
display   area for pictures. To display the Ribbon, click the Historical tab.   
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The Ribbon in Run Mode

If the Ribbon is hidden and you want to use the Global Time Control   or any other feature available on the 
Ribbon at run time, you only need   to clear the Minimize the Ribbon option on the Quick Access Tool list   
while in run mode, as illustrated in the following figure.

The Minimize the Ribbon Option for the Ribbon in Run Mode

The Ribbon in Full Screen Run Mode

While in full screen run mode, the Ribbon is not visible, by default.   However, you can use the Alt key to 
display it. Clicking on a picture   causes the Ribbon, if it is visible, to return to a non-visible state.   To 
always display the Ribbon when in full screen run mode, clear the Minimize the Ribbon options on the 
Quick   Access Tool list while in run mode, as illustrated in the following figure.

The Quick Access Tool list in Full Screen Run Mode

Setting User Preferences 

The iFIX WorkSpace provides several options that you can configure.   These options include:

 l Picture, shape, drawing,   and standard chart preferences. Refer to the Understanding   Picture, 
Shape, Drawing, and Standard Chart Preferences section for   more information. 

 l Save preferences.   Refer to the Saving Back-up Files   section for more information. 
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 l Run-time preferences.   Refer to the Configuring   Run-time Preferences section for more inform-
ation. 

 l The iFIX WorkSpace's   start-up environment. Refer to the Changing   the Start-up Environment 
section for more information. 

 l OPC connection (animation   error) preferences. Refer to the Animation   Error Preferences section 
for more information. 

 l Monitor preferences.   Refer to the Multiple Monitors   and iFIX section for more information.

 

Understanding Picture, Shape, Drawing, and Standard Chart Preferences   

Picture preferences include the default size and background color, and   whether the picture includes a 
title bar, system bar, and the ability   to resize. You can also specify whether your pictures will use a gradi-
ent   fill, will save a thumbnail, can be cached, and can be auto scaled.

Shape preferences let you specify the default colors of new objects   in a picture and default styles, such 
as fill and edge style. If the fill   style is Gradient, you can specify fade type. You can define default pipe   
properties, and the default font name, point size, and styles. 

Drawing preferences let you specify the line extension and line trimming   options and whether or not to 
display connection nodes on objects. 

Standard Chart preferences let you select the defaults for Standard   Chart objects only. These defaults 
include the number of ticks per axis,   the number of labels per axis, the direction in which the chart 
scrolls,   and the length of time the chart displays. To learn more about all picture,   shapes, drawing, and 
chart preferences, refer to the Creating  Pictures manual.

Saving Back-up Files 

Each time you save a file, the iFIX WorkSpace copies the previous   version to a back-up subfolder and 
saves the new version. If a back-up   file already exists for the current file, the new back-up replaces it.

Back-up subfolders reside inside the system tree folders but do not   appear in the system tree. For 
example, the Pictures back-up subfolder   resides inside the Pictures folder and contains back-ups of 
modified pictures.

Depending on the amount of free disk space you have and the size of   your pictures, you may want to dis-
able the back-up option to save space.   

Configuring Run-time Preferences 

The iFIX WorkSpace has several run-time preferences, which include:

 l Saving your open   documents automatically when you switch to the run-time environment. Using   
this feature, you can toggle between the two environments without worrying   about saving your 
changes. By default, this option is disabled. If you   enable it and you want to test a change to a pic-
ture or schedule without   saving the modification, you must disable the preference before 
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switching   to the run-time environment. If you do not, the WorkSpace automatically   saves the 
change. 

 l Displaying the    iFIX WorkSpace full-screen. This feature provides maximum screen space   for cre-
ating and displaying pictures. When you display the WorkSpace full-screen,   it hides its menu bar, 
system tree, and any docked toolbars. Floating   toolbars remain visible. 

 l Opening specific    pictures automatically when the iFIX WorkSpace starts in the run-time   envir-
onment. Use this option to define the specific files you want to   open automatically for your oper-
ators. 

 l Opening specific   schedules you want to open in the background. Use this option to indicate   the 
specific files you want the FixBackgroundServer task to load on start-up.   

Changing the Start-up Environment 

The start-up environment option lets you specify the environment in   which the iFIX WorkSpace starts. 
By default, the iFIX   WorkSpace starts in the configuration environment.

However, when you have finished configuring each node, you may want   to configure the iFIX 
WorkSpace to start up in the run-time environment   automatically. 

Animation Error Preferences 

Each animated object in a picture uses OPC protocols to receive data   and report errors. The animation 
error preferences define the default   error strings and values that the object uses when an error occurs. 
For   example, by default, when a communication error occurs, Data links display   the text "@@@@".

You can customize the animation error defaults by entering new values   in the Animations Data Error 
Defaults tab. By changing the defaults, you   make the default error messages more intuitive for your 
industry. For   example, when a communication error occurs, you can have Data links display   the fol-
lowing text by entering it into the Comm field of the Format Animation   Object Defaults area:

Cannot communicate with server

Choosing the User Interface

The iFIX WorkSpace provides two options for user interfaces.   They are:

 l Classic view – this user   interface was the only one available prior to iFIX 5.0. It uses a number   of 
toolbars in addition to menu driven commands.

 l Ribbon view – this user   interface is available beginning with iFIX 5.0. Almost all functions pre-
viously   available in Classic view via the toolbar can now be accessed on the Ribbon,   without 
opening or importing toolbars. 

 

Customizing the Ribbon User Interface
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In Ribbon view, you can customize the look and feel of the user interface.   Customization choices 
include:

 l Changing the color   scheme of the WorkSpace.

 l Determining how ScreenTips   are displayed.

 l Customizing the Quick   Access toolbar.

 l Creating and customizing   keyboard shortcuts.

 l Deciding whether   or not to show KeyTips.

Displaying the Visual Basic Editor 

You can write Visual Basic for Applications scripts for any picture,   toolbar button, schedule, or iFIX 
object. Using VBA gives you complete   control over your process automation solution because it lets you 
create   custom scripts and automate iFIX for your needs. 

You can begin writing scripts by displaying the Visual Basic Editor.   The VBE provides   access to all the 
available methods, properties, and events for your iFIX   objects. 

You can display the VBE   in many ways, such as by selecting Visual Basic Editor from the WorkSpace   
menu (Classic view) or on the Home tab, in the WorkSpace group, click   Visual Basic Editor (Ribbon 
view), or right-clicking an object and selecting   Edit Script from the pop-up menu, and creating a schedule 
and clicking   VB Editor from   the Add Event Entry or Add Timer Entry dialog box.

To learn how to use the VBE,   refer to its online Help. To learn how to write scripts for iFIX objects,   but-
tons, pictures, and schedules, refer to the Writing  Scripts manual. For information on iFIX methods, prop-
erties, and events,   refer to the iFIX Automation Interfaces Help file.

Multiple Monitors and iFIX

The iFIX WorkSpace supports the use of multiple monitors for displaying   pictures in an expanded (or 
independent) and spanned (or stretched) space.   You must configure your video driver (following the 
instructions from   your hardware vendor) to enable your desktop space to be expanded (or   independent) 
or spanned (or stretched) for all your monitors.

For multiple monitors to work properly with iFIX, you must have the   identical resolution set on all mon-
itors. The primary monitor (Monitor   1) should always be set to the topmost, and leftmost area in the Win-
dows   Display Properties dialog box. 

Valid Monitor Settings Example

The following figures display valid dual monitor settings for the iFIX   WorkSpace, as shown in the Win-
dows Display Properties dialog box:
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Invalid Monitor Settings Example

The following graphics display invalid   dual monitor settings the iFIX WorkSpace, as shown in the Win-
dows Display   Properties dialog box:

  

Configuration in iFIX

When using expanded (or independent) display settings, in the User Preferences   dialog box on the Gen-
eral tab, select the Extend WorkSpace to support   multiple monitors check box and click OK. Be aware 
that if you later disable   this user preference, the WorkSpace shrinks to one monitor (Monitor 1),   but it 
does not move any child windows back into the single monitor view.   The child windows remain in the 
same location.  To   view the child windows again, change the picture’s WindowLeftPercentage   and Win-
dowTopPercentage   to 0 to get them back into the Monitor 1 area.

For help with opening pictures across multiple monitors, you can use   the Track Mouse Coordinates Tool 
in the iFIX WorkSpace. For more information,   refer to the Using  the Find Mouse Coordinates Tool sec-
tion in the Creating Pictures e-book.   This tool whelp you quickly locate the coordinates of the upper left 
corner   where you want a picture to open. 

WorkSpace Dialog Boxes

The WorkSpace application includes the following dialog boxes (listed   in alphabetical order):

 l Add   Server Dialog Box

 l Button   Properties Dialog Box

 l Customize   Toolbars Dialog Box

 l Data   Server Installer Dialog Box

 l Expression   Builder Dialog Box

 l Find   and Replace Dialog Box

 l Get   Project Dialog Box

 l Import   Toolbars Dialog Box

 l Modify   Server Dialog Box
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 l iFIX Project Backup Dialog Box

 l iFIX Project Backup Wizard

 l   iFIX Restore Wizard

 l Task   Wizard Dialog Box

 l Toolbars   Dialog Box

 l User   Preferences Dialog Box

Add Server Dialog Box

The Add Server dialog box displays the following items:

Data Server

Specifies a name for the OPC driver.  This   name identifies the driver to iFIX and is used in data sources 
to access   the selected OPC driver.  Make   sure the name you enter contains no spaces and is not 
already used by   another data server.  

OPC Server

Specifies the OPC driver you want use.  

Machine Name

Specifies the local computer name, or the remote computer name that   the OPC Server resides on. 

Set As Default Server

Select this check box to set the current OPC server as the default server.    iFIX will   use this server when 
you do not explicitly enter a server name in a data   source.  

Button Properties Dialog Box

The Button Properties dialog box displays the following items:

Bitmaps List Box

Displays a list of bitmaps in the iFIX Local path.  You   can select one of these bitmaps for the button or 
you can select a custom   bitmap of your own by browsing to it.  If   you select a custom bitmap, the image 
can be no more than 20 x 20 pixels   and use no more than 16 colors.  

Preview

Displays a preview of the bitmap highlighted in the Current Directory   bitmap list.

Category

Specifies the current category.  

Name

Specifies the name of the button you are configuring.  You   can edit this name by entering the text you 
want.  
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Description

Lets you enter a text description for the button you are configuring.    This text   appears on the Buttons tab 
when you select the button.  

Screentip

Lets you enter a text description of up to 128 characters for the button   you are configuring.  This   text 
pops up when you place the cursor over the button.  

Edit Script

Lets you open the Visual Basic Editor, and enter or edit the current   button's script.  

Configure the Proficy Historian Server(s) Dialog Box

The Configure the Proficy Historian Server(s) dialog box displays the   following items. Be aware that you 
must restart the iFIX Workspace to apply changes from this dialog box.

Enable Historian Aliases for All Sessions

Select this check box to  create a common Historian Server configuration that can be used across mul-
tiple Windows user accounts.  The common Historian server configuration is available in any session 
type including: iClient, iClientTS, and Webspace clients. When the option is disabled, you can create a 
custom Historian Server configuration for each Windows user.

For example, say you are logged into Windows with a user account named “Joe” and you save the His-
torian Server configuration with the option enabled.  Then, you log in with a user account called “Tom” 
and start iFIX and the WorkSpace.  The WorkSpace will be able to use the Historian Server configuration 
you created earlier, even though you are logged in with a different user account.  Conversely, if you are 
logged in to Windows as “Joe” and you save the Historian Server configuration with the option disabled, 
when you log in as “Tom” and start iFIX and the WorkSpace, you will need to create the Historian Server 
configuration.  This Historian Server configuration will only be available when the “Tom” user account is 
logged in to Windows.

There are some special considerations when iFIX runs in a Terminal Server environment.  When iFIX 
runs in an iClientTS session, there is another option, TSCommonHistConfig*, that comes into play.  
When the “Enable Historian aliases for all sessions” option is enabled, it overrides the TSCom-
monHistConfig option.  When it is disabled, when iFIX run as an iClientTS it uses the common Historian 
Server configuration if TSCommonHistConfig is enabled; it uses the user-based Historian Server con-
figuration if TSCommonHistConfig is disabled.

WebSpace client sessions use the common Historian sSrver configuration that was created on the 
WebSpace server.  WebSpace client sessions are not affected by the “Enable Historian aliases for all 
sessions” or TSCommonHistConfig options.

The following table summarizes how the “Enable Historian aliases for all sessions” and TSCom-
monHistConfig options work in different session types:

iFIX is Run-
ning as an...

and the 
"Enable His-
torian aliases 
for all ses-
sions" option 

and the TSCom-
monHistConfig option* is…

the Historian Server con-
figuration is…
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is…
iClient enabled enabled or disabled common
iClient disabled enabled or disabled user-based
iClientTS enabled enabled or disabled common
iClientTS disabled enabled common**
iClientTS disabled disabled user-based
Webspace Cli-
ent

enabled or dis-
abled enabled or disabled common

* The TSCommHistConfig option is configured in the [Historian] section of the FixUserPreferences.ini 
file.

** When using iFIX in a Terminal Server environment with “Enable Historian aliases for all sessions” dis-
abled and TSCommonHistConfig enabled, take care to save the Historian Server configuration from the 
Terminal Server console.   Changes made to the Historian Server configuration from an iClientTS session 
will be saved as user-based.

Alias Name/Server Name List

Lists the alias and server name of the configured Historian.

Set Default

Use this button to set the server selected in the Alias Name/Server   Name list as the default Historian 
server.

Add Server

Use this button to add a Historian server.

Modify

Use this button to modify server characteristics.

Delete

Use this button to delete the selected server from the Alias Name/Server   Name list.

Alias Name

Enter the alias name in this field. This field is unavailable if the   default server is selected. Do not use spe-
cial characters, such as @,   $, a period (.), or #, in this field.

Server Name

Enter the server name in this field.

User Name

Enter the user name for the Historian server.

Password

Enter the password for the Historian server.

Close

Use this button to close the Configure the Proficy Historian Server(s)   dialog box.
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Get Collectors

Use this button to populate the Collector Name list.

Collector Name List

Lists only the collectors that use iFIX EDA, which includes the following   :

 l iFIX Native Collector

 l OPC EDA Collector

 l iFIX OPC Collector

NOTE: The Collector   Name List only displays local collectors, even if you set a remote server   as the default 
server.

Set Default

Use this button to set the collector in the Collector Name list as the   default. 
 

Customize Toolbars Dialog Box

The Customize Toolbars dialog box displays the following items:

Toolbars Tab

Item Description
Owner Lets you select a toolbar owner.  Only   active owners appear in the list.  
Toolbars Lets you show and hide the selected toolbar.  
Enable Docking for 
Selected Toolbar

Lets you enable or disable toolbar docking.  

Show ScreenTips   
on Toolbars

Lets you enable or disable text descriptions for every   button on every tool-
bar.  When   enabled, you can display a description by placing the cursor 
over a button.    

Add Toolbar Lets you create a toolbar.  
Modify Properties Lets you modify the properties of the selected toolbar.    Toolbars   supplied 

with iFIX cannot be modified.  
Delete Toolbar Lets you delete the selected toolbar.  Toolbars   supplied with iFIX cannot 

be deleted.  
Reset Lets you reset the selected toolbar to its default   state.  Any   buttons 

removed from the toolbar and supplied by default are added back.    All but-
tons   not supplied with the toolbar are removed.  Resetting   a toolbar 
affects toolbars supplied with iFIX; toolbars you create are   not affected.   

Import Lets you import custom toolbars shared among your   iFIX nodes or cre-
ated by a toolbar developer.

Buttons Tab

Item Description
Categories Lets you select a toolbar category.  
Add Category Lets you add a toolbar category.  
Rename Category Lets you rename the selected toolbar category.  Categories   supplied with 
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iFIX cannot be renamed.  
Delete Category Lets you delete the selected toolbar category.  Categories   supplied with 

iFIX cannot be deleted.  
Buttons Area Drag and drop a button from this group box onto a   toolbar, or double-click 

a button in the toolbar to edit the VBA script.    
Description Displays a description of the selected button.  
Add Button Lets you add a button to the selected category.  
Modify Button Lets you modify the selected button's properties.    You cannot   modify a 

button supplied with iFIX.  
Delete Button Lets you delete the selected toolbar button.  Buttons   supplied with iFIX 

cannot be deleted.  

Data Server Installer Dialog Box

The Data Server Installer dialog box displays the following items:

Data Servers

Displays the available OPC servers and lets you select the server you   want to modify or delete.    

OPC Server

Specifies the OPC driver of the selected server.  

Machine Name

Specifies the local computer name, or the remote computer name that   the OPC Server resides on. 

Add

Use this button to add (install) an OPC server.  

Remove

Use this button to delete the selected OPC server.   

Modify

Use this button to modify the selected OPC server.  

Expression Builder Dialog Box

The Expression Builder dialog box displays the following items:

NOTE: If a tab   is not displayed, you can click the Available Data Sources drop-down  to select the applic-
able one that you want to bring into   view. The following figure illustrates where the Available Data Sources   
drop-down appears in the Expression Builder dialog box. 
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FIX Database Tab

Item Description
Node Names List 
Box

Displays a filtered list of SCADA servers that the   local node is com-
municating with.  By   default, all SCADA servers are displayed.  

Node Names Filter Specifies the current SCADA server filter.  You   can edit the filter or 
select one from the list.  You   can also include in the filter the wildcards ? 
(to represent a single   character) or * (to represent two or more char-
acters).  

Node Names Filter 
Button

Use this button to update the list of nodes based   on the current SCADA 
server filter.  

Tag Names List Box Displays a filtered list of database blocks (tags)   on the selected SCADA 
server.  By   default, all blocks are displayed.  

Tag Names Filter Specifies the current block name filter.  You   can edit the filter or select 
one from the list.  You   can also include in the filter the wildcards ? (to rep-
resent a single   character) or * (to represent two or more characters).  

Tag Names Filter 
Button

Use this button to update the list of blocks based   on the current block fil-
ter.  

Field Names List 
Box

Displays a filtered list of fields available from   the selected block.  By   
default, all blocks are displayed.  

You can receive help on any field displayed in this   list box by using the 
Block Field Reference and selecting the field's   block from the list that 
appears.

A_* Button Use this button to change the block field filter to   display all A_ fields and 
selects the A_CV field, if available.  

F_* Button Use this button to change the block field filter to   display all F_ fields and 
selects the F_CV field, if available.  

E_* Button Use this button to change the block field filter to   display all E_ fields and 
selects the E_CV field, if available.  

Block Field Filter Specifies the current block field filter.  You   can edit the filter or select 
one from the list.  You   can also include in the filter the wildcards ? (to rep-
resent a single   character) or * (to represent two or more characters).  

Block Field Filter 
Button

Use this button to update the list of fields based   on the current block 
field filter.  

Current Expression 
Box

Specifies the current expression.  You   can enter the expression directly 
or build it by making selections from   the other fields and buttons on the 
tabbed page.  
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Valid Characters:    all alphanumeric   characters, hyphen (-), underscore 
(_), exclamation point (!), less than   (<), greater than (>), pound (#), per-
cent (%), dollar sign ($),   ampersand (&), forward slash (/), backslash (\), 
pipe (|), opening   bracket ([), closing bracket (]), and single quote (').

If a single quote (') or a backslash (\) is a literal   part of the addressing 
string syntax,  it   must be preceded by a backslash (\) in order for the 
character to be passed   to the server as part of the address.  For   
example, to enter a tag with the name 'TEST', you would enter the data   
source FIX32.THISNODE.\'TEST\'.F_CV.

Tolerance Specifies the current connection's rounding factor.   Typically, iFIX uses 
this value when comparing a process value to a target   value. If the pro-
cess value is within the specified tolerance, iFIX assumes   the two val-
ues are equal. For example, if the target value is 1.0, the   tolerance is 
0.1, and the current value of a data source is 0.8, iFIX   does not assume 
the two values are equal because the data source is not   within the spe-
cified tolerance. The value must be within the range 0.9   to 1.1 to equal 
the target value. Seven digits of precision are allowed   for accuracy.

Deadband Specifies the maximum fluctuation you want for the   current connection 
before iFIX updates it. By entering a dead band value,   you create a +/- 
dead zone around the connection's current value. As long   as the value is 
within this range, iFIX does not update the value. However,   once the 
value exceeds the maximum or minimum dead band, the value is   
updated. Seven digits of precision are allowed for accuracy.

Refresh Rate Specifies the rate at which iFIX updates the current   connection.  iFIX   
updates the connection no faster than the specified speed.  For   speeds 
less than 1 second, iFIX updates no faster than once every 50 mil-
liseconds.    For speeds   greater than 60 seconds, iFIX updates no faster 
than once every 60 seconds.    

Check Syntax But-
ton

Use this button to check the syntax of your expression.    A valid   expres-
sion displays the message "Syntax check successful!"  An   error mes-
sage appears if the syntax is invalid. 

Mathematical Func-
tions Button

Use this button to show or hide a keypad of numbers,   and mathematical 
and Boolean operators you can use in your expressions.    

Pictures and Globals Tabs

Item Description
Objects List Box Displays a list of the open pictures (Pictures tab)   or the global objects 

(Globals tab) available on this node.  By   expanding a picture or the user 
globals, you can display a filtered list   of objects in the pictures or in the 
User Globals folder.    

Object Filter Specifies the current filter for the selected item.    You can   edit the filter or 
select one from the filter list.  You   can also include in the filter the wild-
cards ? (to represent a single   character) or * (to represent two or more 
characters).  

Object Filter Button Use this button to update the item list based on the   current filter.  
Properties List Box Specifies the properties for the currently selected   picture or object.  

NOTE: If   you have created an object-to-object connection, such as the 
fill percentage   of one tank to another, or created a connection to a data 
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source, the   animated properties display in boldface.
Properties Filter Specifies the current property filter.  You   can edit the filter or select one 

from the list.  You   can also include in the filter the wildcards ? (to rep-
resent a single   character) or * (to represent two or more characters).  

Properties Filter But-
ton

Use this button to update the list of properties based   on the current prop-
erty filter.  

Current Expression 
Box

Specifies the current expression.  You   can enter the expression directly 
or build it by making selections from   the other fields and buttons on the 
tabbed page.  

Valid Characters:    all alphanumeric   characters, hyphen (-), underscore 
(_), exclamation point (!), less than   (<), greater than (>), pound (#), per-
cent (%), dollar sign ($),   ampersand (&), forward slash (/), backslash (\), 
pipe (|), opening   bracket ([), closing bracket (]), and single quote (').

If a single quote (') or a backslash (\) is a literal   part of the addressing 
string syntax,  it   must be preceded by a backslash (\) in order for the 
character to be passed   to the server as part of the address.  For   
example, to enter a tag with the name 'TEST', you would enter the data   
source FIX32.THISNODE.\'TEST\'.F_CV.

Tolerance Specifies the current connection's rounding factor.    Typically,   iFIX uses 
this value when comparing a process value to a target value.    If the   pro-
cess value is within the specified tolerance, iFIX assumes the two   val-
ues are equal.  For   example, if the target value is 1.0, the tolerance is 
0.1, and the current   value of a data source is 0.8, iFIX does not assume 
the two values are   equal because the data source is not within the spe-
cified tolerance.  The   value must be within the range 0.9 to 1.1 to equal 
the target value.  

Deadband Specifies the maximum fluctuation you want for the   current connection 
before iFIX updates it.  By   entering a dead band value, you create a +/- 
dead zone around the connection's   current value.  As   long as the value 
is within this range, iFIX does not update the value.    However,   once the 
value exceeds the maximum or minimum dead band, the value is   
updated.  

Refresh Rate Specifies the rate at which iFIX updates the current   connection.  iFIX   
updates the connection no faster than the specified speed.  For   speeds 
less than 1 second, iFIX updates no faster than once every 50 mil-
liseconds.    For speeds   greater than 60 seconds, iFIX updates no faster 
than once every 60 seconds.    

Check Syntax But-
ton

Use this button to check the syntax of your expression.    A valid   expres-
sion displays the message "Syntax check successful!"  An   error mes-
sage appears if the syntax is invalid. 

Mathematical Func-
tions Button

Use this button to show or hide a keypad of numbers,   and mathematical 
and Boolean operators you can use in your expressions.    

Data Servers Tab

Item Description
Data Servers Box Displays a list of the SCADA servers collecting historical   data for the 

local node (Historical tab) or the third-party OPC servers   that support 
browsing (Data Servers tab).  By   expanding a node, you can display a 
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filtered list of the historical values   being collected or the I/O points 
being monitored.  Refer   to the Entering Data Source Syntax section in 
the Creating Pictures electronic   book for additional information about 
using third-party OPC servers.  

Data Servers Filter Specifies the current filter for the selected item.    You can   edit the filter or 
select one from the filter list.  You   can also include in the filter the wild-
cards ? (to represent a single   character) or * (to represent two or more 
characters).  

Data Servers Filter 
Button

Use this button to update the item list based on the   current filter.  

Current Expression 
Box

Specifies the current expression.  You   can enter the expression directly 
or build it by making selections from   the other fields and buttons on the 
tabbed page.  

Valid Characters:   all alphanumeric characters, hyphen (-), underscore 
(_), exclamation point   (!), less than (<), greater than (>), pound (#), per-
cent (%), dollar   sign ($), ampersand (&), forward slash (/), backslash (\), 
pipe (|),   opening bracket ([), closing bracket (]), and single quote (').

If a single quote (') or a backslash (\) is a literal   part of the addressing 
string syntax,  it   must be preceded by a backslash (\) in order for the 
character to be passed   to the server as part of the address.  For   
example, to enter a tag with the name 'TEST', you would enter the data   
source FIX32.THISNODE.\'TEST\'.F_CV.

Note on Tag Group Substitution and your Expression

If you use tag group substitution and   the object of your substitution is 
an element in an OPC server address   that includes double quotes sur-
rounding its data items, it is recommended   that you add single quotes 
surrounding the tag group symbol. For example,   the following sub-
stitution for the PDS driver will fail:

'PDS.<Item Project=@PRJT@   Device="Device1" id="%R00001" 
dataType="VT_12"   FGUSpan="0.00" EGULow="0.00"/>'

However, the modified string ("'@PRJT@'")   in this example, is one 
that will resolve properly:

'PDS.<Item Project="'@PRJT@'"   Device="Device1" id="%R00001" 
dataType="VT_12"   FGUSpan="0.00" EGULow="0.00"/>'

Tolerance Specifies the current connection's rounding factor.    Typically,   iFIX uses 
this value when comparing a process value to a target value.    If the   pro-
cess value is within the specified tolerance, iFIX assumes the two   val-
ues are equal.  For   example, if the target value is 1.0, the tolerance is 
0.1, and the current   value of a data source is 0.8, iFIX does not assume 
the two values are   equal because the data source is not within the spe-
cified tolerance.  The   value must be within the range 0.9 to 1.1 to equal 
the target value.  

Deadband Specifies the maximum fluctuation you want for the   current connection 
before iFIX updates it.  By   entering a dead band value, you create a +/- 
dead zone around the connection's   current value.  As   long as the value 
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is within this range, iFIX does not update the value.    However,   once the 
value exceeds the maximum or minimum dead band, the value is   
updated.  

Refresh Rate Specifies the rate at which iFIX updates the current   connection.  iFIX   
updates the connection no faster than the specified speed.  For   speeds 
less than 1 second, iFIX updates no faster than once every 50 mil-
liseconds.    For speeds   greater than 60 seconds, iFIX updates no faster 
than once every 60 seconds.    

Check Syntax But-
ton

Use this button to check the syntax of your expression.    A valid   expres-
sion displays the message "Syntax check successful!"  An   error mes-
sage appears if the syntax is invalid. 

Mathematical Func-
tions Button

Use this button to show or hide a keypad of numbers,   and math-
ematical and Boolean operators you can use in your expressions.    

Alarm Counters Tab

Item Description
Node Names List 
Box

Displays a filtered list of SCADA servers that the local node is com-
municating   with.  By   default, all SCADA servers are displayed.  

Node Names Filter Specifies the current SCADA server filter.  You   can edit the filter or 
select one from the list.  You   can also include in the filter the wildcards 
? (to represent a single   character) or * (to represent two or more char-
acters).  

Node Names Filter 
Button

Use this button to update the list of nodes based on the current SCADA   
server filter.  

Alarm Area Tag 
Names List Box

Displays a filtered list of alarm areas on the selected SCADA server.    
Also displays   the alarm counter (ALARMCOUNTERS) tag.  By   default, 
all areas are displayed.  

Alarm Area Tag 
Names Filter

Specifies the current area name filter.  You   can edit the filter or select 
one from the list.  You   can also include in the filter the wildcards ? (to 
represent a single   character) or * (to represent two or more characters).  

Alarm Area Tag 
Names Filter Button

Use this button to update the list of areas based on the current area   fil-
ter.  

Alarm Counter Field 
Names List Box

Displays a filtered list of fields available from the selected area.    By 
default,   all fields are displayed.  

A_* Button Use this button to change the field filter to display all A_ fields.    
F_* Button Use this button to change the field filter to display all F_ fields.    
Alarm Counter Field 
Names Filter

Specifies the current area field filter.  You   can edit the filter or select 
one from the list.  You   can also include in the filter the wildcards ? (to 
represent a single   character) or * (to represent two or more characters).  

Alarm Counter Field 
Names Filter Button

Use this button to update the list of fields based on the current field   fil-
ter.  

Current Expression 
Box

Specifies the current expression.  You   can enter the expression directly 
or build it by making selections from   the other fields and buttons on the 
tabbed page.  

Valid Characters:   all alphanumeric characters, hyphen (-), underscore 
(_), exclamation point   (!), less than (<), greater than (>), pound (#), per-
cent (%), dollar   sign ($), ampersand (&), forward slash (/), backslash (\), 
pipe (|),   opening bracket ([), closing bracket (]), and single quote (').
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If a single quote (') or a backslash (\) is a literal   part of the addressing 
string syntax,  it   must be preceded by a backslash (\) in order for the 
character to be passed   to the server as part of the address.  For   
example, to enter a tag with the name 'TEST', you would enter the data   
source FIX32.THISNODE.\'TEST\'.F_CV.

Tolerance Specifies the current connection's rounding factor.    Typically,   iFIX uses 
this value when comparing a process value to a target value.    If the   pro-
cess value is within the specified tolerance, iFIX assumes the two   val-
ues are equal.  For   example, if the target value is 1.0, the tolerance is 
0.1, and the current   value of a data source is 0.8, iFIX does not assume 
the two values are   equal because the data source is not within the spe-
cified tolerance.  The   value must be within the range 0.9 to 1.1 to equal 
the target value.  

Deadband Specifies the maximum fluctuation you want for the   current connection 
before iFIX updates it.  By   entering a dead band value, you create a +/- 
dead zone around the connection's   current value.  As   long as the value 
is within this range, iFIX does not update the value.    However,   once the 
value exceeds the maximum or minimum dead band, the value is   
updated.  

Refresh Rate Specifies the rate at which iFIX updates the current   connection.  iFIX   
updates the connection no faster than the specified speed.  For   speeds 
less than 1 second, iFIX updates no faster than once every 50 mil-
liseconds.    For speeds   greater than 60 seconds, iFIX updates no faster 
than once every 60 seconds.    

Check Syntax But-
ton

Use this button to check the syntax of your expression.    A valid   expres-
sion displays the message "Syntax check successful!"  An   error mes-
sage appears if the syntax is invalid. 

Mathematical Func-
tions Button

Use this button to show or hide a keypad of numbers,   and math-
ematical and Boolean operators you can use in your expressions.    

Proficy Historian Tab

NOTE: This tab   only appears if the data source selected permits historical data.

Item Description
Servers Displays a selection list of servers.
Display Collector 
Name Check Box

Allows you to select whether Collector names are displayed.

Node Names List 
Box

Displays a filtered list of SCADA servers that the   local node is com-
municating with. By default, all SCADA servers are displayed.    

Tag Names List Box Displays a filtered list of database blocks (tags)   on the selected 
SCADA server. By default, all blocks are displayed.  

Description List Box Displays a filtered list of descriptors of  the   selected SCADA server. By 
default, all descriptions are displayed. 

Collector Names 
List Box

Displays a filtered list of Collector Names for the   selected SCADA 
server. By default, all Collector Names are displayed.

Filter fields Displays four drop-down lists that you can use filter what displays   in the 
tag list. Any combination of four filters can be selected at one   time: 

 l Node   - Specifies the current node name for the SCADA server 
you want to filter   on. Leave it set to All (*), or enter a node name 
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or expression to filter   by.

 l Tag   - Specifies the current description filter. Leave it set to All 
(*), or   enter a tag name or expression to filter by.

 l Description   - Specifies the current description filter. Leave it set 
to All (*), or   enter a tag description or expression to filter by.

 l Collector   Type - Specifies the current collector type filter. You 
can select   a collector type from this list, such as: All, Cal-
cEngine, File, iFIX,   LabData, Manual, OPC, Other, Server-
ToServer, and Simulation. The default   is All.

 l Engineering   Units - Specifies the engineering units filter. Leave 
it set to   All (*), or enter a type of units or expression to filter by.

 l Data   Type - Specifies the current tag name filter. You select a 
data   type from the list, such as: All, Double Float, Double 
Integer, Scaled,   Single Float, or Single Integer. 

For all fields, except Collector Type and Data Type, when building a   fil-
ter expression, you can include a wildcard ? (to represent a single   char-
acter) or * (to represent two or more characters) in the filter. 

Apply Filter Button Use this button to apply the selected filter to the   item list.  
Reset Filter Button Use this button to reset the item list based on the   current filter.
Filtered Tag Count Displays the number of tags found that meet filter   criteria.
Maximum Count Displays the maximum number of tags that the search   can return from 

Proficy Historian.
Current Expression 
Box

Specifies the current expression.  You   can enter the expression directly 
or build it by making selections from   the other fields and buttons on the 
tabbed page.  

Valid Characters:  all   alphanumeric characters, hyphen (-), underscore 
(_), exclamation point   (!), less than (<), greater than (>), pound (#), per-
cent (%), dollar   sign ($), ampersand (&), forward slash (/), backslash (\), 
pipe (|),   opening bracket ([), closing bracket (]), and single quote (').

If a single quote (') or a backslash (\) is a literal   part of the addressing 
string syntax,  it   must be preceded by a backslash (\) in order for the 
character to be passed   to the server as part of the address.  For   
example, to enter a tag with the name 'TEST', you would enter the data   
source FIX32.THISNODE.\'TEST\'.F_CV.

Check Syntax But-
ton

Use this button to check the syntax of your expression.    A valid   expres-
sion displays the message "Syntax check successful!"  An   error mes-
sage appears if the syntax is invalid. 

 

Find and Replace Dialog Box

The Find and Replace dialog box displays the following items:
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Find Tab

Item Description
Find What Specifies the text you want to search for (the search   string). 
Match Case Select this   check box to limit your search to only the values that match the 

exact   case of the search string.
Whole Word Only Select this check box to limit your search to only   whole words that match the 

search string.  A   whole word is any text delimited by a carriage return, a line 
feed, a   space, a hyphen (-), a semi-colon (;), a colon (:), a comma (,), a period   
(.), an underscore (_), an exclamation point (!), quotation marks ("),   an apo-
strophe ('), or the following characters: (, ), {, }, [, ].  

Data Source Only Select this check box to limit your search to only   data sources that match the 
search string. 

Include Scripts Select this check box to expand your search to include   the scripts associated 
with the current picture or schedule.  

Find Button Use this button to display any value that matches   the search string.  On   the 
Replace tab, only values you can modify appear.  These   values can be picture 
and scheduler properties, or property values of   objects in your pictures.   

Match List Displays the properties and property values that match   the search string after 
you click the Find button.  

On the Replace tab, a preview of the replaced text   also appears when you 
click Replace Preview.  You   can jump to the current picture, schedule, or one 
of the objects in the   list by double-clicking it.  

Stop Button Use this button to stop the search or replace in progress.    
Go To Button Use this button to jump to the object, picture, or   schedule selected in the 

Match List list box.   Before   jumping, the iFIX WorkSpace closes the Find and 
Replace dialog   box.  If   you jump to an object, the iFIX WorkSpace selects it 
after the   dialog box closes.  

Replace Tab

Item Description
Find What Specifies the text you want to search for (the search   string). 
Replace With Specifies the text you want to substitute for the   search string.  
Match Case Select this check box to limit your search to only   the values that match the 

exact case of the search string.  
Whole Word Only Select this check box to limit your search to only   whole words that match the 

search string.  A   whole word is any text delimited by a carriage return, a line 
feed, a   space, a hyphen (-), a semi-colon (;), a colon (:), a comma (,), a period   
(.), an underscore (_), an exclamation point (!), quotation marks ("),   an apo-
strophe ('), or the following characters: (, ), {, }, [, ].  

Data Source Only Select this check box to limit your search to only   data sources that match the 
search string. 

Include Scripts Select this check box to expand your search to include   the scripts associated 
with the current picture or schedule.  
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Find Button Use this button to display any value that matches   the search string.  On   the 
Replace tab, only values you can modify appear.  These   values can be pic-
ture and scheduler properties, or property values of   objects in your pictures.   

Replace Selected Use this button to replace only the property value   you select from the Match 
List box.  

Replace All Use this button to replace all property values found.    
Replace Preview Use this button to display the results of replacing   all property values in the 

Match List list box.  
Match List Displays the properties and property values that match   the search string.  On   

the Replace tab, a preview of the replaced text also appears when you   click 
Replace Preview.  You   can jump to the current picture, schedule, or one of 
the objects in the   list by double-clicking it.  

Stop Button Use this button to stop the search or replace in progress.    

Get Project Dialog Box

The Get Project dialog box displays the following items:

Select Project

Select a project name from the drop-down list. The names in this list   represent iFIX project names that 
you can retrieve from the Change Management   Server.   

Project Destination

The path that the project was last checked in with. Change this path   if it is the same as your local iFIX 
path. 

IMPORTANT:   Do not get a project directly into your local iFIX path.  Doing   so copies over your existing iFIX 
files, which may create problems the   next time you start iFIX. If you try to get a project to your local iFIX   path, 
an error message appears.

TIP: If you later   want to start iFIX with the SCU associated with this project, open the   SCU, and modify the path 
configuration (the base and NLS paths should   point to the local install, while the project path should point to 
folder   you copied the files to). You also should modify the startup tasks, network   configuration, SQL tasks, and 
local startup definition so that the appropriate   paths point to the local iFIX install. Save the SCU and restart 
iFIX to   start iFIX with this new SCU. 

Get Options

Item Description
Delete all existing 
files under Project 
Destination

Select this check box to delete all existing files in the path you specify,   
and replace them with the ones in this project. If you select this check   
box, it is strongly recommended that you select the Initialize Project   
Destination with iFIX Default Files check box. 

Initialize Project 
Destination with 
iFIX default files

Select this check box to restore your iFIX files to the factory default   set-
tings before retrieving the iFIX files from this project. If you do   not select 
this check box, you can get the files, but you will not be   able to run them 
in iFIX.

Selecting this check box helps your project to run properly if the path   is dif-
ferent from the default one listed when you select the project.   It is highly 
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recommended that you leave this check box selected.  

SCU File

Shows the SCU name of the currently selected project. If you change   the project destination, be sure to 
take note of this name; you will need   to locate it in the SCU to update it.   

Base Path

Shows the base path of the currently selected project. This is the main   iFIX folder. Other iFIX folders are 
usually subdirectories of the base   path.

If you change the project destination, be sure to take note of this   path; you will need to change base path 
in the SCU to the local base path.   

Project Path

Shows the project path of the currently selected project. This path   includes project specific application 
files, such as pictures, databases,   and tag groups. The default value for the Project Path is the base 
path.    

If you change the project destination, be sure to take note of this   path; you will need to change the pro-
ject path in the SCU to the destination   path. 

Import Toolbars Dialog Box

The Import Toolbars dialog box displays the following items:

Toolbars Box

Lets you select the toolbar you want to import.   

Owner

Lets you select an owner for the toolbar you are importing.  

Import

Lets you import the selected toolbar.  

Modify Server Dialog Box

The Modify Server dialog box displays the following items:

Data Server

Specifies a name for the OPC driver.  This   name identifies the driver to iFIX and is used in data sources 
to access   the selected OPC driver.  Make   sure the name you enter contains no spaces and is not 
already used by   another data server.  

OPC Server

Specifies the OPC driver you want use.  
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Machine Name

Specifies the local computer name, or the remote computer name that   the OPC Server resides on. 

Set As Default Server

Select this check box to set the current OPC server as the default server.    iFIX will   use this server when 
you do not explicitly enter a server name in a data   source.  

Multiple Command Script Wizard Dialog Box

The Multiple Command Script Wizard lets you use one or more command   Experts to build a sequence of 
actions that can be triggered by a mouse   click on an object, a Scheduler entry, or a key macro.

The Multiple Command Script Wizard dialog box displays the following   items:

Select Action to Append

The Select Action to Append drop-down list contains pre-defined Experts   that you can add to your com-
mand sequence.  When   you select an action from the list, its associated Expert launches. After   you con-
figure the Expert for use in the sequence, it will appear in the   Configured Actions list box.

NOTE: If the   Expert you want to append is already displayed in the drop-down list,   you can click the Append 
action button to launch the Expert.

Configured Actions

Append action button

Click this button to open the Expert currently displayed in the Select   Action to Append list.

Delete a selected action button

Click this button to delete a selected action.

Delete all actions button

Click this button to delete all actions in the Configured Actions list   box.

Up/Down buttons

Click the Up or Down button to move a selected action up or down in   the Configured Actions list box.

Show/Hide action details button

Click the Show or Hide button to display or hide the details of all   actions in the Configured Actions list 
box.

Modify selected action button

Click this button to modify the selected action.

Launch VB Editor

Click this button to launch the Visual Basic Editor.

Configured Actions List Box

78 © 2024 General Electric Company. All rights reserved.



The Configured Actions list box displays the command or sequence of   commands that have been con-
figured for the selected object. You can click   the plus symbol next to a command to expand it and dis-
play its configured   properties.

iFIX Project Backup Dialog Box

the iFIX Project Backup dialog box displays the following items:

Project Backup Wizard Button

Use this button to copy iFIX data and configuration files from the local   node to a compressed archive 
file.  

Backup Type

Custom Backup

Allows you to select specific files within the project path to backup.    

Full Backup

Select to backup all files, including security files, within the project   path.  

Project Restore Wizard Button

Use this button to copy iFIX data and configuration files from a compressed   archive file to the local 
node.  

iFIX Project Backup Wizard

the iFIX Project Backup Wizard displays the following items:

Custom Backup

Page 1

Item Description
Backup Type Specifies the type of backup you selected. 
Node Specifies the name of the local node from which you   are backing up files.
Project Path Specifies the path on the local node from which you   are backing up files.  
Backup File Option Select the types of files you want to back up.  
Include Security Files 
In Archive

Select to backup security settings.  This   option is only enabled when security 
files are found on the system. 

Backup Notes Displays notes about the backup. You cannot edit this   field.

Page 2

Item Description
Backup File 
Path and 
Filename

Allows you to specify the path and name of the archive   file to save.  You   can enter any 
valid file name and path, including a network path.  The   Wizard automatically appends 
the .FBK extension to the name you enter.    
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Browse But-
ton

Lets you select the path and file name of the archive   file by browsing to it.   

Full Backup

Item Description
Backup File 
Path and 
Filename

Allows you to specify the path and name of the archive   file to save.  You   can enter any 
valid file name and path, including a network path.  The   Wizard automatically appends 
the .FBK extension to the name you enter.    

Browse But-
ton

Lets you select the path and file name of the archive   file by browsing to it.   

iFIX Restore Wizard

the iFIX Restore Wizard displays the following items:

Page 1

Backup Filename To Restore

Specifies the name of the archive file you want to copy files from and   the path to it.  

Browse Button

Lets you select the path and file name of the archive file by browsing   to it.   

Page 2

Backup Type

Displays the type of archive you are restoring (Custom, Full, or Factory   Default), and displays the loc-
ation of the archive file.  

Restore Destination Options

Item Description
Use the Cur-
rent SCU

Select this option to restore files into the current   project path.  

Use SCU 
File From 
Archive

Select this option to restore files into the project   path specified in the archived SCU.   

NOTE: When   you select the Use SCU File from Archive option, be sure check the 
default   iFIX path configurations in the SCU in each of your iFIX projects after   you restore 
your files. For example, if you installed the latest version   of iFIX to a 64-bit path (C:\Pro-
gram Files (x86)\Proficy\iFIX),   and your previous picture files were installed to a 32-bit 
path (C:\Program Files (x86)\Proficy\iFIX), you will need to make sure you update these   
paths in the SCU to 64-bit.

Create a 
New Project

Select this option to restore files to a new project   path with a default sub-project path.  
To   modify the default sub-project paths, refer to the BackupRestore.ini or   user-specified 
ini file.  

Optionally, once you have restored the file, you can   create a new SCU file and point to 
these new paths.   
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SCU File Specifies the path and name of the local node's current   SCU file.  
Node Specifies the name of the local node.    
Project Path Specifies the project path of the local node.  You   can change the project path by over-

writing the existing SCU file on the   local node and entering a new path.  The   wizard uses 
the path in this field to restore its files, creating any   non-existent relative paths defined in 
the archive file.  

View Project 
Path Con-
figuration

Click to display the configured paths for the restored   files within the project.  

Restore File Options

Item Description
Delete All Existing 
Files Under Target 
Path Before   The 
Restore

Select this check box to delete all existing files   under the selected project path 
before restoring a Custom or Full backup   file.  This   option will not delete exist-
ing security files or the current SCU file   loaded in local startup. 

Restore Default iFIX 
Files Before Restoring 
Your Backup   Files

Select this check box to restore default iFIX files   before restoring your backup 
files.  For   Custom and Full restores, the default iFIX files are restored from the   
FactoryDefault file.  

To modify the default settings, modify the FactoryDefault   definitions in the 
BackupRestore.ini file.  

Leave Current Secur-
ity Settings Alone

Select this option to maintain the current security   settings and ignore security 
overwrites in the backup files during the   restore.  

Replace Existing 
Security Files With 
Archived Files

Select this option to replace the current security   settings with the security set-
tings in the archived files.

Delete Existing Secur-
ity Files And Disable 
Security

Select this option to delete all existing security   files from the current iFIX sys-
tem and disable security upon restore.   This field also displays the current 
status of security (Enabled or Disabled).    

Restore File Selection Box

Select the types of files you want to restore.  

Task Wizard Dialog Box

The Task Wizard dialog box displays the following items:

Task Categories

Specifies a task category.  Each   category contains Experts related to the category name.  For   example, 
the Database category contains Experts that let you create and   modify database blocks.  

Tasks

Lets you select and run an Expert.  
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Perform Task

Use this button to run the selected Expert.  

Toolbars Dialog Box

The Toolbars dialog box displays the following items:

Owner

Lets you select a toolbar owner.  Only   active owners appear in the list.  

Toolbars

Lets you show and hide the selected toolbar.  

Customize

Lets you: 

 l Create, import, and   delete toolbars.

 l Create, arrange,   and delete toolbar buttons.

 l Create, rename, and   delete toolbar categories.

Show ScreenTips On Toolbars

Lets you enable or disable text descriptions for every button on every   toolbar.  When   enabled, you can 
display a description by placing the cursor over a button.    

User Preferences Dialog Box

Click a link below for more information about the tabs featured in the   User Preferences dialog box.

 l General   Tab

 l Animations   Data Error Defaults Tab

 l Shape   Preferences Tab

 l Picture   Preferences Tab

 l Standard   Chart Preferences Tab

 l Drawing   Options Tab

 l Environment   Protection Tab

 l Background   StartUp Tab

 l StartUp   Pictures Tab

 l Change   Management Tab

 l Operations Hub Tab

 l Historian Tab

General Tab - User Preferences Dialog Box
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The General tab of the User Preferences dialog box displays the following   items:

WorkSpace Options

Item Description
Start 
WorkSpace 
In Run Mode

Select this check box to indicate that the iFIX WorkSpace   starts in the run-
time environment. Clear this check box to indicate that   the iFIX WorkSpace 
starts in the configuration environment.  

Auto Save 
Documents 
When Switch-
ing From Con-
figure   To Run

Select this check box to automatically save open documents   when the iFIX 
WorkSpace switches to the run-time environment.  

Full Screen In 
Run Mode

Select this check box to display pictures in the run-time   environment with the 
maximum screen space possible.  When   the iFIX WorkSpace displays full-
screen in the run-time environment, the   menu bar is hidden.  The   system tree 
and all toolbars are always hidden in this environment.  

Always 
Create 
Backup Copy

Select this check box to automatically copy the previous   version of a file to a 
back-up folder each time you save a new version.    If a back-up   file already 
exists, the new back-up file replaces it.  

Fire 
DataChange   
Event On 
Startup

Select this check box to configure the Data Change   event of an event object to 
fire only when there is new data after the   initialization.  

Actions such as switching from the Configuration environment   to the Run-time 
environment while an iFIX schedule is open will cause   the DataChange   event 
to trigger accordingly.

If you select this option, iFIX fires the event when   initializing the event object 
at the time you open a picture and switch   to run mode.  Clear   this check box if 
you want events to fire only if the data source truly   changes.

Extend 
WorkSpace 
to Support 
Multiple Mon-
itors

Select this check box if you plan to use multiple   monitors with your iFIX dis-
plays. 

Enable Rib-
bon User 
Interface

Select this check box to use the Ribbon user interface   in the iFIX WorkSpace. 
Clear this check box to use the Classic user interface   in the iFIX WorkSpace.

Zoom To Fit 
in Run Mode

In run mode, select this check box to suppress the   scroll bars and to show the 
entire picture in the current picture window.   Only pictures using Enhanced 
Coordinates that are opened in Run mode will   honor this setting. If you do not 
want to apply this setting to a specific   picture, then a script change under the 
picture initialization code is   required. For more information, refer to the 
ZoomToFit Method   section in iFIX Automation Reference   e-book.

Enable High 
Performance 
HMI Graphics

Select this check box to create high performance graphics in iFIX pictures that 
use the High Performance color set and the high performance settings for 
shapes and picture creation. For more information, refer to the Creating High 
Performance Pictures e-book.
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Electronic Signature Options

Item Description
Perform Com-
ments Table 
Name

Specifies the name of the table that contains predefined   perform comments 
for the Electronic Signature dialog box.    

Create Default 
Perform Com-
ments Table

Use this button to create a new table containing predefined   perform com-
ments for the Electronic Signature dialog box.    

Verify Com-
ments Table 
Name

Specifies the name of the table that contains predefined   verify comments in 
the Electronic Signature dialog box.    

Create Default 
Verify Com-
ments Table

Use this button to create a new table containing predefined   verify comments 
for the Electronic Signature dialog box.    

Custom ActiveX 
Control ProgID

Specifies the ProgID   for the custom ActiveX control you want to use to 
replace the standard   electronic signature ActiveX control used to capture 
user names and passwords   for signatures. 

When the Electronic Signature dialog box opens, it   checks this field for a 
ProgID.  If no ProgID is found, the standard Esignature   ActiveX control is 
displayed. If a ProgID is found, the Electronic Signature dialog box attempts 
to create the custom   ActiveX control. However, if creation of the control 
fails, a message is displayed stating that   the custom control could not be 
created and the standard Esignature   ActiveX control is displayed instead. 

Security Options

User Accounts Disabled Message

Specifies the message that appears from the Electronic Signature dialog   box when a user account is no 
longer valid.

Expression Editor Options

Remember Last Filter

Select this check box so that the last filter used in the Expression   Builder dialog box is remembered. 
This is useful if you frequently use   the same or similar information when building your expressions.

Animations Data Error Defaults Tab - User Preferences Dialog Box

The Animations Data Error Defaults tab of the User Preferences dialog   box displays the following items:

Linear Animation Object Defaults

Item Description
ConfigurationSpecifies the default OPC error values that iFIX returns   when a linear, format, 

or lookup animation fails to receive data because   the specified data source 
could not be found.  You   can define your own defaults for each type of anim-
ation by entering a   new value into each field.  

Out of Ser-
vice

Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   the specified I/O point is off 
scan.  You   can define your own defaults for each type of animation by entering 

84 © 2024 General Electric Company. All rights reserved.



a   new value into each field.  
Unknown Specifies the default OPC error values that iFIX returns   when a linear, format, 

or lookup animation receives an undefined error.    You can   define your own 
defaults for each type of animation by entering a new   value into each field.  

Uncertain Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives questionable data.    This data   may be out of range 
or may be the result of combining good data with uncertain   data.  You   can 
define your own defaults for each type of animation by entering a   new value into 
each field. 

Comm Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives a network error.  You   can define your own defaults 
for each type of animation by entering a   new value into each field.  

Device Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   an OPC device did not 
respond.  You   can define your own defaults for each type of animation by enter-
ing a   new value into each field.  

Format Animation Object Defaults

Item Description
ConfigurationSpecifies the default OPC error values that iFIX returns   when a linear, format, 

or lookup animation fails to receive data because   the specified data source 
could not be found.  You   can define your own defaults for each type of anim-
ation by entering a   new value into each field.  

Out of Ser-
vice

Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   the specified I/O point is off 
scan.  You   can define your own defaults for each type of animation by entering 
a   new value into each field.  

Unknown Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives an undefined error.    You can   define your own 
defaults for each type of animation by entering a new   value into each field.  

Uncertain Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives questionable data.    This data   may be out of range 
or may be the result of combining good data with uncertain   data.  You   can 
define your own defaults for each type of animation by entering a   new value into 
each field. 

Comm Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives a network error.  You   can define your own defaults 
for each type of animation by entering a   new value into each field.  

Device Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   an OPC device did not 
respond.  You   can define your own defaults for each type of animation by enter-
ing a   new value into each field.  

Lookup Animation Object Defaults

Numeric Table Entries

Item Description
ConfigurationSpecifies the default OPC error values that iFIX returns   when a linear, format, 

or lookup animation fails to receive data because   the specified data source 

© 2024 General Electric Company. All rights reserved. 85



could not be found.  You   can define your own defaults for each type of anim-
ation by entering a   new value into each field.  

Unknown Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives an undefined error.    You can   define your own 
defaults for each type of animation by entering a new   value into each field.  

Comm Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives a network error.  You   can define your own defaults 
for each type of animation by entering a   new value into each field.  

Out Of Ser-
vice

Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   the specified I/O point is off 
scan.  You   can define your own defaults for each type of animation by entering 
a   new value into each field.  

Device Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   an OPC device did not 
respond.  You   can define your own defaults for each type of animation by enter-
ing a   new value into each field.  

Uncertain Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives questionable data.    This data   may be out of range 
or may be the result of combining good data with uncertain   data.  You   can 
define your own defaults for each type of animation by entering a   new value into 
each field. 

String Table Entries

Item Description
ConfigurationSpecifies the default OPC error values that iFIX returns   when a linear, format, 

or lookup animation fails to receive data because   the specified data source 
could not be found.  You   can define your own defaults for each type of anim-
ation by entering a   new value into each field.  

Unknown Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives an undefined error.    You can   define your own 
defaults for each type of animation by entering a new   value into each field.  

Comm Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives a network error.  You   can define your own defaults 
for each type of animation by entering a   new value into each field.  

Out Of Ser-
vice

Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   the specified I/O point is off 
scan.  You   can define your own defaults for each type of animation by entering 
a   new value into each field.  

Device Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation fails to receive data because   an OPC device did not 
respond.  You   can define your own defaults for each type of animation by enter-
ing a   new value into each field.  

Uncertain Specifies the default OPC error values that iFIX returns   when a linear, format, 
or lookup animation receives questionable data.    This data   may be out of range 
or may be the result of combining good data with uncertain   data.  You   can 
define your own defaults for each type of animation by entering a   new value into 
each field. 

Color Table Entries
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Item Description
ConfigurationUse this button to open the Select Color dialog box   where you can choose the 

default color that iFIX displays when a lookup   animation fails to receive data 
because the specified data source could   not be found.  

Unknown Use this button to open the Select Color dialog box   where you can choose the 
default color that iFIX displays when a lookup   animation receives an undefined 
error.    

Comm Use this button to open the Select Color dialog box   where you can choose the 
default color that iFIX displays when lookup   animation receives a network error.  

Out Of Ser-
vice

Use this button to open the Select Color dialog box   where you can choose the 
default color that iFIX displays when a lookup   animation fails to receive data 
because the specified I/O point is off   scan.  

Device Use this button to open the Select Color dialog box   where you can choose the 
default color that iFIX displays when a lookup   animation fails to receive data 
because an OPC device did not respond.     

Uncertain Use this button to open the Select Color dialog box   where you can choose the 
default color that iFIX displays when a lookup   animation receives questionable 
data.  This   data may be out of range or may be the result of combining good 
data with   uncertain data.  

Shape Preferences Tab - User Preferences Dialog Box

The Shape Preferences tab of the User Preferences dialog box displays   the following items:

Color

Item Description
Fade Color Use this button to open the Select Color dialog box   where you can choose the 

default shape fade color.
Foreground 
Color

Use this button to open the Select Color dialog box   where you can choose the 
default shape foreground color.  

Background 
Color

Use this button to open the Select Color dialog box   where you can choose the 
default shape background color.  

Edge Color Use this button to open the Select Color dialog box   where you can choose the 
default shape edge color.

Font

Item Description
Font 
Name

Specifies the default font for text objects.  

Font Size Specifies the default size of text objects.  
Font 
Styles

Specifies the default text object style.  The   text can be regular, bold, italics, or bold 
italics.  

General

Item Description

Edge Style Specifies the default shape edge style.  Edges   can be solid, transparent, dotted, 
or dashed.  
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Edge Width Specifies the default shape edge width.  You   can enter any width from 0 to 255 
pixels.  

Hit Test 
Size

Specifies the minimum distance the cursor can be from   an object before high-
lighting the object.  You   can enter any distance from 0 to 255 pixels.  

Blend Per-
cent

Specifies how much of the fade color, in a percentage,   will be mixed with the fore-
ground color. The higher the percentage, the   more the fade color is visible.  

Fill Style Specifies the default shape foreground fill style.    Fills can   be solid, transparent, 
gradient, or a pattern.  

Background 
Style

Specifies whether the default shape background is   opaque or transparent. 

Fade Type Specifies the default fade type for shape objects.    Fade types   can be linear, con-
centric, radial, or reflected.  

Pipe

Item Description
Thickness Specifies the default thickness for pipe objects.    You can   enter any value from 10 

to 300.  
Elbow 
Style

Specifies the default elbow style for pipe objects.    Elbow styles   can be round or 
square.  

Start Cap Specifies the default start cap for pipe objects.    Start caps   can be round, square, 
horizontal-diagonal, or vertical-diagonal. 

End Cap Specifies the default end cap for pipe objects.  End   caps can be round, square, 
horizontal-diagonal, or vertical-diagonal.    

Datalink –   Remove Leading and Trailing Spaces

Select this check box to indicate whether iFIX should remove extra spaces   when Data links are dis-
played in the run-time environment.  This   check box is selected by default, which means that all blank 
spaces before   and after data within Data links will be stripped out.  Also,   note that this option only 
applies to Data links that display ASCII (A_)   or Raw Format data.  If   you change this option, you must 
restart the WorkSpace for the change   to take effect.  

Text –   Remove Leading and Trailing Spaces

Select this check box so that leading and trailing spaces are removed   from text objects that you add to 
the WorkSpace. This setting only applies   to text entered after you change the setting; it does not change 
existing   text entries.

By default, this check box is selected.  

Historical Datalink –   Show Time Stamp with Data

Select this check box to specify that the Historical Datalink include   the time stamp with the data. The 
time stamp appears only at run-time.   

By default, this check box is selected. 

Picture Preferences Tab - User Preferences Dialog Box

The Picture Preferences tab of the User Preferences dialog box displays   the following items:
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Properties

Item Description
Window Size Specifies the default window size for pictures.  You   can create windows 

full size, half the height or width of the screen,   or a quarter of the screen.  
Automatically 
Determine Docu-
ment Size

Select this check box to enable the Document Width   and Document 
Height fields to allow you to define your own coordinate   system that differs 
from the default logical coordinate system of 4:3   horizontal to vertical res-
olution.  You   should not change this setting unless you are familiar with the 
coordinate   system used for  measuring   picture height and width.  Other-
wise,   objects may not animate as expected.  

Document Height Specifies the default picture height in logical units   or postscript points.
Document Width Specifies the default width for pictures in logical   units or postscript points. 
Highlight Timeout 
Interval

Specifies the length of time an object remains highlighted   at run-time.  
When   the specified interval expires, the highlight disappears.  You   can 
enter the time in hundredths of a second.  

Grid Interval Specifies the number of pixels between grid points.    
Background Color Use this button to open the Select Color dialog box   where you can choose 

the default picture background color.
Fade Color Use this button to open the Select Color dialog box   where you can choose 

the default picture fade color. 

Basic Animation Dialog

Item Description
Prompt On Delete Select this check box to be prompted to confirm the   deletion of an anim-

ation in the Basic Animation dialog box and the Command   Expert dialog 
box. 

Always Show 
Basic Animation 
Dialog

Select this check box to display the Basic Animation   dialog box when you 
double-click an object or select Animations from an   object's right-click 
menu.  

If this check box is cleared, the Advanced Animations   dialog box appears.  

Create Picture Wizard

Show Picture Wizard From New Picture Menu

Select this check box to display the Create Picture Wizard. If this   check box is cleared, the Create Pic-
ture Wizard is unavailable.

Picture Translation

Item Description
Translate Pic-
ture On Open

Select this check box if you want to replace the text   strings in all of your pic-
tures with a selected language file (if it exists)   when you open them in the run-
time environment. 

If this check box is selected, the TranslateOnOpen   and LanguageDesired   prop-
erties on each picture's Properties window cannot be changed. 

If this check box is cleared, you can configure the   TranslateOnOpen   and Lan-
guageDesired   properties at the individual picture level. 
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Language Specifies the language that all of your pictures'   text strings will appear in when 
the pictures are opened in run mode.   This field is available only when the Trans-
late Picture on Open check   box is selected. 

Window Properties

Item Description
Title Bar Select this check box to indicate whether your pictures   appear with or without title bars.  
System Menu Select this check box to indicate whether you are   creating pictures with or without a 

System menu, or Maximize, Minimize,   and Close buttons.  
Resizable Select this check box to indicate whether you can   or cannot resize pictures.  
Always On 
Top

Select this check box to indicate that your pictures   will automatically float on top of all 
other open documents.  Typically,   this feature is used to create detail pictures that you 
always want to   display on top of other pictures.  

Grid Enabled Select this check box to indicate whether or not the   grid in pictures is automatically dis-
played.  

Snap To Grid Select this check box to indicate whether or not your   pictures will automatically align 
objects to the grid.  

Click And 
Stick Enabled

Select this check box to indicate whether or not your   pictures show or hide visual cues 
as to which objects can be selected   and which object is currently selected.  

Gradient

Enable Gradient

Select this check box to enable the Gradient fill style. The default   fade type for the picture is linear. You 
can change the picture's fade   type in the Edit Picture dialog box. 

Thumbnail

Save Thumbnail

Select this check box to save a thumbnail of each picture you create.   

Cache

Item Description
Enable Pic-
ture Cache

Select this check box to enable picture caching, which   reads and opens previously 
opened pictures from memory. Clear this check   box to indicate that picture files will be 
opened from the disk drive.    

Cache Size Specifies the number of pictures (from 1-99) you want   in the cache.  

Standard Picture Scaling

Disable Auto Scale Feature

Select this check box to override the logical units to pixel ratio (Logical   Coordinate System) when chan-
ging the resolution of your screen. This may   be helpful for multiple monitor configurations.  

For the Enhanced Coordinate System, Auto Scale calculates the picture   window size percentages 
based on the resolution of the window with the   current view of the picture. Disabling this feature will cal-
culate the   window sizes based on the resolution where this picture was last saved.
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Picture Files Open Style

Open in Read Only Mode

Select this check box to open picture files in read-only mode. This setting is helpful for working with 
Webspace and Remote Desktop (Terminal Server) sessions. By selecting this option, it will help you 
exceed the Windows limitation of 20 concurrent user sessions of iFIX pictures.

Standard Chart Preferences Tab - User Preferences Dialog Box

NOTE: The following   options apply only to Standard Charts.

The Standard Chart Preferences tab of the User Preferences dialog box   displays the following items:

Scroll Direction

Item Description
Scroll Right To Left Select this option to set the default scroll direction   for all charts to a right-to-left 

scroll.  
Scroll Left To Right Select this option to set the default scroll direction   for all charts to a left-to-right 

scroll.  
Reset Specifies the percentage of the chart that moves when   the plotted data reaches 

the left edge of the chart.  For   example, when you enter 25 into this field, the 
chart shifts right 25%   along its time (X) axis and continues plotting data.  

Time Axis

Item Description
Number Of Ticks Specifies the default number of ticks to display on   your chart's time (X) axis.  

You   can enter any value from 0 to 20 into this field.  
Number Of Labels Specifies the default number of labels to display   on your chart's time (X) axis.  

You   can enter any value from 0 to 20 into this field.  

Value Axis

Item Description
Number Of Ticks Specifies the default number of ticks to display on   your chart's value (Y) axis.  

You   can enter any value from 0 to 20 into this field.  
Number Of Labels Specifies the default number of labels to display   on your chart's value (Y) axis.  

You   can enter any value from 0 to 20 into this field.  

Time Axis Span

Item Description
Duration Days Specifies the amount of data your charts display along   their time (X) axes.  You   

can enter any value from 0 to 999 days in the Days field.  In   the Time field, 
enter the time in hours, minutes, and seconds.   You   can enter any time up to 
23 hours, 59 minutes, and 59 seconds.  

Duration Time Specifies the amount of data your charts display along   their time (X) axes.  You   
can enter any value from 0 to 999 days in the Days field.  In   the Time field, 
enter the time in hours, minutes, and seconds.   You   can enter any time up to 
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23 hours, 59 minutes, and 59 seconds.  
Interval Time Specifies the default interval between the data points   on your charts.  In   the 

Time field, enter the time between data points in hours, minutes,   and seconds.  
You   can enter any time up to 23 hours, 59 minutes, and 59 seconds.  

The interval cannot be greater than half the duration.    If you   enter zero, iFIX auto-
matically calculates the interval as the duration   divided by the number of dis-
play points.  

General

Item Description
Allow Time Axis 
Reset

Select this check box to control changes to the limits   on the X (time) axis in a 
chart.  Initially,   the limits are set to match the time specified on the Time tab of 
the   Chart Configuration dialog box.  However,   when you select this check box, 
you enable the time axis limits of your   chart to be reset after you right-click the 
object to zoom out.  The   chart resets the time axis limits to the values of the 
Start Time and   End properties.  

Allow Value Axis 
Reset

Select this check box to control changes to the limit   on the Y (value) axis in a 
chart.  Initially,   the limits are set to match the High and Low limits specified on 
the Pen   tab of the Chart Configuration dialog box.  However,   when you select 
this check box, you enable the value axis limits of your   chart to be reset after 
you right-click the object to zoom out.  The   chart resets the value axis limits to 
the values of the HiLimit and LoLimit   properties.  

Transparent Select this check box to create a chart with a transparent   background.  

Drawing Options Tab - User Preferences Dialog Box

The Drawing Options tab of the User Preferences dialog box displays   the following items:

Geometry Helper Options

Item Description
Always Extend Lines Specifies that the selected lines will always extend   to the intersection 

point when the Extend Lines button on the CAD Toolbar   is used.  
Extend Only When The Exten-
sion Is Shorter Than Half   The 
Line

Specifies that the selected line will be extended   to the intersection 
point only when the extension is shorter than half   the line being exten-
ded.  

Extend Only When The Exten-
sion Is Shorter Than X Pixels

Specifies that the selected line will be extended   to the intersection 
point only when the extension is shorter than the   defined value.  

Always Trim Lines Specifies that the selected lines will always be trimmed   at the inter-
section point when the Trim Lines button on the CAD Toolbar   is used.  

Trim Only When The Trimmed 
Area Is Shorter Than X Pixels

Specifies that the selected line will be trimmed at   the intersection 
point only when the trimmed area is shorter than the   defined value.  

Graphics Connections

Always Show Connection Nodes
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Select this check box to indicate that the connection nodes are always   displayed on the shapes in a pic-
ture.  If   this check box is cleared, the connection points are not visible, but   can be displayed using one of 
the following methods:

 l Select a connector   and move it towards the shape to anchor it to a certain connection point   on the 
shape.

- Or -

 l Select the shape   and click either the Add Connection Point button or Delete Connection   Point but-
ton on the CAD Toolbar.  

Environment Protection Tab - User Preferences Dialog Box

The Environment Protection tab of the User Preferences dialog box displays   the following items:

Enable Run Time Environment Protection

Select this check box to enable environment protection for the local   node.  When   enabled, you can 
select the specific options that you want to restrict   access to. These options take effect when you 
switch to the run-time environment.    

WorkSpace Title and Menu Options

Item Description
Disable Title 
Bar And 
Menu Bar

Select this check box to hide the WorkSpace menu bar   and title bar at run-time.  

NOTE: In Ribbon view, if this option is selected, the Title Bar takes on the 
appearance of Classic view, rather than Ribbon view. 

Enable 
ALT+F4

When the WorkSpace title bar is disabled, there is no way to shut down the 
WorkSpace application in run mode. Select this check box to allow the use of 
the ALT+F4 keyboard shortcut to shut down the WorkSpace in run mode when 
the WorkSpace title bar is disabled. The logged-in user must have the Enable 
Task Switching and Workspace Runtime Exit security features enabled.  

Disable 
Menu Bar

Select this check box to disable the WorkSpace menu bar at run-time.

Disable 
"WorkSpace" 
Menu Pull-
down

Select this check box to disable the WorkSpace menu at run-time.

NOTES:
 l When   WorkSpace is running with the Ribbon in full screen mode and you enable   the  Run   Time Envir-

onment Protection and Disable Title bar and Menu Bar options,   the Ribbon bar will be displayed when 
the Alt key is pressed. This will   allow access to the Historical tab with Global Time Control. All other   
menus will be removed or disabled and the WorkSpace cannot be dragged,   minimized, or closed 
using the Ribbon bar.

 l The   historical tab with Global Time Control can be removed by modifying the   DyanmicRibbon.ini file in 
the iFIX install ADDON folder and setting [StandardTabs]   Historical=0. If the tab is removed and no 
other tabs are visible on the   run mode Ribbon (because you also enabled the enable the  Run   Time 
Environment Protection and Disable Title bar and Menu Bar options)   , the Ribbon bar will not display 
when the Alt key is pressed.
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WorkSpace File Menu Accelerators

Item Description
Disable "WorkSpace" 
File Menu Accel-
erators

Select this check box to disable both the Open (Ctrl+O)   and Print 
(Ctrl+P) WorkSpace file menu accelerators while in the Run-time   envir-
onment.  

Disable Open Accel-
erator

Select this check box to disable the Open (Ctrl+O)   WorkSpace file 
menu accelerator while in the Run-time environment.  

Disable Print Accel-
erator

Select this check box to disable the Print (Ctrl+P)   WorkSpace file 
menu accelerator while in the Run-time environment.  

Other Options

IMPORTANT: When iFIX security is enabled, these options are overridden by the logged in user's per-
missions.

Item Description
Disable <Ctrl> <Alt> 
<Del>

Select this check box to disable the <Ctrl><Alt><Delete>   key 
sequence at run-time, thereby restricting operators from accessing   
the Task Manager, changing their password, logging off, or shutting 
down   the computer.  

Disable Task Switch-
ing

Select this check box to disable run-time task switching   through 
<Alt><Tab> and the Start button. 

NOTE: The   Shift + F10 key macro does not work if you select this 
option. 

Disable VBE Access Select this check box to allow you to restrict access   to the Visual 
Basic Editor at run-time.  If   access is not restricted, the editor appears 
when a compilation or run-time   error occurs, allowing you to correct 
the error.  When   you restrict access, the iFIX WorkSpace suppresses 
the Visual Basic Editor   even if an error occurs.  

Background StartUp Tab - User Preferences Dialog Box

The Background StartUp tab of the User Preferences dialog box displays   the following items:

Background Task StartUp Schedules List Box

Displays the schedules configured to automatically load in the background   task when the background 
task is started.  By   double-clicking in the list, you can enter or edit any scheduled entry.    You can   also 
select the schedule you want to add by browsing to it with the Browse   button. 

New Button

Use this button to add a schedule (Background Startup tab) or a picture   (Startup Pictures tab) to the 
start-up list by entering its name and path.    You can   also select the file by browsing to it with the Browse 
button.  

Delete Button

Use this button to delete the selected file from the start-up list.    

Move Up Button

Use this button to move the selected file up in the start-up list.  
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Move Down Button

Use this button to move the selected file down in the start-up list.    

StartUp Pictures Tab - User Preferences Dialog Box

The StartUp Pictures tab of the User Preferences dialog box displays   the following items:

StartUp Pictures List Box

Displays the pictures you want to open automatically when the iFIX WorkSpace   starts in the run-time 
environment.  By   double-clicking in the list, you can enter or edit any entry.  You   can also select the pic-
ture you want to add by browsing to it with the   Browse button.

New Button

Use this button to add a schedule (Background Startup tab) or a picture   (Startup Pictures tab) to the 
start-up list by entering its name and path.    You can   also select the file by browsing to it with the Browse 
button.  

Delete Button

Use this button to delete the selected file from the start-up list.    

Move Up Button

Use this button to move the selected file up in the start-up list.  

Move Down Button

Use this button to move the selected file down in the start-up list.    

Change Management Tab - User Preferences Dialog Box

The Change Management tab of the User Preferences dialog box displays   the following items:

Enable Change Management Server Connection

Select this check box to if you want to enable iFIX to connect to the   Change Management Server. With 
this option selected, right mouse   menu items for Change Management become available in the iFIX 
WorkSpace.   

NOTE: You cannot   edit the fields in this dialog box if security is disabled, or after you   connect to the Change 
Management Server. 

Logon Info

Item Description
Change Management 
Server

Enter the name of your Change Management Server.   For instance, if your 
server is named MYSERVER, enter MYSERVER in this   field.  

Test Connection Click to test a connection to the Change Management   Server.  After   you supply 
login credentials for the Change Management Server, a message   box appears 
indicating whether a connection can be made.  

NOTE: If   you do not have iFIX security Change Management application priv-
ileges,   you will receive an error message when you click Test Connection. For   
more information refer to the Overview of iFIX Configuration Steps in   the 
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Change Management and iFIX ebook.
Logon at WorkSpace 
Startup

Select this check box to log in to the Change Management   Server when you 
start the iFIX WorkSpace. 

Clear this check box if you only want to login to   the Change Management 
Server from the right-click menu. (In the system   tree, right-click the node name, 
select Manage, and then click Logon.)

TIP: If   you have a very large iFIX project, it is recommended that you clear this   
check box. Otherwise, for large projects, it may take several extra minutes   for 
the iFIX WorkSpace to start up. 

Prompt For User 
Name And Password 
At Logon

Select this check box if you always want a dialog   box requesting login cre-
dentials to appear when you logon to the Change   Management Server. 

Clear this check box if you want to allow for automatic   logon. 

NOTE: For   an automatic logon to work, the user name and password must be 
identical   on both the Change Management Server and in iFIX. If the user name 
and   password does not match in both applications, or the iFIX user you are   
logged in as is not defined as a user on the Change Management Server   (or 
vice versa), after an error message, the Logon dialog box appears,   even with 
this check box cleared. 

Change Management Project Name

Enter the name of the Change Management project folder you want to open   after you logon.  Files   you 
check out or check in will reside in this project folder.  

Require comments to check in and check out files

Select this check box if you want to require that the user enter a comment   when checking out or check-
ing in a file. If you require comments, the   OK button (found in the Check Out and the Check In dialog 
boxes) does   not become available until you enter a comment.

Electronic Signature Options

Item Description
Perform Comments 
Table Name

Specifies the name of the table that contains predefined   perform comments for 
the Electronic Signature dialog box used with Change   Management actions in 
the iFIX WorkSpace. 

This table name can be the same as the one you use   for iFIX Performed By 
electronic signatures, as defined on the General   tab. Or, you can enter another 
table with perform comments applicable   only to the Change Management 
Server. 

Create Default Per-
form Comments Table

Use this button to create a new table containing predefined   perform comments 
for the Electronic Signature dialog box that appears   with Change Management 
actions in the iFIX WorkSpace.    

Verify Comments 
Table Name

Specifies the name of the table that contains predefined   verify comments for 
the Electronic Signature dialog box used with Change   Management actions in 
the iFIX WorkSpace. 

This table name can be the same as the one you use   for iFIX Verfied By elec-
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tronic signatures, as defined on the General tab.   Or, you can enter another 
table with verify comments applicable only to   the Change Management Server.  

Create Default Verify 
Comments Table

Use this button to create a new table containing predefined   verify comments 
for the Electronic Signature dialog box that appears with   Change Management 
verify actions in the iFIX WorkSpace.   

None Select this option if no iFIX electronic signature   is required to perform a Change 
Management function from the WorkSpace.    

Perform Only Select this option if an iFIX Performed By electronic   signature is required to per-
form a Change Management function from the   WorkSpace (in addition to the 
Change Management Server login).  

Perform And Verify Select this option if a Performed By and Verified   By electronic signature is 
required by iFIX in order to perform a Change   Management function from the 
iFIX WorkSpace (in addition to the Change   Management Server login).  

Allow Continuous Use Select this check box to allow the operator to repeatedly   sign for successive 
actions by supplying only a password, when electronic   signatures are enabled. 
Continuous use applies only to the person performing   an action and does not 
affect the person verifying an action.  

Operations Hub Tab - User Preferences Dialog Box

The Operations Hub tab of the User Preferences dialog box displays   the following items:

Operations Hub Configuration

Item Description
Server Name Enter the network name of the Operations Hub Server. 

NOTE: IP addresses are not acceptable for the Server Name.
Proficy Auth. (UAA)  l If using Operations Hub and Proficy Authentication on the same server, 

leave this entry blank.
 l If using Operations Hub with with Proficy Authentication on a different 

server, enter the machine name where Proficy Authentication resides.
 l Update your hosts file to add the related machine IP addresses for Oper-

ations Hub and Proficy Authentication.
Port Enter the port number you want to communicate with Operations Hub. By 

default, the port is port 443.
User Name Enter the user name to connect to the Operations Hub Server.
Test Connection Use this button to test your connection to the Operations Hub Server.

SSL Security

Item Description
Require Trusted Con-
nection

Select this option if a trusted connection is required to export or publish pic-
tures.

View Certificate Use this button to view your trusted certificate.
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Export Configuration

Item Description
Mimic Export Path Enter that path where you want Operations Hub to look for your exported pic-

tures.
Publish to Operations 
Hub

Select this option to publish your iFIX pictures to Operations Hub. If the Publish 
to Operations Hub option is not selected, pictures are only exported and not pub-
lished to Operations Hub. By default, this option is disabled. 

Historian Tab - User Preferences Dialog Box

The Historian tab of the User Preferences dialog box displays   the following items:

Automatically Configure Tags for Collection in Historian

Use this option to configure all tags in your currently loaded database   for collection by Proficy Historian. 
Collection begins when the Collector starts.

 

How Do I...

The following sections explain how to use the iFIX WorkSpace:

 l Using   the System Tree

 l Working   with Files

 l Starting   Applications and Experts

 l Working   with the WorkSpace Environments

 l Setting   Preferences

 l Selecting   Data Sources and Building Expressions

 l Managing   Files and Nodes

 l Working   with Toolbars

 l Installing   a Third-Party OPC Server

Click a section above for steps on how to use or configure this part   of the iFIX WorkSpace.

Using the System Tree

The following sections provide steps on how to use the system tree in   the iFIX WorkSpace:

 l Displaying   a System Tree Path

 l Showing   and Hiding the System Tree

 l Opening   or Closing a Folder

 l Copying   and Moving Objects

 l Viewing   Thumbnails
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Displaying a System Tree Path

 To display a   system tree path:

 1. In the iFIX WorkSpace   system tree, right-click any folder or document.  A   pop-up menu appears.

 2. From the pop-up menu,   select Properties or File Properties.

 

Showing and Hiding the System Tree

 To show and hide   the system tree:

From the WorkSpace menu in the iFIX WorkSpace,   select System Tree. If the system tree was 
hidden, the iFIX WorkSpace   displays it. If the system tree was visible, the program hides it.

 

Opening or Closing a Folder in the System Tree

 To open or close   a folder in the system tree:

 1. In the iFIX WorkSpace   system tree, click the plus sign to open (expand) a folder.

 2. Click the minus sign   to close (collapse) a folder.

 

Copying and Moving Objects

 To copy or move   an object:

 1. In the iFIX WorkSpace,   open the source and target picture or Dynamo set.

 2. Click, drag, and   drop the object into the target to move it. Using the system tree, click,   drag, and 
drop the object's name over the target's name to move it.

 3. Hold the Control   key down and drag and drop the object to copy it.

You can also copy and paste, or cut and paste   objects when the source and destination do not appear on 
the screen simultaneously.

Viewing Thumbnails 

 To view picture   and Dynamo set thumbnails:

 1. In the iFIX WorkSpace   system tree, click the plus sign to open (expand) both the Dynamo Sets   
and the Pictures folders.

 2. Place the mouse pointer   over a Dynamo set or picture file name. The thumbnail, if it exists, 
appears.

NOTES:
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 l Windowless OLE objects   will not display in thumbnails.

 l Not all thumbnails appear   in a uniform location; some may be centered while others appear in the    
upper left hand corner.

 

Working with Files

The following sections provide steps on how to work with files in the   iFIX WorkSpace:

 l Creating   Files

 l Opening   Files

 l Saving   Files

 

Creating Files 

The following sections provide steps on how to create files in the iFIX   WorkSpace:

 l Creating   a New Picture, Schedule, or Dynamo Set

 l Creating   a New File

 

Creating a New Picture, Schedule, or Dynamo Set

 To create a new   picture:
In Classic view, in the iFIX WorkSpace,   click the New Picture button on the Standard toolbar to 
create a picture.   

-Or-

In Ribbon view, click the WorkSpace button,   select New and then click Picture. 

The Create Picture Wizard appears. Use this   wizard to set sizes, locations, and properties of 
your new pictures.

NOTE:   If a single untitled picture appears when you click the New Picture button,   the Create Picture 
Wizard has been disabled. Enable it by selecting the   following check box on the Picture Preferences 
tab of the User Preferences   dialog box: Show Picture Wizard from New Picture Menu.

 To create a new   schedule:
In Classic view, in the iFIX WorkSpace,   click the New Schedule button on the Standard toolbar 
to create a schedule.   

-Or-

In Ribbon view, click the WorkSpace button,   select New, and click Schedule.
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 To create a new   Dynamo Set:
In Classic view, in the iFIX WorkSpace,   click the New Dynamo Set button on the Standard tool-
bar to create a Dynamo   Set. 

-Or-

In Ribbon view, click the WorkSpace button,   select New, and click Dynamo Set.

 

Creating a New File

 To create a new   file:
 1. In Classic view,   in the iFIX WorkSpace, from the File menu, select New, and then Others.   

-Or-

In Ribbon view, click the WorkSpace button,   select New, and click Others.

 2. From the New FIX   Object list box, select the document type.

 

Opening Files 

The following sections provide steps on how to create files in the iFIX   WorkSpace:

 l Opening   a File

 l Opening   a Back-up File

 l Opening   Pictures Automatically at Run Time

 

Opening a File

 To open a file:
 1. In Classic view,   in the iFIX WorkSpace, from the Standard toolbar, click the Open button.   

-Or-

In Ribbon view, click the WorkSpace button   and then Open.

 2. Select the file you   want to open.

TIP:   You can also open a file from the system tree by expanding a folder and   double-clicking the file 
you want to open.

Opening a Backup File

 To open a backup   file:
 1. In Classic view,   in the iFIX WorkSpace, from the Standard toolbar, click the Open button.   

-Or-
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In Ribbon view, click the WorkSpace button   and then Open.

 2. Select the path containing   your backup file.

 3. Double-click the   backup file you want to open.

 4. From the File menu,   select Save As.

 5. Rename the backup   file and save it in the iFIX Picture path.

 

Opening Pictures Automatically at Run Time

 To open pictures   automatically at run time:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Startup   Pictures tab.

 3. Click the Add button   and enter a file name (GRF files) for the picture you want to load when   the 
iFIX WorkSpace enters the run-time environment. Optionally, click   the Browse button to locate 
the file.

 4. Repeat step 3 until   you have added all the files you want to load at run time.

 5. Select a file and   click the Delete button to remove any pictures you no longer want to load   at run 
time.

 6. Double-click any   existing entry to modify it, as needed.

 

Saving and Deleting Files

The following sections provide steps on how to save and delete files   in the iFIX WorkSpace:

 l Saving   a File

 l Saving   Files Automatically

 l Renaming   a File

 l Deleting   a File

 

Saving a File

 To save a file:
 1. In Classic view,   in the iFIX WorkSpace, on the Standard toolbar, click the Save button.   

-Or-
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In Ribbon view, click on the Application   button, and then Save.

 2. If you are saving   a new file, the iFIX WorkSpace prompts you for a file name. To save the   new 
file, enter a name and a file type for the file.

 

Saving Files Automatically

 To automatically   save open documents when switching to the run-time envir-
onment:

 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. Select the Auto Save   Documents when Switching from Configure to Run check box.

 

Renaming Files

 To rename a file:
 1. In the iFIX WorkSpace   system tree, right-click a closed file.

 2. From the pop-up menu,   select Rename.

 3. Enter the new name   when prompted.

 

Deleting Files

 To delete a file:
 1. In the iFIX WorkSpace   system tree, right-click a closed file.

 2. From the pop-up menu,   select Delete.

 

Starting Applications and Experts 

The following sections provide steps on how to start applications and   Experts in the iFIX WorkSpace:

 l Starting   an iFIX Application

 l Starting   the Visual Basic Editor
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 l Running   Experts with the Task Wizard

 l Configuring   a Button

 

Starting iFIX Applications

 To start an iFIX   application:

 l In Classic view,   in the iFIX WorkSpace, on the Application toolbar, click the button for   the applic-
ation you want to start. 

-Or-

 l In Ribbon view, on   the Applications tab, select the application you want to start.

-Or- 

 l Double-click the   application from the iFIX WorkSpace system tree.

 

Starting the Visual Basic Editor

 To start the   Visual Basic Editor from the iFIX WorkSpace:

In Classic view, in the iFIX WorkSpace,   on the Standard toolbar, click Visual Basic Editor. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Visual Basic Editor.

 

Running Experts With the Task Wizard

 To run Experts   with the Task Wizard:

 1. In Classic view,   in the iFIX WorkSpace, select an object from the current picture and click   the 
Task Wizard button on the Standard toolbar. 

-Or-

In Ribbon view, on the Tools tab in the   Tasks/Experts group, click the Tasks/Experts dialog box 
launcher. 

 2. Select a category   from the Task Category list.

 3. In the Tasks list   box, double-click the specific task or Expert you want to complete.

NOTE: If you   want to specify multiple commands for the object, select Multiple Commands   Expert from the 
Command category to open the Multiple Command Script Wizard.

 

Configuring a Button
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 To configure   a button:

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab in the WorkSpace   group, click Setting, and then click Toolbars. 

 2. Click Customize.   

 3. Click the Buttons   tab.

 4. Select the category   for the button you want to modify.

 5. Click Modify Button.    

NOTE:   You can only modify buttons in user-created categories.

 6. From the Bitmaps   area, select the bitmap for the button. If you want to use your own bitmap,   
browse for it and select it. Make sure the image size is no more than   20 x 20 and uses no more 
than 16 colors.

 7. In the Name field,   enter the button's name. 

 8. In the Description   field, enter text describing the button.

 9. In the ScreenTip   field, enter the button's ToolTip.

 10. Click Edit Script   to launch the Visual Basic Editor.

 11. Write a script for   the button.
 

Working with the WorkSpace Environments 

The following sections provide steps on how to work with environments   in the iFIX WorkSpace:

 l Switching   Between Environments

 l Setting   the WorkSpace's Start-up Environment

 l Configuring   Environment Protection

 

Switching Between Environments

 To switch between   the configuration environment and the run-time environments:

 1. In Classic view,   in the iFIX WorkSpace configuration environment, click Switch to Run on   the 
Standard toolbar. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Switch to Run.

 2. In the run-time environment,   select Switch to Configure from the WorkSpace menu.

TIP:   You can also use the shortcut, Ctrl+W to switch between environments.

 

Accessing Menu Commands While in Full Screen Run Mode
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 To access menu   commands while in full screen run mode: 

 l Press the Alt key.

Setting up the WorkSpace's Start-up Environment

The following sections provide steps on how to use the start-up environment   for the iFIX WorkSpace:

 l Starting   the iFIX WorkSpace in the Run-time Environment

 l Starting   the iFIX WorkSpace in the Configuration Environment

Starting the iFIX WorkSpace in the Run-time Environment

 To configure   the iFIX WorkSpace to start in the run-time environment:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. Select the Start   WorkSpace in Run Mode check box.

 

Starting the iFIX WorkSpace in the Configuration Environment

 To configure   the iFIX WorkSpace to start in the configuration environment:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. Clear the Start WorkSpace   in Run Mode check box.

 

Setting the Display Options for the Ribbon in Run Mode

The following sections explain how to set the display options for the   Ribbon in run mode:

 l Viewing   the Ribbon in Run Mode

 l Minimizing   the Ribbon in Run Mode

 l Disabling   the Ribbon Auto Hide Feature in Full Screen Run Mode

 l Enabling   the Ribbon Auto Hide Feature in Full Screen Run Mode

Viewing the Ribbon in Run Mode
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 To view the Ribbon   in run mode:
 l On the Quick Access   toolbar, while in run mode, from the Customize Quick Access Tool list,   

deselect Minimize the Ribbon.

Minimizing the Ribbon in Run Mode

 To minimize the   Ribbon in run mode:
 l On the Quick Access   toolbar, while in run mode, from the Customize Quick Access Tool list,   

select Minimize the Ribbon.

Disabling the Ribbon Auto Hide Feature in Full Screen Run Mode

 To disable the   Ribbon auto hide feature in full screen run mode:
 1. Press the Alt key   to view the Quick Access toolbar.

 2. On the Quick Access   toolbar, from the Customize Quick Access Tool list, clear Auto Hide the   
Ribbon.

Enabling the Ribbon Auto Hide Feature in Full Screen Run Mode

 To enable the   Ribbon auto hide feature in full screen run mode:
 1. Press the Alt key   to view the Quick Access toolbar.

 2. On the Quick Access   toolbar, from the Customize Quick Access Tool list, select Auto Hide the   
Ribbon.

Configuring Environment Protection

The following sections provide steps on how to configure environment   protection in the iFIX WorkSpace:

 l Enabling   Environment Protection

 l Disabling   Environment Protection

Enabling Environment Protection

 To enable environment   protection:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Environment   Protection tab.

 3. Select the Enable   Environment Protection check box.

 4. Select the options   you want to enable.
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Disabling Environment Protection

 To disable environment   protection:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view on the Home tab, in the WorkSpace   group, click Settings, and then click User 
Preferences. 

 2. Click the Environment   Protection tab.

 3. Clear the Enable   Environment Protection check box.

Customizing the Ribbon User Interface

The following sections provides steps on how to customize the Ribbon   user interface.

 l Showing   Keytips

 l Disabling   Keytips

 l Changing   the WorkSpace Color Scheme

 l Changing   the Screentip Style

 l Adding   Commands to the Quick Access Toolbar

 l Moving   the Quick Access Toolbar

 l Removing   Commands from the Quick Access Toolbar

 l Resetting   the Quick Access Toolbar

 l Customizing   Keyboard Shortcuts

Showing KeyTips

 To show KeyTips:

NOTE:   The following procedure applies only to Ribbon view.

 1. Click the Application   button and then on the Application menu, click Options. 

 2. If not already selected,   in the Navigation pane, click Popular.

 3. Select Show KeyTips.

 4. Click OK. 

 

Disabling KeyTips

 To disable KeyTips:

NOTE:   The following procedure applies only to Ribbon view.

 1. Click the Application   button and then on the Application menu, click Options. 

 2. If not already selected,   in the Navigation pane, click Popular. 
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 3. Deselect Show KeyTips.

 4. Click OK. 

 

Changing the WorkSpace Color Scheme

 To change the WorkSpace Color Scheme:

NOTE:   The following procedure applies only to Ribbon view.

 1. Click the Application   button and then on the Application menu, click Options. 

 2. If not already selected,   in the Navigation pane, click Popular . 

 3. From the Color Scheme   list, select the desired color scheme .

 4. Click OK. 

 

Changing the ScreenTip Style

 To change the ScreenTip style:

NOTE:   The following procedure applies only to Ribbon view.

 1. Click the WorkSpace button in the upper left corner of the application,   and then on the application 
menu, click the Options button. 

 2. If not already selected,   in the Navigation pane, click Popular. 

 3. From the ScreenTip   style list, select the desired ScreenTip style.

 4. Click OK. 

Adding Commands to the Quick Access Toolbar

There are three methods you can use to add commands   to the Quick Access toolbar. 

NOTE: The following   procedures apply only to Ribbon view.

 To add commands to the Quick Access   toolbar (method 1):

 1. In the iFIX WorkSpace,   in the Ribbon, right-click the command you want to add to the Quick 
Access   toolbar. 

 2. Click Add to Quick   Access Toolbar.

 To add commands to the Quick Access   toolbar (method 2):

 1. In the iFIX WorkSpace,   on the Ribbon, click the Application tab. 

 2. Right-click an empty   portion of the Ribbon, and select Customize Quick Access Toolbar. The   
Customize dialog box appears.

 3. In the Choose Commands   From list, select the category that contains the command you want to 
add   the to the Quick Access toolbar. 
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 4. In the Commands list,   for each the command you want to add to the Quick Access toolbar, select   
it and then click Add. 

 5. Repeat Step 4 until   all desired commands are added.

 6. To change the order   of which the commands appear on the Quick Access toolbar:

 a. Click the command   to move.

 b. Use the up or   down arrow to move the command in the desired direction.

 c. Repeat steps   a and b until commands are in the desired order.

 7. Click OK. 

 To add commands to the Quick Access   toolbar (method 3):

 1. Right-click the Quick   Access toolbar, and select Customize Quick Access Toolbar. The Cus-
tomize   dialog box appears.

 2. In the Choose Commands   From list, select the category that contains the command you want to 
add   the to the Quick Access toolbar. 

 3. In the Commands list,   for each the command you want to add to the Quick Access toolbar, select   
it and then click Add. 

 4. Repeat Step 3 until   all desired commands are added.

 5. To change the order   of which the commands appear on the Quick Access toolbar:

 a. Click the command   to move.

 b. Use the up or   down arrow to move the command in the desired direction.

 c. Repeat steps   a and b until commands are in the desired order.

 6. Click OK. 

Moving the Quick Access Toolbar

There are three methods you can use to move the Quick Access toolbar   either above or below the Rib-
bon. 

NOTE: The following   procedures apply only to Ribbon view.

 To move the Quick Access toolbar   (method 1):

 1. In the iFIX WorkSpace,   click the Quick Access toolbar. 

 2. Click the available   command: either Show Quick Access Toolbar Below the Ribbon or Show 
Quick   Access Toolbar Above the Ribbon.

 To move the Quick Access toolbar   (method 2):

 1. Click the Application   button and then on the Application menu, click Options. 

 2. In the Navigation   Plane, click Customize. 

 3. To show the Quick   Access toolbar below the Ribbon, select Show Quick Access Toolbar Below   
the Ribbon.

 4. To show the Quick   Access toolbar above the Ribbon, deselect Show Quick Access Toolbar 
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Below   the Ribbon.

 5. Click OK.

 To move the Quick Access toolbar   (method 3):

 1. Click Expand on the   Quick Access toolbar. .

 2. Click the available   command, either Show Below the Ribbon or Show Above the Ribbon.

Removing Commands from the Quick Access Toolbar

There are three methods you can use to remove commands   from the Quick Access toolbar. 

NOTE: The following   procedures apply only to Ribbon view.

 To remove commands from the Quick   Access toolbar (method 1):

 1. In the iFIX WorkSpace,   on the Quick Access toolbar, right-click the command you want to 
remove.   

 2. Click Remove from   Quick Access Toolbar.

 To remove commands from the Quick   Access toolbar (method 2):

 1. Click the Application   button and then on the Applications menu, click Options. 

 2. In the Navigation   pane, click Customize. 

 3. In the list of commands   in the box on the right, click the name of the command to remove and 
click   Remove. 

 4. Click OK. 

 To remove commands from the Quick   Access toolbar (method 3):

 1. Click Expand on the   Quick Access toolbar. 

 2. Click More Commands.

 3. In the list of commands   in the box on the right, click the name of the command to remove and 
click   Remove. 

 4. Click OK. 

 

Resetting the Quick Access Toolbar

 To reset the default commands on   the Quick Access toolbar:

NOTE:   The following procedure applies only to Ribbon view.

 1. Click the Application   button and then click Options. 

 2. In the Navigation   pane, click Customize. 

 3. Click Reset. 

 4. Click OK. 

 5. Click OK.

Customizing Keyboard Shortcuts
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 To customize keyboard shortcuts:

NOTE:   The following procedure applies only to Ribbon view.

 1. Click the Application   button and then on the Application menu, click Options. 

 2. In the Navigation   pane, click Customize. 

 3. Click Customize.   

 4. In the Categories   list, click the category that contains the command for which you want   to create 
a shortcut.

 5. In the Commands list,   click the name of the command for which you want to create a shortcut.   
Any shortcut keys that are currently assigned appear in the Current Keys   box.

 6. Click in the Press   New Shortcut Key box and press the desired keyboard shortcut. The com-
bination   appears in the Press New Shortcut Key box.

 7. In the Set Accelerator   for list, choose the desired option.

 8. Click Assign.

 9. Click OK. 

 

Setting Preferences 

The following sections provide steps on how to set preferences in the   iFIX WorkSpace:

 l Setting   Monitor Preferences

 l Setting   Picture, Shape, Drawing, and Chart Preferences

 l Setting   Run-time Preferences

 l Setting   the WorkSpace's Start-up Environment

 l Configuring   Environment Protection

 

Setting Monitor Preferences 

 

 To enable the use of multiple monitors:

IMPORTANT:   You configure the overall monitor settings for your computer, before you   can configure 
iFIX to display multiple monitors. 

 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. Select the Extend   WorkSpace to support multiple monitors check box.

 4. Click OK.
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Setting the iFIX WorkSpace User Interface

 To set the iFIX WorkSpace User Interface:

 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. To enable Ribbon   view, select the Enable Ribbon User Interface check box.

 4. To enable Classic   view, clear the Enable Ribbon User Interface check box.

 5. Click Ok.

 6. Restart the WorkSpace   for changes to take effect.

Enabling Database Tag Collection by Historian

 To enable database   tag collection by Historian:

NOTES:

 l Enabling this feature   causes all of your database tags to be collected by Historian.

 l During database reload,   if an iFIX tag already exists in Historian, the information is read from   His-
torian, not iFIX; the update in the iFIX database contains the Historian   fields.

 l You can enable collection,   one tag at a time, on the Historian tab of the database block itself.   For more 
information, see Enabling  or Disabling Block Collection by Historian.

 l This feature does not   work if you have a run-time only license for iFIX.

 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Historian tab.

 3. Select Automatically   Configure Tags for Collection in Historian.

 4. Click OK.

 5. Restart the WorkSpace   and reload the database for changes to take effect.

 

Setting Picture, Shape, Drawing, and Chart Preferences

The following sections provide steps on setting picture, shape, drawing,   and chart preferences in the 
iFIX WorkSpace:
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 l Setting   Picture Preferences

 l Globally   Translating Picture Text

 l Enabling   Picture Caching

 l Setting   Shape Preferences

 l Setting   Drawing Options

 l Setting   Save Preferences

 l Setting   Standard Chart Preferences

 

Setting Picture Preferences

 To set picture   preferences:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Picture   Preferences tab.

 3. From the Window Size   list, select the default window size.

 4. In the Window Properties   area, select the window properties you want to enable.

 5. If you are familiar   with the Logical or Enhanced Coordinate System of measuring picture height   
and width, clear the Automatically determine document size check box.   Then, in the Document 
Height and Document Width fields, enter, in logical   units or postscript points, the default height 
and width for your pictures.    

 6. In the Highlight   Timeout Interval field, enter the length of time, in seconds, that an   object in your 
picture should stay selected.

 7. In the Grid Interval   field, enter the space, in pixels, between grid points for your pictures.

 8. Click the Background   Color button and choose the default picture background color.

 9. Click the Fade Color   button and choose the default picture fade color.

 10. In the Gradient area,   select the Enable Gradient check box.

 11. In the Thumbnail   area, select the Save Thumbnail check box.

 12. In the Basic Animation   Dialog area, select from the following options:

 l Prompt   on Delete – Prompts you to confirm the deletion of an animation   in the Basic 
Animation dialog box and the Command Expert dialog box.

 l Always   Show Basic Animation Dialog – Displays the Basic Animation dialog   box 
when you double-click an object or select Animations from an object's   right-click menu. If 
this check box is cleared, the Advanced Animations   dialog box appears.
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 13. Enable picture caching.

 14. In the Create Picture   Wizard area, select the Show Picture Wizard From New Picture Menu 
check   box. If this check box is cleared, the Create Picture Wizard is not available.

 15. If you use the Logical   Coordinate System, select the Disable Auto Scale Feature check box to   
override the logical unit-to-pixel ratio when changing the resolution   of your screen. 

 16. If applicable, set   global language settings.

 

Globally Translating Picture Text

 To configure   global picture language settings:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Picture   Preferences tab.

 3. Select the Translate   Picture on Open check box.

 4. From the Language   list, choose the language you want all picture text strings to appear   in, 
provided that you add translations to an exported CSV file.

TIP: Confirm that the applicable font is set on the Shape Preferences tab of the User Preferences dia-
log box before you switch to run mode, and change it, if necessary.

 5. Open your pictures   in run mode. The displayed text strings are automatically translated into   the 
selected language.

Enabling Picture Caching

 To enable picture   caching:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Picture   Preferences Tab.

 3. Select the Enable   Picture Cache check box.

 4. Enter a number from   1 to 99 to indicate the number of pictures to be cached. This number rep-
resents   preload and run-time pictures.

 

Setting Shape Preferences

 To set shape   preferences:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 
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-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Shape Preferences   tab.

 3. In the Color area,   click each button and select the shape's fade, foreground, background,   and 
edge colors.

 4. In the Font area,   select the default font, size, and style for text objects.

 5. From the Edge Style   and Fill Style lists select the default shape edge and fill styles, respectively.

 6. In the Edge Width   field, enter the default edge thickness, in pixels.

 7. From the Background   Style list, select the default background style.

 8. In the Hit Test Size   field, enter the minimum distance, in pixels required to select an object.   
When the cursor is within the specified distance, iFIX selects the object.   

 9. From the Fade Type   list, choose the default fade type.

 10. In the Blend field,   enter how much of the fade color, in a percentage, will be mixed with   the fore-
ground color.

 11. In the Thickness   field, enter the default thickness for pipe objects. You can enter any   value from 
10 to 300.

 12. From the Elbow Style   list, choose the default elbow style for pipe objects.

 13. From the Start Cap   and End Cap lists, choose the default start and end caps for pipe objects.

 14. Select the Remove   Leading and Trailing Spaces check box to indicate that iFIX should remove   
extra spaces when Data Links are displayed in the run-time environment.

 

Setting Drawing Preferences

 To set drawing   preferences:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Drawing   Options tab.

 3. In the Extend Options   area, select the default option for extending line objects to an intersection   
point.

 4. In the Trim Options   area, select the default option for trimming line objects to an intersection   
point.

 5. Select the Always   Show Connection Nodes check box to display the connection nodes when 
using   the LineConnector Tool, the Rightangleline Connector, or the Pipe Connector.

 

Setting Save Preferences
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 To set the save   preferences:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. Select the Always   Create Backup Copy check box to automatically create a backup copy each   
time you save a file. Clear the check box to disable the option.

 

Setting Standard Chart Preferences

NOTE: You can   only set preferences for Standard Charts.

 To set standard   chart preferences:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Chart Preferences   tab.

 3. From the Scroll Direction   area, select the scroll direction. 

 4. If you choose a Left   to Right scroll, in the Reset field, enter the percentage of the chart   to repaint 
when the plotted data reaches the left edge of the chart.

 5. In the Time Axis   and Value Axis areas, enter the number of ticks and labels for the X and   Y axes, 
respectively.

 6. In the Duration area,   enter the length of time the X axis spans.

 7. In the Interval area,   enter the length of time between plotted data points.

 8. Select the Allow   Time Axis Reset check box to enable the time axis limits of your chart   to be 
reset after you right-click the object to zoom out. The time axis   limits are reset to the values of the 
Start Time and End properties.

 9. Select the Allow   Value Axis Reset check box to enable the value axis limits of your chart   to be 
reset after you right-click the object to zoom out. The value axis   limits are reset to the values of 
the HiLimit and LoLimit properties.

 10. Select the Transparent   check box to make the chart's background transparent. Clear the check   
box to make the background opaque.

 

Setting Run-time Preferences 

The following sections provide steps on how to set run-time preferences   in the iFIX WorkSpace:
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 l Displaying   the WorkSpace Full Screen

 l Hiding  the Historical Datalink Timestamp

 l Running   Schedules in the Background

 l Defining   OPC Connection Error Preferences

Displaying the WorkSpace Full-Screen

 To display the   WorkSpace at full-screen:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the General   tab.

 3. Select the Full Screen   in Run Mode check box.

Running Schedules in the Background

 To select the   schedules you want to run in the background:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Background   Startup tab.

 3. Click the Add button   and enter a file name (EVS   files) for the schedule you want to run when iFIX 
starts. Optionally,   click the Browse button to locate the file.

 4. Repeat step 3 until   you have added all the files you want to run in the background.

 5. Select a file and   click the Delete button to remove any schedules you no longer want to   run in the 
background.

 6. Double-click any   existing entry to modify it, as needed.

 

Setting OPC Connection Error Preferences

 To set the OPC   connection error preferences:
 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 
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 2. Click the Animations   Data Error Defaults tab.

 3. In the Linear Animation   Object Defaults area, enter the default numeric values to use when an   
error occurs scaling a value. 

 4. In the Format Animations   Object Defaults area, enter the default strings to display in a Data link   
when an error occurs.

 5. In the Numeric Table   Entries and the String Table Entries areas, enter the default numeric   and 
string values to use when an error occurs in a lookup table.

 6. In the Color Table   Entries area, click each button and select the color to use when an error   occurs 
in a lookup table.

 

Selecting Data Sources and Building Expressions 

The following sections provide steps on how to select data sources and   build expressions in the iFIX 
WorkSpace:

 l Browsing   the Process Database

 l Building   an Expression

 l Filtering   Data Sources

 l Specifying   the Tolerance, Deadband, and Refresh Rate

 l Using   the Proficy Historian Tab in the Expression Builder Dialog Box

Browsing the Process Database

 To browse the   process database:

 1. In the iFIX WorkSpace,   open a dialog box that displays a Data Source field. For instance, double-
click   a datalink to display the Datalink dialog box, or open an Expert dialog   box to add a basic 
animation.

 2. Click the Browse   button to the right of the Data Source field. The Expression Builder dialog   box 
appears.

 3. Click the FIX Database   tab.

 4. From the Node Names,   Tag Names, and Field Names list boxes, respectively, select the 
SCADA   server, block, and field you want. If a list box has many entries you   do not want to dis-
play, filter the data source.

 5. Enter the tolerance,   deadband, and refresh rate for this connection.

 

Building an Expression
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 To build an expression:

 1. In the iFIX WorkSpace,   open a dialog box that displays a Data Source field. For instance, double-
click   a datalink to display the Datalink dialog box, or open an Expert dialog   box to add a basic 
animation.

 2. Click the Browse   button to the right of the Data Source field. The Expression Builder dialog   box 
appears.

 3. Click the tab that   contains the items you want to use in your expression, as follows:

 l To include   a data source in an expression, click the node, block, and field from   the FIX 
Database tab.

 l To include   properties of picture objects, click the Pictures tab.

 l To include   historical data, click the Historical tab.

 l To include   global objects, click the Globals tab. 

 l To include   I/O points from third-party OPC servers, click the Data Servers tab.

NOTE:   Not all tabs are available for all objects.

 3. Expand the list to   display the items you want and select them. If a tab has many entries   you do 
not want to display, filter the data source.

 4. If you want to combine   two expressions, click the Mathematical Functions button and an operator   
button followed by a numeric value or another expression.

 5. Repeat steps 2 through   4, moving from tab to tab until you have included all the items you want   in 
the expression.

 6. Enter the tolerance,   deadband, and refresh rate for this connection.

 7. Click the Check Syntax   button to verify that your expression is valid. A valid expression displays   
the message "Syntax check successful!". An error message is   displayed for an invalid expres-
sion.

NOTE:   If you have created an object-to-object connection, such as the fill percentage   of one tank to 
another, or created a connection to a data source, the   animated properties display in boldface in the 
Properties list of the   Pictures tab for the selected object.

 

Filtering Data Sources

 To filter data   sources:

 1. In the iFIX WorkSpace,   open a dialog box that displays a Data Source field. For instance, double-
click   a datalink to display the Datalink dialog box, or open an Expert dialog   box to add a basic 
animation.

 2. Click the Browse   button to the right of the Data Source field. The Expression Builder dialog   box 
appears.

 3. Click the tab you   want to display.

 4. Enter the text you   want to display, including any wildcards, in the Filter field.

 5. Click the Filter   button.

Remembering the Last Filter
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 To remember the   last filter:

 1. In Classic view,   from the iFIX WorkSpace menu, select User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences.

 2. Select the Remember   last filter check box on the General tab. The most recently used filter(s)   
used on the Expression Builder dialog box will be remembered.

Specifying the Tolerance, Deadband, and Refresh Rate

 To specify the   tolerance, deadband, and refresh rate:

 1. In the iFIX WorkSpace,   open a dialog box that displays a Data Source field. For instance, double-
click   a datalink to display the Datalink dialog box, or open an Expert dialog   box to add a basic 
animation. 

 2. Click the Browse   button to the right of the Data Source field. The Expression Builder dialog   box 
appears.

 3. Click the FIX Database   tab.

 4. In the Tolerance   field, enter the maximum allowable rounding factor for the data source   or expres-
sion you are building. If the value of the data source or expression   is within the tolerance of a tar-
get value, iFIX assumes the two values   are equal. 

 5. In the Deadband field,   enter the maximum fluctuation you want for the data source or expression.   
If the value of the data source or expression exceeds the maximum or minimum   deadband, iFIX 
updates the object with the new value.

 6. In the Refresh Rate   field, select how often to update the data source or expression, in seconds.

 

Using the Proficy Historian Tab

The following sections provide steps on how to use the Proficy Historian   tab when working with the iFIX 
WorkSpace:

 l Sorting   Fields in the Tag List

 l Applying   Filters to the Tag List

 l Resetting   Tag Filters

 

Sorting Fields in the Tag List

 To sort a field   in the tag list:
 1. Click the appropriate   field header name (Node, Tag, Description, or Collector Name). An arrow   

appears. The up arrow indicates that the field is sorted in ascending   order. The down arrow indic-
ates that the field is sorted in descending   order.

 2. Click the field header   name again to reverse the sort order.
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NOTE:   By default, the fields are sorted in ascending order by the node name.

Applying a Filter to the Tag List

 To apply a specified   filter to the tag list:
 1. Enter your filter   criteria in the appropriate filter drop-down box (Node, Description, Tag,   or Col-

lector Type).

 2. Select the Apply   Filter button.

Resetting Tag Filters

 To reset filter   specifications:
Select the Reset button.

Managing Files and Nodes 

The following sections provide steps on how to manage files and nodes   in the iFIX WorkSpace:

 l Sharing   Files

 l Starting   iFIX with an SCU file from a different path

 l Getting   a Different iFIX Project from the Change Management Server

 l Creating   a Factory Default

 l Finding   and Replacing Data Overview

 l Using   the Backup and Restore Wizard Overview

 

Sharing iFIX Files

 To share iFIX   files:

 1. In Classic view,   in the iFIX WorkSpace, click the System Configuration Utility button on   the tool-
bar. 

-Or-

In Ribbon view, on the Applications tab,   in the System & Security group, click SCU. 

 2. Click the Paths button   on the SCU toolbox. 

 3. In the appropriate   field(s, enter the network path(s) you want to use. For example, enter   a network 
path in the Picture field, such as C:\Program Files (x86)\Proficy\iFIX\PIC, to change the Picture 
path.

 4. Copy all the files   in the shared paths from your local node to your file server.

 

Starting iFIX with an SCU File from a Different Path
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 To start iFIX   with an SCU file from a different path:

NOTE:   The following steps describe how to modify an SCU file with a path outside   the install path, so 
that you run it in iFIX.

 1. Shut down iFIX.

 2. On the Start menu,   point to Programs, iFIX, and then System Configuration   to open the SCU. 
The SCU window appears.

 3. From the SCU Configure   menu, click Paths. The Path Configuration dialog box appears.

 4. In the Path Configuration   dialog box, change the base path and NLS path to point to the local 
install    path. Change the project path to point to the project destination folder,   if it does not already 
do so.

 5. From the SCU Configure   menu, click Tasks. The Task Configuration dialog box appears.

 6. In the Task Configuration   dialog box, change the path of the configured tasks to the local install   
path, make sure that you include the same command line options.

 7. From the SCU Configure   menu, click Network. The Network Configuration dialog box appears.

 8. In the Network Configuration   dialog box, confirm the information is correct and make changes if 
necessary.

 9. From the SCU Configure   menu, click SQL, and then click Configure SQL Tasks. The SQL Task 
Configuration   dialog box appears.

 10. In the SQL Task Configuration   dialog box, make sure that the Primary and Secondary paths are 
correct,   if used.

 11. From the SCU Configure   menu, click Local Startup. The Local Startup Definition dialog box 
appears.

 12. In the Local Startup   Definition dialog box, change the path to the folder you copied the project   to 
with the get command. 

 13. From the SCU File   menu, click Save.

 14. Restart iFIX.
 

Getting a Different iFIX Project from the Change Management Server

 To get a different   iFIX project from the Change Management Server:

 1. From the iFIX WorkSpace   system tree, right-click the node name, point to Manage, and then 
click   Get Other Project. The Get Project dialog box appears.

NOTE:   The Manage right-click menu is unavailable if you are not logged into   the Change Man-
agement Server from iFIX.

 2. In the Select Project   drop-down list, select a project name.

 3. In the Project Destination   field, if the path is the same as your local iFIX install, enter a different   
path. By doing this, you prevent the get command from overwriting your   current iFIX project files.
  By default, the path in the Project Destination field is set to the   path that the project was last 
checked in with.
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 4. If you want to delete   any existing files before you get the project files, select the Delete   all exist-
ing files under Project Destination check box. 

 5. If you want to copy   iFIX default files into the folder before retrieving the project, select   the Ini-
tialize Project Destination with iFIX default Files check box.   It is recommended that you leave 
this check box selected. Otherwise, you   will not be able to run the project you get in iFIX.

 6. Click Get. A status   box appears as the iFIX project files are copied to your local computer.

 7. If you want to start   iFIX using the SCU from the project you just got, follow the steps below.

 To start iFIX   with that project's SCU:

NOTE:   These steps start iFIX with an SCU from a different path (a path outside   the install path).

 1. Shut down iFIX.

 2. On the Start menu,   point to Programs, iFIX, and then System Configuration   to open the SCU. 
The SCU window appears.

 3. From the SCU Configure   menu, click Paths. The Paths Configuration dialog box appears.

 4. In the Path Configuration   dialog box, change the base path and NLS path to point to the local 
install    path. Change the project path to point to the project destination folder,   if it does not already 
do so.

 5. From the SCU Configure   menu, click Tasks. The Tasks Configuration dialog box appears.

 6. In the Task Configuration   dialog box, change the path of the configured tasks to the local install   
path, make sure that you include the same command line options.

 7. From the SCU Configure   menu, click Network. The Network Configuration dialog box appears.

 8. In the Network Configuration   dialog box, confirm the information is correct and make changes if 
necessary.

 9. From the SCU Configure   menu, click SQL, and then click Configure SQL Tasks. The SQL Task 
Configuration   dialog box appears.

 10. In the SQL Task Configuration   dialog box, make sure that the Primary and Secondary paths are 
correct,   if used.

 11. From the SCU Configure   menu, click Local Startup Paths. The Local Startup Definition dialog 
box   appears.

 12. In the Local Startup   Definition dialog box, change the path to the folder you copied the project   to 
with the get command. 

 13. From the SCU File   menu, click Save.

 14. Restart iFIX.
 

Creating a Factory Default Backup File

 To create a factory   default backup file:

From the command line, enter
BackupRestore.exe /FactoryDefault [/l=<user ini file>]

NOTE:   You can modify the BackupRestore.ini   file to create user specific defaults. For more inform-
ation, refer to   the BackupRestore.ini   file.
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Finding and Replacing Data 

The following sections provide steps on how to find and replace data   in the iFIX WorkSpace:

 l Finding   Data

 l Replacing   Data

 

Finding Data in Pictures, Schedules, and Scripts

 To find data   in pictures, schedules, and scripts:
 1. In Classic view,   in the iFIX WorkSpace, from the Edit menu, select Find and Replace. 

-Or-

In Ribbon view, on the Home tab, in the   Editing group, click Find and Replace. 

 2. In the Find What   field, enter the text you want to locate.

 3. Select one or more   of the following check boxes to set the appropriate options:

 l Select the Match   Case check box to do a case-sensitive search.

 l Select the Whole   Word Only check box to locate whole words that match the search 
string.

 l Select the Data   Source Only check box to locate only data sources.

 l Select the Include   Scripts check box to locate the search string in the scripts associated   
with the picture or schedule.

 4. Click Find.

 

Replacing Data in Pictures, Schedules, and Scripts

 To replace data   in pictures, schedules, and scripts:
 1. Using the Find and   Replace dialog box, find the data you want to replace.

 2. Click the Replace   tab in the Find and Replace dialog box.

 3. In the Replace With   field, enter the text you want to substitute for the search string.

 4. Click one or more   of the following buttons to replace the values as needed:

 l Click Replace   Preview to view the results of replacing all the property values found   
without changing them.

 l Click Replace   Selected to replace the value selected from the Match List list   box.

 l Click Replace   All to replace all the property values found.

 

Using the Backup and Restore Wizard
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The following sections provide steps on how to use the Backup and Restore   wizard in the iFIX 
WorkSpace:

 l Archiving   Selected Files

 l Restoring   Files From an Archive

 l Defining   the Archive iBatch Project

 

Archiving Selected Files

 To archive selected   files, or create a new factory default file:
 1. From the iFIX submenu,   open the Backup & Restore Wizard:

 a. From the Windows   Start menu, point to Programs, iFIX, Tools, and then   Backup and 
Restore Wizard.

 b. From the iFIX   submenu, choose Backup & Restore Wizard. the iFIX Project   Backup dia-
log box appears.

NOTE:   To run the Backup and Restore wizard with the Factory Default option,   run the application with 
the /FactoryDefault   command line option. For instance, in the Run dialog box, type: backuprestore.exe   
/FactoryDefault.   In Factory Default mode, the Custom and Full Backup options are unavailable.

 2. Select the Custom   Backup or Factory Default Backup option and click the Project Backup Wiz-
ard   button. the iFIX Project Backup Wizard appears.

 3. From the Backup File   Option list, select the check box(es)   for the types of files you want to 
archive. To archive all your files,   select the Backup the Entire System check box.

 4. If you have Security   files and want to add those to your archive file, select the Include security   
files in archive check box.

 5. Click Next and specify   the path and archive file to use. You can also click the Browse button   to 
locate the path and file.

 6. Click Finish to archive   the selected files.

 To create an   archive of all your files:
 1. From the iFIX submenu,   select the Backup & Restore Wizard as follows:

 a. From the Windows   Start menu, point to Programs then point to iFIX.

 b. From the iFIX   submenu, choose Backup & Restore Wizard. the iFIX Project   Backup dia-
log box appears.

 2. In the Backup Type   area, select the Full Backup option and click the Project Backup Wizard   but-
ton. the iFIX Project Backup Wizard appears.

 3. Enter the path and   archive file to use. You can also click the Browse button to locate the   path and 
file.

 4. Click Finish to archive   the selected files.

 

Restoring Files From an Archive
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 To restore files   from an archive:
 1. Shut down iFIX if   it is running.

 2. From the iFIX submenu,   select Backup & Restore Wizard as follows:

 a. From the Windows   Start menu, point to Programs, iFIX, Tools, and then   Backup and 
Restore Wizard.

 b. From the iFIX   submenu, choose Backup & Restore Wizard. the iFIX Project   Backup dia-
log box appears.

 3. Click the Project   Restore Wizard button. the iFIX Restore Wizard appears.

 4. Click the Browse   … button and select the archive file from which to restore files.

 5. Click Next and select   the appropriate Restore Destination Option.

The corresponding destination information   displays in the Destination Info fields.

 6. To perform a clean   restore and delete all files before restoring the archive, select the   Delete all 
existing files under target project path before the restore   option.

 7. To restore the iFIX   files to their default state before restoring your archive, select the   Restore 
default iFIX files before restoring your backup files option.

 8. If security files   are located in the archive, select to leave the security settings alone,   replace 
existing security files with archived files, or delete all existing   security files and disable security.

 9. Select the check   box(es) of   the specific files you want to restore or select the Restore the entire   
system check box to restore all files in the archive.

 

Defining the Active Batch Execution Project

 To define the   active Batch Execution project:
 1. From the system tree,   double-click the Batch configuration icon. The Batch Configuration dialog   

box appears.

 2. Click the Project   tab.

 3. In the Active Project   field, enter the name of the project or click the Create New Project button   
and enter the name of the project in the dialog box that appears.

 4. Click OK.

 5. Restart the iFIX   WorkSpace.

 

Installing the Proficy Historian Server

The following sections provide steps on how to install and use the Historian server in the iFIX 
WorkSpace:

 l Configuring   Proficy Historian and iFIX

 l Creating a Common Historian Server Configuration for All Users
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 l Adding    a Server to the Proficy Historian Server List

 l Deleting   a Server from the Proficy Historian Server List

 l Modifying   a Server on the Proficy Historian List

 l Setting   the Default Collector

 l Setting   the Default Proficy Historian Server

 l Troubleshooting   Proficy Historian and iFIX
 

Configuring Proficy Historian and iFIX

You must shut down Historian services and licensing prior to installing   iFIX and Historian. To use the 
integrated Proficy Historian features in   iFIX, you must install Historian. 

 To configure   Proficy Historian and iFIX: 

After the iFIX and Historian installs, do the following: 

 1. Restart your computer.   Manually start the Proficy Historian Archiver through the Windows Ser-
vice   Control Panel, if it is not already running.

 2. Confirm that the   Collectors installed. To do so: 

 a. On the Start   menu, click Programs, Proficy Historian, and then Historian Administrator.   
The Historian Administrator program starts.

 b. Log into the   Historian Administrator.

 c. Click Collectors.

 d. Verify that all   of your collectors appear in the Collectors area, especially the iFIX   collector. 

 3. Start iFIX, the WorkSpace   and the iFIX collector. 

 4. Classic view only:   Insert the Proficy Historian toolbar. To do so:

 a. In the WorkSpace   system tree, double-click the Project Toolbar Files folder, and then the   
Toolbars folder. 

 b. Double-click   Proficy Historian. The Proficy Historian toolbar displays in the WorkSpace.

 5. Configure the Historian   Server. To do so:

 a. In Classic view,   in the Proficy Historian toolbar, select Configure the Historian Server.   

-Or-

In Ribbon view, on the Administration tab,   in the Proficy Historian Group, click Configure 
Historian, and then click   Configure Historian Server.

 b. Click Get Collectors.   The Collector Name list is populated. 

 c. Select the iFIX   collector, and then click Set Default.

 d. Click Close.   

 e. Restart the WorkSpace.
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 6. In the iFIX Database   Manager, add the blocks that you want to start collecting on. To do so:

 a. In the Database   Manager, in Classic view, on the Database Manager's toolbar, click 
Open.    

-Or-

In Ribbon view, click the Main Button, and   then click Open.

 b. Double-click   the SCADA server you want to connect to. The database displays.

 c. Double-click   in a blank cell in the spreadsheet. The Select a Block Type dialog box   
appears.

 d. Select the type   of block you want to add and click OK. The block's dialog box appears.

 e. Complete each   tab. Use the Proficy Historian tab to enter the information from Historian,   
and then click Save.

 f. Repeat Steps   C-E for each block you want to add.

 g. Save your database.   In Classic view, on the Database Manager's toolbar, click Save.  

-Or-

In Ribbon view, click the Main Button, and   then click Save.

NOTE:   For instructions on modifying blocks, see Modifying  Blocks.

 7. After approximately   two minutes, in the Historian Administrator, check that your tag was added.   
To do so:

 a. On the Start   menu, click Programs, Proficy Historian, and then Historian Administrator.   
The Historian Administrator program starts.

 b. Log into the Historian Administrator.

 c. Click Tags.

 d. Verify that all   of your tags appear in the tags area.

NOTE:   The confighist.txt file is the log file in the iFIX LOCAL folder. Use   this log file to 
troubleshoot if your tags do not get added to Historian.   

 8. Verify your configuration.   To do so: 

 a. Add a historical   data link to your picture. In Classic view, from the Toolbox, click His-
torical   Datalink.   

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and 
then click Historical Datalink.

 b. Switch to run   mode. In Classic view, from the WorkSpace menu, select Switch to Run.     

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Switch to Run.

 c. View the last   value collected in the data link. 

NOTE:   There will be a delay of approximately two minutes between data updates.

 

 Creating a Common Historian Server Configuration for All Users
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 To create a common Historian Server configuration (also known as global Historian aliasing): 

 1. In the iFIX WorkSpace, go to the Applications tab. 

 2. Click Configure Historian and then Configure Historian Server. The Configure the Proficy His-
torian Server dialog box appears.

 3. Select the "Enable Historian aliases for all sessions" option.

 4. Close the dialog box to save your settings. An information message appears.

 5. Click OK to continue.

 6. Restart iFIX Workspace to apply your change.

 

Adding a Server to the Proficy Historian Server List

 To add a server   to the Proficy Historian server list:

 1. In Classic view,   locate the Proficy Historian toolbar and then click the Configure Historian   Server 
button, which is the third of the four buttons.  

-Or-

In Ribbon view, on the Administration tab,   in the Proficy Historian group, click Configure His-
torian, and then click   Configure Historian Server.

 3. Click Add Server.

 4. In the Alias Name   field, enter an alias.

 5. In the Server Name   field, enter a server name.

 6. If required, in the   User Name and Password fields, enter a user name and password, respect-
ively.

 7. Click Add Server.   

 8. Click OK. 

 9. Click Close.

 

 

Deleting a Server from the Proficy Historian Server List

 To delete a server   from the Proficy Historian server list:

 1. In Classic view,   locate the Proficy Historian toolbar and then click the Configure Historian   Server 
button, which is the third of the four buttons.  

-Or-

In Ribbon view, on the Administration tab,   in the Proficy Historian group, click Configure His-
torian, and then click   Configure Historian Server.

 3. From the Alias Name/Server   Name list, select the server to delete.

 4. Click Delete.
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 5. Click Close.

 
 

Modifying a Server on the Proficy Historian List

 To modify a server   on the Proficy Historian server list:

 1. In Classic view,   locate the Proficy Historian toolbar and then click the Configure Historian   Server 
button, which is the third of the four buttons.  

-Or-

In Ribbon view, on the Administration tab,   in the Proficy Historian group, click Configure His-
torian, and then click   Configure Historian Server.

 3. From the Alias Name/Server   Name list, select a server to modify.

 4. Click Modify.

 5. Click Close.

Setting the Default Proficy Historian Server

 To set the default   Proficy Historian server:

NOTE: You must   select a default Historian server. Otherwise, Historian will not work   correctly in the 
WorkSpace.

 1. In Classic view,   locate the Proficy Historian toolbar and click the Configure Historian   Server but-
ton, which is the third of the four buttons.  

-Or-

In Ribbon view, on the Administration tab,   in the Proficy Historian group, click Configure His-
torian, and then click   Configure Historian Server.

 3. From the Alias Name/Server   Name list, select a server.

 4. Click Set Default.   The selected server is set as the default Historian server.

 

Setting the Default Collector

 To set the default collector:

 1. In Classic view,   locate the Proficy Historian toolbar and then click the Configure Historian   Server 
button, which is the third of the four buttons.  

-Or-

In Ribbon view, on the Administration tab,   in the Proficy Historian group, click Configure His-
torian, and then click   Configure Historian Server.

 3. Click Get Collectors.

 4. From the Collector   Name list select a collector.

 5. Click Set Default.   The selected collector is set as the default Historian collector.
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NOTES:

 l For iFIX   5.1 automatic collection, you must select the iFIX collector.

 l If you are   upgrading your system, set your existing collector as the default collector.

 l If you have   redundant servers, for each server, set the primary server's collector   as the default 
collector. For more information about redundancy and Historian,   refer to the Historian and 
Enhanced Failover section.

 l Because this feature   only supports collectors that read data from iFIX, the collectors available   
for selection are limited to the following:

 l iFIX Native Collector

 l OPC Collector   reading from Intellution.OPCEDA or Intellution.OPCiFIX OPC servers

 
 

Troubleshooting Proficy Historian and iFIX

The following table lists some specific troubleshooting information   for configuring Proficy Historian and 
iFIX. 

 

Scenario Solution/Explanation
I reloaded my database. I 
have a tag named AI1; I   
have set Enable Col-
lection on this tag and 
updated the necessary 
Historian   fields. However, 
the tag does not seem to 
be collected.

Verify that:

 l The   default Collector is configured.

 l A connection   exists between iFIX and Historian.

 l You   have configuration privileges.

There are a number of reasons why tags are not collected.   If 
none of the preceding reasons seem to be the cause, check the 
confighist.txt   file and review the error log. Also, check the alarm 
history information.

I have a tag named 
Fix.AI1.F_CV in Historian 
already   collecting. What 
will happen if I reload or 
import a database and the   
database already contains 
a tag named AI1? 

Proficy Historian always configures tags using the   following 
format for the tag name:

NodeName.TagName.F_CV.

Hence, if you are already collecting a tag with the   same name, 
when you:

Reload – at the time   of reload, iFIX will detect that there is 
already another tag with the   same name being collected and all 
the information from Historian for that   tag will be updated in the 
iFIX block named AI1.

Import or   Add –   When importing or adding a tag to the database, 
the tag from Historian   will be overwritten with the tag of the same 
name from the iFIX database.

I do not want to install 
integrated Historian, and   
want to continue using His-

Never do the following:

 l Select   the Automatically Configure Tags for Collection 
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torian as I did before. in Historian on the Historian tab of the User Prefer-
ences dialog box.

 l Use   Proficy Historian fields in the iFIX Database Man-
ager to configure anything   in Historian.

I want to use both 
products simultaneously 
to configure   tags.

We recommend avoiding this practice. Use the feature   that best 
accommodates the collection requirements of the particular tag.

If you decide to use both products at once, changes   made in iFIX 
take precedence and will overwrite settings made using His-
torian   Administrator. 

If you are using Historian Administrator, do not use   iFIX block 
fields for those tags.

I just upgraded. What will 
happen to my database 
blocks?

All of the database blocks will be upgraded to include   all of the 
new fields and they will be initialized to default values for   His-
torian fields. Additional considerations:

 l By   default collection is not enabled

 l If   some of the blocks are already being collected, they 
will receive the   information from Historian for the col-
lection fields at the time of reload.

I have configured redund-
ant SCADA nodes. How 
does   this feature affect my 
configuration?

iFIX always adds tags to the primary collector, so   if you have col-
lector redundancy configured correctly, there should be   no prob-
lem.

I selected the Auto-
matically Add Tags for Col-
lection   check box. I have 
some tags already con-
figured for collection in His-
torian.   What will happen to 
my tags?

Since at reload time information from Historian is   updated in 
iFIX, this option will not take effect for your existing tags;   you 
will have to update them manually. The log in configHist.txt will   
show that the tag already exists and in the Database Manager 
you can see   that the tag has pulled up information from His-
torian.

My Collector list is empty. In the Task Configuration dialog box of the SCU tool,   add the col-
lector. Let the collector run at least one time on your system.

My database does not con-
tain all of the tags I added.   

Check the confighist.txt file, located in the Local   folder, to 
determine if you exceeded the licensed tag collection amount.   If 
so, you may need to purchase more tags.

There is a long time 
between when changes 
are made   in the database 
and when they appear.

When using iFIX and Historian together, and the Collector   is run-
ning, there is approximately a two minute delay between when 
changes   are made and when they appear.

I reloaded my database 
and some tags seem to 
have   disappeared from 
Historian. What 
happened?

When you reload the database, all of the new database   tags are 
added to Historian. In addition, all of the tags from the previous   
database are hidden from Historian. It may seem as though 
those tags are   deleted, but they are not.

I decided to uninstall His-
torian. Now I get the error   

To correct this, register COMDLG32.ocx.
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message "Could not load 
an object..." when I open 
WorkSpace.
On the Configure the 
Proficy Historian Server 
dialog   box, the Get Col-
lectors and Set Default 
buttons are unavailable.

The Get Collectors and Set Default buttons are unavailable   in 
iFIX if you are attempting to configure the default collector on a   
View node. 

I have configured my His-
torian Servers. However, 
when   I log in to iFIX, there 
are no servers listed.

Historian servers need to be configured for each operating   sys-
tem user. For example, let's assume you configured the His-
torian server   while you were logged in as Administrator. If you 
did not configure the   Historian server for all other Windows 
users, the servers you configured   for the Administrator will not 
display, because they are not configured   for any other user. 
Make sure to configure Historian servers for all operating   system 
users.

 

Working with Toolbars 

The following sections provide steps on how to work with toolbars in   the iFIX WorkSpace:

 l Showing   and Hiding Toolbars

 l Customizing   Toolbars Overview

 l Creating   Toolbars Overview

 l Creating   Buttons Overview

 

Showing and Hiding Toolbars

 To show or hide   toolbars:

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Select the owner   for the toolbars you want to show or hide.

 3. Select the check   box of each toolbar you want to display and clear the check box for each   toolbar 
you want to hide.

 

Customizing Toolbars

The following sections provide steps on how to customize toolbars in   the iFIX WorkSpace:
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 l Adding   a Button to a Toolbar

 l Removing   a Button from a Toolbar

 l Arranging   Buttons on a Toolbar

 l Enabling   and Disabling Toolbar Docking

 l Resetting   Standard Toolbars

 

Adding a Button to a Toolbar

 To add a button   to a toolbar:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Buttons   tab and select the category for the button you want to add.

 4. Click, drag, and   drop the button you want to add onto the toolbar.

NOTE:   The buttons in the Scheduler category are for internal use only.

 

Removing a Button From a Toolbar

 To remove a button   from a toolbar:
 1. In Classic view,   from the iFIX WorkSpace menu, select Toolbars . 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click, drag, and   drop the button you want to delete off of the toolbar.

 

Arranging Buttons on a Toolbar

 To arrange buttons   on a toolbar:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 
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 2. Click Customize.   

 3. Click, drag, and   drop the button to its new location on the toolbar.

NOTE:   The buttons in the Scheduler category are for internal use only.

 

Enabling and Disabling Toolbar Docking

 To enable and   disable toolbar docking:
NOTE:   In Ribbon view, toolbars cannot be docked.

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

 2. Click Customize.   

 3. Select the owner   of the toolbar you want to modify.

 4. Select the floating   toolbar you want to modify. If the toolbar is hidden, select the toolbar's   check 
box to display it.

 5. Select the Enable   Docking for Selected Toolbar check box to enable docking. To disable dock-
ing,   clear the check box.

 

 

Resetting Standard Toolbars

 To reset a standard   toolbar:
 1. In Classic view,   from the iFIX WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, in the Settings list, click Toolbars. 

 2. Click Customize.   

 3. Select the toolbar   you want to reset and click Reset. If the button is grayed out, the toolbar   is sup-
plied with iFIX.

 

Creating Toolbars 

The following sections provide steps on how to create and work with   toolbars in the iFIX WorkSpace:

 l Creating   a Toolbar

 l Deleting   a Toolbar

 l Modifying   Toolbar Properties

 l Editing   the Script of a Toolbar Button

 

Creating a Toolbar
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 To create a toolbar:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Toolbars   tab.

 4. Click Add Toolbar.

 5. Enter a name for   the toolbar.

 6. Select the toolbar's   owner from the Owner list. If the owner you want does not appear:

 a. Close the Customize   Toolbars dialog box.

 b. Open a document   of the associated type. For example, open a picture to select Picture   as 
an owner.

 7. Repeat steps 1 through   6.

 8. Add buttons to the   toolbar.

 9. Edit each button's   script as needed.

 

Deleting a Toolbar

 To delete a toolbar:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Toolbars   tab.

 4. Select the owner   of the toolbar you want to delete from the Owner list. If the owner you   want does 
not appear:

 a. Close the Customize   Toolbars dialog box.

 b. Open a document   of the associated type. For example, open a picture to select Picture   as 
an owner.

 c. Repeat steps   1 through 4.

 5. Select the toolbar   you want to delete.

 6. Click Delete Toolbar.

 

Modifying Toolbar Properties
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 To modify a toolbar's   properties:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Toolbars   tab.

 4. Select the toolbar's   owner from the Owner list. If the owner you want does not appear:

 a. Close the Customize   Toolbars dialog box.

 b. Open a document   of the associated type. For example, open a picture to select Picture   as 
an owner.

 c. Repeat steps   1 through 4.

 5. Select the toolbar   you want to modify.

 6. Click Modify Properties.

 7. Change the toolbar's   name and owner as needed.

 

Editing the Script of a Toolbar Button

 To edit the script   of a toolbar button:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Double-click the   button you want to modify from a toolbar or click the Buttons tab and   double-
click the button. 

 4. Click Edit Script   to open the Visual Basic Editor. Edit the button's script with the VBE.

 

Creating Buttons

The following sections provide steps on how to create button in the   iFIX WorkSpace:

 l Creating   or Renaming a Category

 l Deleting   a Category

 l Creating   a Button

 l Deleting   a Button

 l Modifying   a Button's Properties
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 l Displaying   a Toolbar

 l Importing   a Toolbar

 

Creating or Renaming a Category

 To create or   rename a category:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Buttons   tab.

 4. Click Add Category   or Rename Category and enter a category name. 

Category names can be up to 31 letters long.   You cannot include numbers, a space, period (.), 
exclamation mark (!),   or the characters @, &, $, # in the name. In addition, category names   can-
not match the name of any other toolbar, category, picture, schedule,   or Dynamo set. 

NOTE:   You can rename user-created categories only.

Deleting a Category

 To delete a category:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Buttons   tab.

 4. Select the category   you want to delete.

 5. Click Delete Category.

NOTE: You   can delete user-created categories only.

 

Creating a Button

 To create a button:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-
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In Ribbon view, on the Home tab in the WorkSpace   group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Buttons   tab.

 4. Select the category   you want to assign the button to.

 5. Click Add Button.

 6. Configure the button.   

NOTE: You   can create buttons for user-created categories only.

 

Deleting a Button

 To delete a button:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Buttons   tab.

 4. Select the category   for the button you want to delete.

 5. Select the button   and click Delete Button.

 6. Click OK when you   are prompted to confirm the deletion.

NOTE: You   can delete buttons only from user-created categories.

 

Modifying Button Properties

 To modify a button's   properties:
 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click Customize.   

 3. Click the Buttons   tab.

 4. Select the category   for the button you want to modify.

 5. Click Modify Button.

 6. Configure the button.

NOTE: You   can modify buttons only in user-created categories.

140 © 2024 General Electric Company. All rights reserved.



 

Displaying a Toolbar

 To display a   toolbar:
 1. Open the iFIX Workspace.   

 2. In the WorkSpace   system tree, double-click the Project Toolbar Files folder, and then the   Tool-
bars folder. 

 3. Double-click the   name of the toolbar you want to display. The toolbar should now display   in the 
WorkSpace.

 

Importing a Toolbar

 To import a toolbar:
 1. Copy the toolbar   file (.TBX)   you want to import to the Local path of your computer.

 2. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 3. Click Customize.   

 4. Click Import.

 5. From the Toolbars   list box, select the file.

 6. From the Owner list,   select the owner. If the owner you want does not appear:

 a. Close the Customize   Toolbars dialog box.

 b. Open a document   of the associated type. For example, open a picture to select Picture   as 
an owner.

 c. Repeat steps   1 through 6.

 7. Click Import.

 

Installing a Third-Party OPC Server 

The following sections provide steps on how to install and use a third-party   OPC server in the iFIX 
WorkSpace:

 l Adding   or Modifying an OPC Server

 l Deleting   an OPC Server

 l Troubleshooting   OPC Server Installations

 l Setting   up DCOM Support   in the WorkSpace
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Adding or Modifying an OPC Server

 To add or modify   an OPC server:

 1. On the Start menu,   point to Programs, iFIX, Tools, and then Data Server   Installer.  

 2. Click Add or double-click   the data server you want to modify. 

 3. In the Data Server   field, enter an OPC data source name. Make sure the name is not already    in 
use.

 4. From the OPC server   list, select an OPC driver.

 5. In the Machine Name   field, enter the local or remote computer name where the OPC Server 
resides.

 6. Select the Set as   Default Server check box to make the server the default.

NOTE:   You must have rights to write to the registry in order to perform this   task.

 

Deleting an OPC Server

 To delete an   OPC server:

 1. On the Start menu,   point to Programs, iFIX, Tools, and then Data Server   Installer. The Data 
Server Installer dialog box appears.

 2. Select the OPC server   you want to delete.

 3. Click Remove.

NOTE:   You must have rights to write to the registry in order to perform this   task.

 

Troubleshooting OPC Server Installations

You can add third-party OPC servers into iFIX by installing   them with the Data Server Installer. The 
Data Server Installer can be   accessed from the Start menu by pointing to Programs, iFIX, Tools, and 
then Data Server Installer. If you have difficulty   accessing data from the OPC server, use the following 
steps to troubleshoot.

 To troubleshoot   your OPC Server installation:

 1. From the Start menu,   select Run and enter Regedit.

 2. Open the key HKEY_CLASSES_ROOT\FIX32\DataSources.

 3. Ensure that each   subkey in the DataSources folder represents an OPC server installed into   iFIX, 
and that it contains the following:
(Default) = "DataSourceName"
DefaultServer = 0 (1, if server is the default)
OpcAccessPath = ""
OpcDataSource = "AnyString"
OpcProgID = "ProgID"
OpcServerMachineName = ""
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For example, the subkey for the FIX OPC   server appears as follows: 
(Default) = "FIX32"
DefaultServer = 1
OpcAccessPath = ""
OpcDataSource = "Intellution OPC EDA Server"
OpcProgID = "Intellution.OPCEDA"
OpcServerMachineName = ""

 

Setting up DCOM Support in the WorkSpace

 To setup DCOM   support in the WorkSpace:

 1. If necessary, install   the driver:

 a. Insert the I/O   Drivers and OPC Servers CD into your CD-ROM drive. The CD spins up 
and   the Driver CD splash screen appears.

 b. Click the Install   Driver button.

 c. Select the driver   name from the menu. For example for the MBE driver, select MBE - Mod-
bus   Eithernet v7.x.

 d. Click the Install   Now button.

 2. Run the Data Server   Installer. You can launch this application from the Start menu by pointing   to 
Programs, iFIX, Tools, and then Data Server Installer.   The Data Server Installer dialog box 
appears.

 3. Click Add to add   an OPC server. The Add Server dialog box appears.

 4. Enter an OPC data   source name in the Data Server field. For example, for the MBE driver,    you 
might enter MBESOURCE in this field.

 5. Select the OPC server   from the drop-down list in the OPC Server field. For example, for the   MBE 
driver you would select Intellution.MBEOPC.

 6. In the Machine Name   field, enter the local or remote computer name where the OPC Server 
resides.

 7. Click OK to save   your changes.

 8. Configure the server   from the iFIX program group. For example, for the MBE driver, select the   
MBE PowerTool option. 

 

System Functions

iFIX provides real-time data to plant personnel and to other software   applications throughout a plant. 
This real-time data presentation is the   key to more efficient use of resources and personnel, and ulti-
mately,   to more automation.

SCADA functions include:
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 l Basic   Functions

 l HMI   and SCADA Functions

 l Reporting   Functions

 l Open   Architecture Functions

 l Application   Functions

 

Basic Functions

iFIX performs basic functions that enable specific applications to perform   their assigned tasks. The two 
most basic functions are data acquisition   and data management. The following figure illustrates the 
basic functions   of iFIX.

iFIX Basic Functions

Data acquisition is the ability to retrieve data from the plant floor   and process that data into a usable 
form. Data can also be written to   the plant floor, thereby establishing the critical two-way link required   by 
control software. iFIX uses OPC to request and utilize plant floor   data. OPC is a client/server model with 
a common interface that allows   iFIX to communicate with standard objects, methods, and properties. 
For   additional information on OPC, refer to the OLE   for Process Control (OPC) section.

iFIX requires no proprietary hardware to acquire data. It communicates   directly with I/O devices already 
in place through a software interface   called an I/O driver. In most cases, iFIX can work with the I/O hard-
ware   installed in your plant. Even if your plant has I/O devices from different   manufacturers on the same 
network, I/O drivers can access and work with   all of them.

We currently offer an extensive catalog of I/O drivers that support   best-selling and specialty I/O devices. 
We also offer the OPC Toolkit,   a development tool that allows you to quickly and easily write high per-
formance,   reliable OPC enabled I/O servers. Any server written with the toolkit   can talk to OLE auto-
mation or OPC client applications. The toolkit includes   an online training session, online help, and 
universal OLE Automation   interfaces. Servers written with the OPC toolkit are open, reliable and   high 
performing servers that incorporate multi-threading, queue-based   messaging, and event-based pro-
cessing. 

Once data is acquired, it is manipulated and channeled according to   requests from your application soft-
ware. This process is known as data   management. 

HMI and SCADA Functions 
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One of the most important goals of automation is to use plant resources   more efficiently. Traditionally, 
plant floor operations have been monitored   and controlled through control room panels. iFIX can enhance 
or replace   many of these traditional control room functions, including:

 l Monitoring

 l Supervisory   Control

 l Alarming

 l Control

The following figure illustrates the HMI and SCADA functions.

HMI and SCADA Functions

Monitoring 

Monitoring is the ability to gather and display real-time plant-floor data to all relevant personnel. Powerful 
numeric, text, and graphical formats are available to make real-time data more accessible, easier to 
read, and easier to understand.  

Supervisory Control 

Supervisory control is the ability to monitor real-time data coupled   with the ability to change set points 
and other key values directly from   your computer. 

With iFIX, you can easily control who has access rights to this data   and which data points can be 
changed.

Alarming 
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Alarming is the ability to recognize exceptional events within your   process and immediately report those 
events to the appropriate personnel.   Alarms are generated based on the control limits you establish and 
can   be reported in a variety of ways. 

For additional information refer to the Implementing  Alarms and Messages manual.

Control 

Control is the ability to automatically apply algorithms that adjust   process values and thereby maintain 
those values within set limits. Control   goes one step beyond supervisory control by removing the need 
for human   interaction. 

iFIX includes continuous control, batch control, and statistical process   control capabilities. It can be 
used to control your whole process or   part of your process.

Reporting Functions

Real-time data is only one level of information processing. Many plants require the ability to report or 
store real-time data for later analysis. iFIX allows you to use any third-party reporting application that 
supports ODBC queries to create reports based on critical system and process information. The fol-
lowing figure illustrates the reporting functions.

Data Analysis Functions

Data Archiving 
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Any data point in the system can be sampled and stored in data files   at operator-specified rates. This 
archived data represents a powerful   tool for process optimization and correction. 

At any time, the data can be retrieved from the data files to create   trend displays of historical data. Man-
agers and engineers can use this   data to examine the events leading up to a critical event after address-
ing   more immediate problems. 

Reports 

Detailed reports are important tools for reviewing the performance of   a process. They allow you to 
quickly grasp the relationships between specific   pieces of manufacturing process data so that you can 
make effective decisions.   Using any third-party reporting application that supports ODBC queries,   you 
can create customized reports based on iFIX real-time and historical   data. When you use iFIX real-time 
data, you generate the report with current   data extracted from the iFIX database. When you create a 
report using   iFIX historical data, you generate the report based on data gathered over   a period of time. 

For example, suppose you are the production manager of a cookie factory.   At the end of each shift you 
want to generate a customized report that   shows the amount of down time on each production line. You 
would use the   Scheduler to request this report at certain times using iFIX historical   data. In addition, if a 
failure occurs on a particular line you want to   have your system automatically generate a report showing 
the tank level   of each ingredient, the state of the mixer and dropper, and the temperature   of the oven at 
the time of the failure. When a failure occurs, the requested   iFIX real-time data is extracted from the iFIX 
database and displayed   in a report. The data in this report can then be analyzed to help prevent   future fail-
ures. 

Open Architecture Functions 

Many plants have unique needs that can be solved through access to real-time data. iFIX provides read 
and write access to any data point in the system. This open architecture allows you to use custom and 
third-party applications to resolve your unique automation needs. The following figure illustrates the open 
architecture functions.
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Open Architecture Functions

The iFIX architecture also allows you to write scripts that provide key real-time data. Visual Basic® for 
Applications is integrated directly into iFIX to allow you to quickly and easily develop scripts that interact 
with plant-floor data. For more information, refer to the Writing Scripts manual.  

Application Functions 

iFIX is a multi-tasking system. Each node can run several different   applications simultaneously. Intern-
ally, critical programs have priority   access to system resources and applications may be preempted to 
respond   to a more critical resource request.

All iFIX applications can be classified into three types:

 l User   configuration applications

 l System   applications

 l User   applications

 

User Configuration Applications 
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User configuration applications allow you to create the instructions and logic that monitor and control 
your process. These applications create configuration files. When started, system applications read the 
configuration files and use the information found here to execute the assigned tasks.  

The Event Scheduler is an example of a user configuration application. In the Event Scheduler, you 
define the event that triggers an action (for example the time of day or a change in your process) and the 
action that you want to occur. Once the event is scheduled, the action automatically triggers when the 
event occurs. No further interaction is required.

System Applications 

System applications work with your process in real-time. These applications receive instructions from 
configuration files and require little or no interaction. In general, system applications have priority access 
to system resources.  

User Applications 

User applications are programs that you interact with in order to work with the process or process data. 
User applications also create and use configuration files.  

The Alarm Summary Object (OCX) is an example of a user application. It requires you to interact with 
the system by manipulating the Alarm Summary Object that is embedded in your picture.

Some programs may serve as more than one kind of application. For example, the Database Manager is 
a user configuration application for creating process databases. However, Database Manager also acts 
as a user application because it allows you to display real-time data in spreadsheet form.

Managing iFIX Nodes

This chapter explains how to manage your iFIX nodes with the   iFIX WorkSpace by backing up and 
restoring your files. The chapter also   describes other management tasks you can complete with the 
WorkSpace,   such as configuring the local computer, finding and replacing data in   iFIX, and specifying 
the active Batch Execution project.

Refer to the following sections for more information:

 l Configuring   the Local Computer

 l Sharing   Files

 l Finding   and Replacing Data

 l Backing   up and Restoring Files

 l Specifying   a Batch Execution Project

 

Configuring the Local Computer 
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Your main tool for configuring your computer for use with iFIX is the System Configuration Utility (SCU). 
This program lets you configure the computer's:

 l Network connections.   

 l Alarm routing and destinations.   

 l SCADA and I/O driver options (for SCADA servers only).   

 l Security options (when iFIX is running).   

 l iFIX paths.   

 l Start-up tasks.   

 l Alarm area configuration.   

To learn more about the SCU, refer to the Setting up the Environment manual.  

Creating a New Project 

To   create projects, you use the iFIX System Configuration Utility (SCU).   For each project you create, 
there is a separate, unique SCU file. 

To access the SCU, double-click the SCU icon in the   WorkSpace system tree, or click the Start button 
and point to Programs,  iFIX, and then SCU. You can also   start the SCU directly from the iFIX Startup 
dialog box, also known as   the Launch application. Make sure you shut down iFIX before starting the   
SCU. You cannot make edits in the SCU while iFIX is running.

 To create a new project in the SCU: 

 1. Start the SCU. 

 2. On the Configure   menu, click Paths. The Path Configuration dialog box appears. 

IMPORTANT: The   Base and Language Paths should be the same for each project. 
DO NOT CHANGE THESE FIELDS. Leave the Base and Language   paths set to the default, and pro-
ceed by editing the Project path fields.

 3. In the Project field,   enter a path for the project. For example, a valid path that you might   enter for a 
developer would be: C:\Program Files (x86)\Proficy\iFIX\PRJ\Dev1.    

 4. Click the Change   Project button. A message box appears asking if you want to add the default   
iFIX files to the new project. 

IMPORTANT: The   SCU will not copy the files or subdirectories from the existing directories   to the new 
directories. 

 5. Click Yes. The project   path information from the Project field is appended to the other project   path 
fields, such as Local, Database, Picture, Application, and so on.   

For instance, if you enter C:\Program Files (x86)\Proficy\iFIX\PRJ\Dev1 in the Project field, the 
SCU automatically   adds \PRJ\Dev1 to the other project fields as well. For instance the Local   
path in this dialog box would now read: C:\Program Files (x86)\Proficy\iFIX\PRJ\Dev1\Local. 
The Database path would read: C:\Program Files (x86)\Proficy\iFIX\PRJ\Dev1\PDB, and so on. 

NOTE: While the   paths displayed in the Path Configuration dialog box appear to be added   at this 
point, the actual folders for these paths have not been created   yet. While you can view the new paths 
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from this dialog, you will not be   able to view them from the Windows Explorer until you complete the 
remaining   steps in this section.

 6. If there are any   paths that you want to change, such as to a shared directory, manually   edit the 
path fields. 

 7. Click OK from the   Path Configuration dialog box. A message box appears asking you to create   
the folders for the configured paths. 

 8. Click Create All.   A message box may appear indicating you do not have a valid Alarm Area   Data-
base file. 

 9. Click Proceed to   continue. 

iFIX creates the paths for the project folders.   You should be able to view the new folders in Win-
dows Explorer. 

 10. On the File menu,   click Save As. The Save File As dialog box appears. 

 11. Browse to the Project's   Local folder. For instance, for Developer1 browse to the C:\Program Files 
(x86)\Proficy\iFIX\PRJ\Dev1\Local folder. 

 12. Enter a name for   the SCU file. 

Valid SCU file names can be up to eight characters   long. SCU file names can include alpha-
numeric characters, but must begin   with a letter. Special characters, such as symbols and punc-
tuation marks,   cannot be used.

For example for Developer1, you might enter   Dev1. 

 13. Click Save. A message   box appears asking you if this is the SCU file that you want to use next   
time you restart iFIX. 

 14. Click No. 

 15. If you have a template   folder with iFIX files that you want to copy into one or more project   folders, 
use the Windows Explorer to copy the files from the template   folders into the new project folders. 

After you have created all the projects, you can go back later and edit   all the other SCU settings for each 
project that require changing. For   more detailed information about configuring the rest of the options for   
the SCU files, refer to the Configuring  iFIX Using the SCU chapter in the Setting Up the Environment 
manual.   

After you finish creating project directories and configuring the SCU   files, you may want to use the 
Application Validator to create a baseline   snapshot of the project directories. For more information on the 
Application   Validator, including the command line options, refer to the Validating  an Application section 
in the Mastering iFIX manual. 
Notes on Security Configuration for Multiple Projects

When working with multiple projects for multiple users, make sure that   you also enable global security 
paths in the Configuration dialog box   of the Security Configuration. When you enable the global security 
paths   option (Use these paths for all startup profiles), all iFIX user sessions   on a computer share the 
same security configuration. To access the Security   Configuration application, select Security from the 
Configure menu of   the SCU. iFIX must be running to access this application.

Sharing Files 
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Using iFIX, you can share files among your nodes by placing these files   on a file server and changing the 
local node's paths. The files you share   depend on your configuration; you may want to share operator dis-
plays   or schedules. Frequently, the alarm area database is shared to ensure   that all SCADA servers 
have access to an identical set of alarm areas.   Likewise, sharing your security files ensures that oper-
ators can log in   from any node.

The path you specify for sharing files also depends on your configuration.   You can specify any mapped 
network drive, such as Z:\Program Files (x86)\Proficy\iFIX\ALM. 

NOTE: iFIX stores different   types of files in the paths it uses. For example, the Picture path holds   pictures, user 
globals, color tables, and named colors. Sharing this path   gives access to all these files.

The iFIX pictures are not backwards compatible for earlier versions    of iFIX. If you use multiple versions 
of iFIX, store your pictures locally   or use a separate shared pictures path for each version of iFIX. 

Configuring the Picture Path

If you are using a shared PIC directory on a drive other than the one   on which iFIX is installed, you must 
enter the full path in the SCU. 

For example, if you want to use a shared PIC directory on the G:\drive,   you must enter G:\PIC in the 
SCU. If you enter G:\, your WorkSpace will   not open correctly.

Finding and Replacing Data

Many process environments are expansive, and may include pictures or   schedules that reference many 
sources of data for operations in different   locations throughout your plant. If you need to reroute certain 
data to   another node, or globally change a data source throughout a plant, you   can do so quickly, without 
disrupting operation or using valuable resources   by finding and replacing data.

Finding data locates values of picture and schedule properties that   match the search string. It also loc-
ates property values of objects in   your pictures. The search string you enter indicates the data you want   
to locate and optionally replace. Any property value that matches this   text appears on the Find tab. On 
the Replace tab, only values you can   modify appear.

Find Options

You can select any of the following options when finding data:

Match   Case –   Finds text that matches the exact case of the search string.

Whole   Word Only –   Finds only whole words that match the search string. A whole word is any   text 
delimited by a carriage return, a line feed, a space, a hyphen (-),   a semi-colon (;), a colon (:), a 
comma (,), a period (.), an underscore   (_), an exclamation point (!), quotation marks ("), apostrophe 
('),   parenthesis ( ), braces { }, or brackets [ ]. This means that a typical   data source, such as 
Fix32.MIXER1.AI1.F_CV contains five words.

Data   Source Only –   Finds only data sources that match the search string.

NOTE: If a data source   used to animate an object has its Data Conversion type set to Object,   the data source 
is ignored during all Find operations.

Include   Scripts –   Finds text in the scripts associated with the current picture or schedule.
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Replace Options

When replacing data, you can select from the following options:

Replace   Selected –   Replaces only the property values you select. 

Replace   All –   Replaces all property values found.

Replace   Preview –   Displays the results of replacing all property values in the Replace Value   With 
column.

NOTE: You cannot undo   a Find and Replace operation and the text you enter as the replacement   string 
appears exactly as you enter it.
Notes on Special Characters in Search Strings

When you use wildcard characters such as the * or ? character in your   search string, text containing the 
following special characters will not   be found even if it satisfies the search criteria: 

" ' ( ) * + ; ? @ ^ ' { } ~
 

For instance, if you want to locate joe@company.com and enter j*com   as your search string in the Find 
What field, the joe@company.com term   is not found, since the text includes a special character (@). 
Example: Finding and Replacing Data

Assume you want to replace all of the tags in a picture from MIXER.AI_VALVE_OPEN   to MIXER.AI_
VALVE_CLOSED. One way you can change these value is to perform   a whole word find and replace.
 To perform a whole word find and   replace: 

 1. On the Edit menu,   click Find and Replace. 

 2. In the Find What   field, enter MIXER1.AI_VALVE_OPEN. 

 3. Click the Replace   tab, and enter MIXER1.AI_VALVE_CLOSED in the Replace With field. 

 4. Click Replace Preview   to view the resulting values in the Replace Value With column. 

 5. Click Replace All.   

If you find and replace a tag which returns numeric data only, such   as F_CV, with a tag that returns non-
numeric data, such as A_CUALM, Data   links that are connected to this tag will no longer appear to 
update.   For example: 

If you 
replace...

With... Then the Replace will...

F_CV A_CV Works for analog tags where the A_CV is simply a string   con-
taining a number.

A_CV F_CV Work without errors.
F_CV A_MODE Not work.
F_CV A_CV and then A_

MODE
Not work because the tag was originally a number.

Using Wildcards

One of the most powerful options you have when finding and replacing data is the ability to include wild-
cards in search strings and the replacement text you enter. You can enter any of the following wildcards:
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* – Finds zero or more characters.

? – Finds any single character. For example, the search string TAN? locates the string TANK. It also loc-
ates the string TANKS.

When replacing data, the wildcard only lets you substitute one character for the wildcard. For 
example, if you replace TAN? with TANZ, the resulting strings are TANZ and TANZS.

\ – Finds wildcard characters in the search string. For example, \* locates an asterisk (*) in the property 
values being searched.

To make your searches more effective, use these guidelines:

 l If the search string has wildcard characters, the replacement string must have the same wildcard 
characters or none at all.   

 l If the search string has no wildcard characters, the replacement string cannot have any wildcard 
characters.   

 l Do not use * and ? in the same search string.   

The table below details some examples of using wildcards with Find and Replace.    

Property Value Search String Replacement Text Modified Value
NODE1.AI1 N*.A* M*.B* MODE1.BI1
NODE1.AI1 *.AI1 NEWNODE.A NEWNODE.A
NODE1.AI1 *.* N2.A2 N2:A2
NODE1.AI2 NOD*.AI* BE*.CO* BEE1.CO2
MIXER1.AI3 MIXER1.A?? MIXER1.D?? MIXER1.DI3
*Alarm Area Mixer* \*Alarm Area Mixer\* -Alarm Area Mixer- -Alarm Area Mixer-

Find and Replace Wildcard Examples   

Finding and Replacing Data in Scripts

By default, finding and replacing data in the iFIX WorkSpace   does not search in the scripts associated 
with the current picture or   schedule. However, you can search in event scripts by selecting the Include   
Scripts check box. Declarations, forms, class modules, and other scripts   are not searched by iFIX. To 
search in these scripts, use the Visual Basic   Editor (VBE). For more information on using the VBE, refer 
to its online   Help.

iFIX lets you add find and replace capabilities to your scripts using   the FindReplace interface in the 
FixScriptGlobal object. Refer to the   Writing Scripts manual and the iFIX   Automation Interfaces Help file 
for more information.

Using Find and Replace with User Globals

In order to use the Find and Replace command on User Globals, you must   right-click the User icon in the 
Globals folder in the system tree, and   select Find and Replace from the menu. You cannot perform a 
Find and Replace   on User Globals by selecting Find and Replace from the Edit menu (Classic   view) or 
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on the Home tab, in the Editing group, click Find and Replace   (Ribbon view). That menu belongs to the 
active document only.

Note that the Find and Replace dialog box displays the name of the document   being searched in its title 
bar. For example, if you perform a Find and   Replace on User Globals, Find and Replace User appears in 
the title bar.

Backing up and Restoring Files 

To help you manage your iFIX files, use the iFIX Backup and Restore   feature. Access this feature 
through the Backup and Restore Wizard or   from the command line. Command line parameters are avail-
able to automate   backup or restore operations in scripting or external programs.

With this feature, you can backup your entire iFIX system or portions   of it. You can later use these 
backed up files to restore your iFIX system,   or specific parts of it. Additionally, you can restore your iFIX 
system   to the factory default settings and files –   a clean restore. This feature is helpful in configuring 
new computers   with the same configuration, or in disaster recovery.

NOTE: A Full Backup includes version dependent files. Do not restore a Full Backup  from one version of iFIX 
to another version. Instead, use the Custom Backup option if you want to restore specific files from one ver-
sion of iFIX  to another. Custom backups do not include iFIX-managed files such as toolbars and .FXG files 
installed or owned by iFIX (FactoryGlobals, PlugandSolve, ExpertGlobals). A custom backup will allow you to 
restore security files, pictures, recipes, databases, SCU, user preferences, INI file settings, user FXG files, tag 
groups, and schedules.

Overview of Files

A Custom Backup of iFIX includes a subset of the following files:

 l SCU files 

 l Configuration files

 l Pictures and Dynamo   sets 

 l Process and alarm   area databases 

 l I/O driver configuration   files and exported databases

 l Alarm files 

 l Historical configuration   and data files 

 l Tag groups 

 l Application files

 l Toolbars 

 l Schedules 

 l Global definition   files and named colors 

 l Chart group wizard   files

 l Startup profiles

 l FIX32 picture and   key macro files
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 l Security files

 l Master and control   recipes 

A Full Backup includes all of your iFIX files in the following folders:

 l ALM path (*.*)

 l APP path (*.*)

 l HTR path (*.*)

 l HTRDATA path (*.*)

 l LOCAL path (*.*)

 l PDB path (*.*)

 l PIC path (*.*)

 l RCC path (*.*)

 l RCM path (*.*)

Be aware that you can even backup and restore application files across   multiple iFIX projects using the 
Project Path concept. For more information   about modifying the project path, refer to the Best  Practices 
for Managing Multiple iFIX Users section.

IMPORTANT:
 l To   backup and restore driver configuration files, you must add the driver   in the SCU's SCADA Con-

figuration dialog box. To add the I/O driver, from   the SCU Configure menu, click SCADA. In the I/O 
Driver Definition area,   click the browse (...) button to select the I/O driver name, and then   click Add. 

 l Be   aware that configuration files for 7.x series drivers saved outside of   the iFIX database directory will 
not be backed up with the Backup and   Restore Wizard. If you installed iFIX to the default location, the 
path   to the iFIX database directory is: C:\Program Files (x86)\Proficy\iFIX\PDB.   

 l Be   sure check the default iFIX path configurations in the SCU in each of   your iFIX projects after you 
restore your files. For example, if you installed   the latest version of iFIX to a 64-bit path C:\Program 
Files (x86)\Proficy\iFIX), and your previous picture files were installed to a 32-bit path   (C:\Program 
Files (x86)\Proficy\iFIX), you will need to make sure you   update these paths in the SCU to 64-bit.

Accessing the Backup and Restore Wizard

To access the Backup and Restore wizard, click the Start button and   point to Programs, iFIX, Tools, 
and then Backup and   Restore Wizard. You can also access the application by locating and running   the 
BackupRestore.exe file in the iFIX folder, which is the folder   where you installed iFIX. If you want to 
restore files, you must shut   down iFIX before running the Backup and Restore wizard. Otherwise, iFIX   
should be running.

The following figure shows the main screen that appears when you open   the Backup and Restore Wiz-
ard.

156 © 2024 General Electric Company. All rights reserved.

opt.chm::/opt_best_practices_for_managing_multiple_ifix_users.htm
opt.chm::/opt_best_practices_for_managing_multiple_ifix_users.htm


Backup and Restore Wizard

Overview of the Backup Process

The Backup and Restore   Wizard allows you to perform the following types of backup:

 l Custom Backup –   Allows you to select the specific files within the project path to backup.   

 l Full Backup –   Archives all files, including security and INI files within the project   path. This 
includes all files in the APP,   HTR, HTRDATA,   LOCAL, PDB,   PIC, RCC,   and RCM folders.

 l Factory Default Backup   – Allows   you to create a new factory default backup file. The Factory 
Default is   a set of default iFIX files used to perform a clean restore. A standard   Fact-
oryDefault.IFD   file is provided with the iFIX product. You can create a new, customized   one, and 
save it under another name or the same name, using this option.

The steps below explain how to perform a backup with the Backup and   Restore Wizard. For steps on 
how to use the command line, refer to the   Using the Command Line   Options section.

 To perform a custom backup: 

 1. In the Backup and   Restore Wizard main screen, select the Custom Backup option. 

 2. Click the Backup   button. The following figure appears. 
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Backup and Restore Wizard   - Custom Backup

 3. Verify that the Backup   Source Info is correct. For more information about modifying the project   
path, refer to the Best  Practices for Managing Multiple iFIX Users section. 

 4. In the Backup File   Option section, select the specific files or folders that you would like   to back 
up. 

 5. Optionally, select   the Include security files in archive option to backup all of your security   files. 

NOTE: If the Backup   and Restore wizard does not detect any security files in the project path,   the 
Include security files in archive option does not appear. 

 6. Click the Next button.   

 7. Enter a backup file   name and path into the field or browse to select one. 

NOTE: By default,   this archive and path is C:\Program Files (x86)\Profi-
cy\iFIX\ProjectBackup\nodename.FBK;   however, you can specify any local path and file name. If you 
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want to   use a network path, you must use a mapped network drive. For instance,   \\MyServer\folder   will 
not work, but a network drive mapped to Y:\folder    (where Y:\   is the map to \\MyServer)   would work.

 8. Click the Finish   button to begin archiving your selected files. 
 To perform a full backup: 

 1. In the Backup and   Restore Wizard main screen, select the Full Backup option. 

 2. Click the Backup   button. 

 3. Enter a backup file   path and filename into the field or browse to select one. 

NOTE: By default,   this archive and path is C:\Program Files (x86)\Profi-
cy\iFIX\ProjectBackup\nodename.FBK;   however, you can specify any local path and file name. If you 
want to   use a network path, you must use a mapped network drive. For instance,   \\MyServer\folder   will 
not work, but a network drive mapped to Y:\folder    (where Y:\   is the map to \\MyServer)   would work.

 4. Click the Finish   button to begin archiving all of your files. 
 To create a new factory default file:   

 1. Start the Backup   and Restore Wizard with the /FactoryDefault   option. For example:
BackupRestore.exe /FactoryDefault

Refer to the Using   the Command Line Options section for more information on /FactoryDefault   
startup options.

 2. In the Backup and   Restore Wizard main screen, select the Factory Default option. 

NOTE:   The Full Backup and Custom Backup options are unavailable when you start   the Backup and 
Restore Wizard in Factory Default mode.

 3. Click the Backup   button. The following dialog box appears.
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Backup and Restore Wizard   - Factory Default Backup

 4. In the Backup File   Option section, select the specific files or folders that you would like   to back 
up. 

NOTE: The Include security files in archive option   is not available for a Factory Default backup. 

 5. Click   the Next button. 

 6. Enter   a backup path and file name into the field, or browse to select one. 

NOTE:   By default, this archive and path is C:\Program   Files\Proficy\Proficy   iFIX\Pro-
jectBackup\nodename.ifd;   however, you can specify any local path and any file name. Most likely,   you 
will want to leave the original Factory Default file, and save the   file under another name. If you want to 
use a network path, you must use   a mapped network drive. For instance, \\MyServer\folder   will not 
work, but a network drive mapped to Y:\folder   (where Y:\   is the map to \\MyServer)   would work.

 7. Click   the Finish button to begin archiving your selected files. 
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TIP: If you enter a new name in step   7, you may want modify the [WizardSettings]   section of 
BackupRestore.ini   file to point this custom Factory Default file. For more information,   refer to the Using   
and Creating FactoryDefault Files and the Sample   BackupRestore.ini sections. 

 

Overview of the Restore Process

You can restore your archived files to any computer that has iFIX installed.   Prior to restoring the files, 
you can select the individual types of files   you want to restore or you can restore the entire archive. 

The Backup and Restore Wizard includes the following restore features:

 l Ability to select   a specified destination for the restored files, as well as the individual   files you 
want to restore. 

 l Ability to delete   all existing files under a target project path before performing a restore.   This 
action removes any existing application files in the destination   paths, with the exception of the 
security files. 

 l Ability to restore   the iFIX factory defaults of your original install before restoring the   backup files. 

 l Option to retain   the current SCU security settings for the restore, replace the SCU settings   with 
the ones in the archive, or create a new project requiring the input   of a new project folder to com-
plete the restore. 

The steps below explain how to perform a restore with the Backup and   Restore Wizard. For steps on 
how to use the command line, refer to the   Using the Command Line   Options section.

 To restore an archive: 

 1. In the Backup and   Restore Wizard main screen, select the Restore button. 

 2. On the first page   of the wizard, enter the backup file name to restore or click browse to   select 
one. 

By default, backup files are stored in the   C:\Program Files (x86)\Proficy\iFIX\ProjectBackup 
folder.

 3. Click Next to continue.   The following dialog box appears, allowing you to select the appropriate   
restore options. 
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iFIX Restore Wizard

 4. Select the required   options and click Finish.
 To restore a factory default file:   

 1. Start the Backup   and Restore Wizard with the /FactoryDefault command line option. For 
example:
BackupRestore.exe /FactoryDefault

Refer to the Using   the Command Line Options section for more information on /FactoryDefault   
startup options.

 2. In the Backup and   Restore Wizard main screen, select the Restore button. 

 3. On the first page   of the wizard, enter the file name of the factory default backup or click   browse to 
select one. 

To restore iFIX with the standard factory   defaults, select the FactoryDefault.IFD file. If you 
installed iFIX to   the default location, you can find this file in the C:\Program Files (x86)\Profi-
cy\iFIX folder.

 4. Click Next to continue.

 5. Select the required   options and click Finish.
Restore Destination Options

The Restore Destination Options allow you to select whether you restore   the files to the current project 
path, the project path specified in the   archived SCU, or into a separate new project path. The Create 
New Project   option does not modify the existing SCU settings. 
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If you select to use the SCU file from the archive, this overwrites   the SCU file on the target computer. 
Typically, you would only want to   overwrite an SCU file if the target computer does not have an SCU 
file,   or if you want to restore the target computer to its previous state. 

If you choose to overwrite an existing SCU file, be sure to verify that   the computer's hardware key sup-
ports all of the enabled SCU options and   the software for these options is installed. For example, if 
SCADA support   is enabled, verify that the hardware key has SCADA support and that the   SCADA soft-
ware is installed on the target node. You should also verify   that the path for each start-up task, listed in 
the Task Configuration   dialog box, is correct.

You can modify the node name and project path stored in the archived   SCU file when you select to over-
write the existing SCU file. The Node   field defines the node name stored in the archived SCU file; the 
Project   Path field defines the project path.

When the restoration process begins, the wizard reads the text in the   Node and Project Path fields to 
determine where to restore the files you   selected. Next, the wizard restores the files using the relative 
paths   stored in the selected SCU file. The wizard creates any non-existent paths.

NOTE: If multiple SCU   files exist in the archive when you are restoring files, iFIX copies all   existing SCU files 
to the Local path. The SCU file that was in use continues   to be used by the system. 

If you choose to Create a New Project, files are restored to a new project   path with a default sub-project 
path. To modify the default sub-project   paths, refer to the BackupRestore.ini or user-specified .INI file. 

Optionally, once you have restored the file, you can create a new SCU   file and point to these new paths. 
Destination Info

The Destination Info section of the Restore screen displays the SCU   file, node, and project path that the 
archive will be restored to. To   display the configured paths for the restored files within the project,   click 
the View Project Path Configuration button. The configured paths   are determined by the destination 
option you selected. If you selected:

Use the current   SCU –   the paths are determined by the SCU file currently loaded. 

Use SCU from archive   – the   paths are determined by the SCU file in the archive. You can modify the   
node name and project path. Sub-project paths are determined by the SCU   file in the archive and can-
not be modified. 

Create a new project   –   the project path is determined by user input. Sub-project paths are determined   
by the .INI file settings. Refer to the BackupRestore.ini file for more   information.

Restore File Options

To perform a clean restore, the Backup and Restore wizard allows you   to delete all existing files or to 
restore default iFIX files before restoring   the archive. 

Select the Delete all existing files under target project path before   the restore option to delete all existing 
files before restoring a Custom   or Full backup file. This option will not delete existing security files   or the 
current SCU file loaded in local startup. 

Select the Restore default iFIX files before restoring your backup files   option to return the files to their 
default state before performing a   restore. For Custom and Full restores, the default iFIX files are restored   
from the FactoryDefault file. 

To modify the default settings, modify the FactoryDefault definitions   in the BackupRestore.ini file. For 
more information, refer to the BackupRestore.ini   file.
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Security File Option

If the Restore Wizard locates any security files in the archive that   you are restoring, you can select from 
the following options:

Leave the current   security settings alone –   Select this option to maintain the current security settings 
and ignore   security overwrites in the backup files during the restore. 

Replace existing   security files with archived files –   Select this option to replace the current security 
settings with the security   settings in the archived files.

Delete all existing   security files and disable security –   Select this option to delete all existing secur-
ity files from the current   iFIX system and disable security upon restore. This option also displays   the 
current status of security (Enabled or Disabled). If you select this   option, ensure that the Restore 
default iFIX files before restoring your   backup files option is also selected to use the active iFIX pro-
ject. 

The restore destination for security files is determined by the presence   of security files in the current 
iFIX system and the archive. The following   table shows the sample configurations and the determined 
destination:   

 Are security files present   in current 
iFIX configuration?

Are security files 
present   in archive?

Destination of restored   
security files:

1No No N/A
2No node.dov Target local path
3No Display.dov Target local path
4node.dov node.dov Target local path
5node.dov Display.dov Target local path
6Display.dov node.dov Target local path
7Display.dov Display.dov Current global security 

path

NOTE: In the previous   table, node.dov denotes that local security settings   related to a single project are 
found. Display.dov denotes that global   security settings are found.

In the 2nd and 3rd configurations shown in the table, the security files   are restored to the target local 
path. The user receives no warning message.

In the 4th and 5th configurations, the security files are also restored   to the target local path. A warning 
message displays the current security   path and the new security path. As node.dov relates   to a specific 
single project, if the current path is not equal to the   target path, the existing security settings remain and 
the archived security   settings are restored to a new project path. If the current path is equal   to the target 
path, the existing security files are deleted and then the   archive is restored.

In the 6th configuration, the global security settings are removed and   the security files are restored to the 
target local path. A warning message   appears displaying the current security path and the new security 
path.

In the 7th configuration, security files are restored to the current   global security path. A warning mes-
sage displays, alerting the user that   the current security path is the same as the new security path and 
will   be overwritten.
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Restore File Selection

Once you select the appropriate restore options, select which specific   files you would like to restore to 
the project path. If you would like   to restore all files, select the Restore the entire system check box.   

Using the Command Line Options

You can also run the Backup and Restore utility from the command line.   This is especially useful if you 
want to automate the backup and restore   operations through scripting or external programs. 

The syntax for the BackupRestore.exe command line is as follows:

Syntax for Backup
BackupRestore.exe
[/FactoryDefault]
/B=<file name with full path>
[/F]
[/P=<project path> or /P=UseINI]
[/BackupSec]
[/S or /Y]
[/I=<ini file name>]
 

Syntax for Restore
BackupRestore.exe
[/FactoryDefault]
/R=<file name with full path>
[/A]
[/A=<project path> [/N=<node name>] [/X]]
[/P=<project path> or /P=UseINI]]
[/C]
[[/RestoreSec] or [/DelSec]]
[/NOIFD]
[/S or /Y]
[/I=<ini file name>]

Notes on the Syntax 

 l The brackets ( [   ] ) indicate that a parameter is optional. The brackets are not part of   a command; 
if a bracketed option is desired, type only the text that is   inside the brackets, and not the brackets 
themselves. 

 l Italics are used   to represent the information that the user must supply to run the command.   The 
information in italics is not typed exactly as it appears. Instead,   the user enters the information 
specific to the italicized expression.   

The following table lists the command line options available for BackupRestore.exe.   

Command 
Option

Description

/F Specifies a Full Backup of all files within a project   path, including security files.
/FactoryDefault Performs a factory default backup or restore.
/P Specifies the source project path for the Backup or   the destination project path for the 

restore.

Available Command Options 
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/P=UseINI Specifies the source project path for the Backup or   the destination project path for the 
Restore. Allows you to specify the   full path for all sub-project paths within the INI file 
settings.

/A Uses the archived SCU file to determine the destination   project path of the Restore.
/A=<project 
path> 

Specifies the destination project path for the Restore,   and sets it to the extracted SCU 
file.

/N=<node 
name>

Specifies the node name of the node you want to restore.   Used with the /A option.

/X Specifies that you do not want to rename the current   node name with the name of the 
restored node. Used with the /A option.

/C Deletes all existing files under the selected project   path before restoring a Custom or 
Full Backup file.

/BackupSec Includes security files in the backup.
/RestoreSec Replaces the current security settings with the security   settings in the archived files 

during the restore.
/DelSec Deletes all existing security files and disables security   upon restore.
/NOIFD Do not restore default iFIX project files before restoring your backup files. 
/S Runs the Backup or Restore project in silent mode,   with no progress bar or user 

prompt.
/Y Automates the user prompt and displays the progress   bar while the backup or restore 

runs in silent mode.
/I Specifies an .INI file and path, if you want to use   an .INI file other than the 

BackupRestore.ini file. 

By default, Backup and Restore reads the BackupRestore.ini   file in the Local folder. 
By using the /l command, you can specify another   .INI file name. The format must be 
the same as the BackupRestore.ini file   however. Refer to the Sample   
BackupRestore.ini section for more information.

/? Opens the Help for the command line options.

NOTE: If you do not   define the /P option while running a Backup, the source path is taken   from the current 
SCU setting. If you do not define the /P or /A option   while running a Restore, the destination is the current 
SCU setting.

Examples

This command performs a custom backup silently including security files,   without displaying the Backup 
and Restore Wizard:

BackupRestore.exe /B="C:\Program Files (x86)\Proficy\iFIX\ProjectBackup\FIX.fbk" /S /BackupSec

This command performs a project restore to the current project path   silently, without displaying the 
Backup and Restore Wizard:

BackupRestore.exe /R="C:\Program Files (x86)\Proficy\iFIX\ProjectBackup\FIX.fbk" /S /RestoreSec

This command performs a project restore to the project path archived   in the SCU, and shows a progress 
bar for restore process:

BackupRestore.exe /R="C:\Program Files (x86)\Proficy\iFIX\ProjectBackup\FIX.fbk" /A /Y
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NOTE: When including   the /A command, you may need to review the SCU to see if the base path   has 
changed.

This command performs a factory default backup, without displaying the   Backup and Restore Wizard:

BackupRestore.exe /FactoryDefault /B="C:\Program Files (x86)\Proficy\iFIX\ProjectBackup\FIX.ifd" /S

This command performs a factory default restore, without displaying   the Backup and Restore Wizard:

BackupRestore.exe /FactoryDefault /R="C:\Program Files (x86)\Proficy\iFIX\ProjectBackup\FIX.ifd" /S

Return Code

The Backup and Restore application returns the following exit codes   after it runs.

Exit Code Description
0 Backup or Restore action completed without errors.

When you run the user interface for the Backup and Restore, instead   of using the com-
mand line, the exit code also will be 0.

1 Backup or Restore action aborted with an error. This usually indicates   that the error 
occurred during the action. For example: a backup file   was unable to be opened, a 
backup file is corrupted, or security settings   could not be adjusted .

2 Backup or Restore action unable to start, for any reason. For example:   an invalid com-
mand was detected, or a specified file was not found.

Also, when you run the BackupRestore.exe /? help command, the exit code   is 2.

When the BackupRestore.exe program returns a 1 or 2, the action failed.   If an error is detected before an 
action log file opens, these errors   are recorded in the BackupRestoreDefaultLog.txt file. By default, this   
file is located in the iFIX base path. If you installed iFIX to the default   location, then the base path is the 
C:\Program Files (x86)\Proficy\iFIX   folder.

If a 1 or 2 is returned, look to the BackupRestoreDefaultLog.txt first   for details on the error. If there is no 
information there, then look   at actual action log (BackupLog.txt or RestoreLog.txt).

Be aware that the BackupRestoreDefaultLog.txt log also contains full   command line parameter inform-
ation and the time when the BackupRestore.exe   program started. 

Using and Creating Factory Default Files

The Factory Default is a set of default iFIX files used to perform a   clean restore. A standard Fact-
oryDefault.IFD file is provided with the   iFIX product.  Refer   to the Files Included in the FactoryDefault 
Backup   File section below for a list of files included in the standard .IFD   file.

NOTE: Be   aware that if you later install an iFIX SIM as a product update, and that   SIM contains updated iFIX 
factory default files, the SIM installer prompts   you to update the original FactoryDefault.IFD file as a part of the 
SIM   installation. 

You can also create your own Factory Default file, with the .IFD file   extension, to include custom tool-
bars, custom Dynamo objects, application   specific picture templates, or user specific .INI settings. To 
do this,   you use the Factory Default command line option for the Backup and Restore   application. You 
can overwrite the original FactoryDefault.IFD file, or   create a new one. Most likely, you will want to 
leave the original Factory   Default file, and save the file under another name. 
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IMPORTANT:  
 l Be   aware that whatever files are included in the FactoryDefault.IFD file   are also used in the restore 

process, by default, when you select the   Restore default iFIX files before restoring   your backup files 
check box in the iFIX Restore Wizard. If you   overwrite the original FactoryDefault.IFD file, you change 
the files that   get restored when that check box is selected. Use caution when overwriting   the original 
FactoryDefault.IFD file. 

 l If   you want this check box to reference another Factory Default file, modify   the [WizardSettings] section 
of BackupRestore.ini file. On the FACTORYDEFAULT=FactoryDefault.IFD,   replace FactoryDefault.IFD 
with the name of your new factory default file.   For more information on the BackupRestore.ini file, refer 
to the Sample   BackupRestore.ini file section.

To create a Factory Default backup file, type the following at the command   line and press ENTER:

BackupRestore.exe /FactoryDefault

This command starts the Backup and Restore application with the Create   New Factory Default file 
option enabled. 

To restore the files in a Factory Default file, use the same command   line option:

BackupRestore.exe /FactoryDefault 

When the /FactoryDefault option is specified, the Backup and Restore   Wizard appears with the Custom 
and Full Backup buttons unavailable, as   shown in the following figure. To create a new Factory Default 
file, click   the Project Backup button to open the Project Backup Wizard. To restore   a Factory Default 
file, click the Project Restore button to open the Project   Restore Wizard.  

For more information on using Command Line options, refer to Using   the Command Line Options sec-
tion.
Files Included in the Factory Default Backup File

The following is a list of files included in the FactoryDefault.IFD   file provided with the iFIX product. If you 
select the Restore default   iFIX files before restoring your backup files option during a restore,   these files 
will be restored to your system before the archive is restored.   
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IMPORTANT: Be   aware that if you later install an iFIX SIM as a product update, and that   SIM contains 
updated iFIX factory default files, the SIM installer prompts   you to update the original FactoryDefault.IFD file 
as a part of SIM the   installation. 

The FactoryDefault.IFD file includes the following files:

ALM Files
None
APP Files 
APP\BuildDynamoInstall.grf
APP\ChartGroupInstall.grf
APP\iDetective.tbx
APP\sqlerr.txt
HTR Files
HTR\ChartGroup1.csv
HTR\ChartGroup2.csv
HTR\ChartGroup3.csv
HTRDATA Files
None
Local Files
LOCAL\alarm.ini
LOCAL\AnimationTasks.tbc
LOCAL\Applications.tbc
LOCAL\ApplicationToolbar.tbx
LOCAL\ApplicationToolbar.xbt
LOCAL\Association.dat
LOCAL\BackupRestore.ini
LOCAL\BuildDynamo.bmp
LOCAL\CADToolbar.tbx
LOCAL\CADToolbar.xbt
LOCAL\CADTools.tbc
LOCAL\ChartGroups.tbc
LOCAL\ChartGroupToolbar.tbx
LOCAL\ChartGroupToolbar.xbt
LOCAL\CommandTasks.tbc
LOCAL\ConfigureWizard.ini
LOCAL\CreateObjects.tbc
LOCAL\CrossReference.ini
LOCAL\CustomButton1.bmp
LOCAL\CustomButton10.bmp
LOCAL\CustomButton2.bmp
LOCAL\CustomButton3.bmp
LOCAL\CustomButton4.bmp
LOCAL\CustomButton5.bmp
LOCAL\CustomButton6.bmp
LOCAL\CustomButton7.bmp
LOCAL\CustomButton8.bmp
LOCAL\CustomButton9.bmp
LOCAL\databasemanager.ini
LOCAL\DatabaseTasks.tbc
LOCAL\DataEntryTasks.tbc
LOCAL\ddeclnt.ini
LOCAL\default.fmt
LOCAL\default.qry
LOCAL\default.rft
LOCAL\default.srt
LOCAL\draw.ini
LOCAL\dwnarrow.ico
LOCAL\dwndwnarrow.ico
LOCAL\DynamoToolbar.tbx
LOCAL\DynamoToolbar.xbt
LOCAL\DynamoTools.tbc
LOCAL\Edit.tbx
LOCAL\Edit.xbt
LOCAL\Experts.tbx
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LOCAL\Experts.xbt
LOCAL\filterederrors.ini
LOCAL\FindReplace.csv
LOCAL\fix.ini
LOCAL\FixGraphicConnectionObjects.tbx
LOCAL\FixGraphicConnectionObjects.xbt
LOCAL\fixodbc.ini
LOCAL\FixUserPreferences.ini
LOCAL\FormatObjects.tbc
LOCAL\GraphicConnections.tbc
LOCAL\Horn.ico
LOCAL\HPLookupColors.ini
LOCAL\htd.ini
LOCAL\iFixScreenSaver.bmp
LOCAL\iFIXSysMgmt.ini
LOCAL\ImportToolbars.txt
LOCAL\logmsg.tov
LOCAL\NoHorn.ico
LOCAL\ProficyEnableFocusTracking.ini
LOCAL\PictureExporter.tbc
LOCAL\PictureTasks.tbc
LOCAL\ProficyHistorian.tbx
LOCAL\ProficyHistorian.xbt
LOCAL\ProficyHistorianCat.tbc
LOCAL\ReportTasks.tbc
LOCAL\RestoreLog.txt
LOCAL\Ribbon.ini
LOCAL\SCADASync.ini
LOCAL\Scheduler.tbc
LOCAL\SECNET.ini
LOCAL\SetupComServerApp.ini
LOCAL\Shapes.tbx
LOCAL\Shapes.xbt
LOCAL\Standard.tbc
LOCAL\StandardCategories.txt
LOCAL\StandardToolbars.ini
LOCAL\StandardToolbar.tbx
LOCAL\StandardToolbar.xbt
LOCAL\SystemTree.csv
LOCAL\Toolbox.tbx
LOCAL\Toolbox.xbt
LOCAL\Tools.tbx
LOCAL\Tools.xbt
LOCAL\TranslationToolbar.tbx
LOCAL\TranslationToolbar.xbt
LOCAL\uparrow.ico
LOCAL\upuparrow.ico
LOCAL\Utilities.tbx
LOCAL\Utilities.xbt
LOCAL\view.ini
LOCAL\VisiconXControls.tbc
LOCAL\VisiconXToolbar.tbx
LOCAL\VisiconXToolbar.xbt
LOCAL\Web_HMI.tbx
LOCAL\Web_HMI.xbt
PDB Files
PDB\aa61.tbl
PDB\ai61.tbl
PDB\ao61.tbl
PDB\ar61.tbl
PDB\bb61.tbl
PDB\bl61.tbl
PDB\ca61.tbl
PDB\CGW.csv
PDB\da61.tbl
PDB\dc61.tbl
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PDB\Default.SM2
PDB\di61.tbl
PDB\do61.tbl
PDB\dr61.tbl
PDB\dt61.tbl
PDB\empty.pdb
PDB\etr61.tbl
PDB\etr73.tbl
PDB\ev61.tbl
PDB\fn61.tbl
PDB\hs61.tbl
PDB\ll61.tbl
PDB\mdi61.tbl
PDB\pa61.tbl
PDB\pg61.tbl
PDB\pid61.tbl
PDB\rb61.tbl
PDB\rm61.tbl
PDB\sc61.tbl
PDB\sd61.tbl
PDB\sqd61.tbl
PDB\sqt61.tbl
PDB\ss61.tbl
PDB\tm61.tbl
PDB\tr61.tbl
PDB\tt61.tbl
PDB\tx61.tbl
PIC Files
PIC\TagStatus
PIC\3D_TEXT.SBL
PIC\aa.bdf
PIC\ai.bdf
PIC\ao.bdf
PIC\ar.bdf
PIC\bb.bdf
PIC\bl.bdf
PIC\BORDERS.SBL
PIC\BUNGEE.odt
PIC\BUNGEE.SVA
PIC\BUNGEE.VGA
PIC\BUTTONS.SBL
PIC\ca.bdf
PIC\ChartGroupDemo.grf
PIC\CHARTS1!.SBL
PIC\CHARTS2!.SBL
PIC\CHARTS3!.SBL
PIC\CHARTS4!.SBL
PIC\CHKBOX!.SBL
PIC\CHKBOX2!.SBL
PIC\da.bdf
PIC\di.bdf
PIC\do.bdf
PIC\dr.bdf
PIC\draw.kmx
PIC\dt.bdf
PIC\DTALNK1!.SBL
PIC\DTALNK2!.SBL
PIC\etr.bdf
PIC\ev.bdf
PIC\EmergencyStopButtons.fds
PIC\ExpertGlobal.fxg
PIC\ExpertGlobals2.fxg
PIC\FACEPLT!.SBL
PIC\FactoryGlobals.fxg
PIC\fn.bdf
PIC\FREEFALL.odt
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PIC\FREEFALL.SVA
PIC\FREEFALL.VGA
PIC\GaugesHozizontalLarge.fds
PIC\GaugesHozizontalMedium.fds
PIC\GaugesHozizontalSmall.fds
PIC\GaugesRoundLarge.fds
PIC\GaugesRoundMedium.fds
PIC\GaugesRoundSmall.fds
PIC\GaugesVerticalLarge.fds
PIC\GaugesVerticalMedium.fds
PIC\GaugesVerticalSmall.fds
PIC\HANGTEN.odt
PIC\HANGTEN.SVA
PIC\HANGTEN.VGA
PIC\High Performance.FTB
PIC\Historical.fds
PIC\HistoricalLineChart.fds
PIC\HPArrows.fds
PIC\HPLinearGauges.fds
PIC\HPLinearGaugesHist.fds
PIC\HPMixers.fds
PIC\HPMotors.fds
PIC\HPPipes.fds
PIC\HPPumps.fds
PIC\HPTanks.fds
PIC\HPTanksAnim.fds
PIC\HPTanksAnimHist.fds
PIC\HPValves.fds
PIC\hs.bdf
PIC\INLINE.odt
PIC\INLINE.SVA
PIC\INLINE.VGA
PIC\ISA-S55A.SBL
PIC\ISA-S55B.SBL
PIC\ISA-S55C.SBL
PIC\ISA-S55D.SBL
PIC\ISA-Y32A.SBL
PIC\ISA-Y32B.SBL
PIC\ISA-Y32C.SBL
PIC\ISA-Y32D.SBL
PIC\ISA-Y32E.SBL
PIC\ISA-Y32F.SBL
PIC\ISA-Y32G.SBL
PIC\ISA-Y32H.SBL
PIC\ISA-Y32I.SBL
PIC\KEYPAD!.SBL
PIC\ll.bdf
PIC\LocalAsBackup.grf
PIC\LocalAsPrimary.grf
PIC\LUGE.odt
PIC\LUGE.SVA
PIC\LUGE.VGA
PIC\mdi.bdf
PIC\METERS!.SBL
PIC\METERS2!.SBL
PIC\Miscellaneous.fds
PIC\MOTORS!.SBL
PIC\Motors.fds
PIC\MOTORS.SBL
PIC\NetworkStatusDisplay.grf
PIC\NetworkStatusOverview.grf
PIC\NetworkStatusRedundancyDisplay.grf
PIC\on.bdf
PIC\pa.bdf
PIC\PanelButtonsLarge.fds
PIC\PanelButtonsMedium.fds
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PIC\PanelButtonsSmall.fds
PIC\PC_PLC.SBL
PIC\pg.bdf
PIC\pid.bdf
PIC\PilotLightsLarge.fds
PIC\PilotLightsMedium.fds
PIC\PilotLightsSmall.fds
PIC\Pipes.fds
PIC\PIPES1.SBL
PIC\PIPES2!.SBL
PIC\PIPES2.SBL
PIC\PIPES3!.SBL
PIC\PIPES3.SBL
PIC\PipesAnim.fds
PIC\PlugandSolve.fxg
PIC\PSHBTN1!.SBL
PIC\PSHBTN2!.SBL
PIC\PTV.odt
PIC\PTV.SVA
PIC\PTV.VGA
PIC\PUMPS!.SBL
PIC\Pumps.fds
PIC\PumpsLarge.fds
PIC\PumpsSmall.fds
PIC\PUMPS.SBL
PIC\PumpsAnim.fds
PIC\RADIO!.SBL
PIC\RADIO2!.SBL
PIC\rb.bdf
PIC\rm.bdf
PIC\ROWERS.SBL
PIC\RUNTASK!.SBL
PIC\sc.bdf
PIC\sd.bdf
PIC\Shades Of Blue.ftb
PIC\Shades Of Cyan.ftb
PIC\Shades Of Gray.ftb
PIC\Shades Of Green.ftb
PIC\Shades Of Magenta.ftb
PIC\Shades Of Red.ftb
PIC\Shades Of Yellow.ftb
PIC\SHAPES.SBL
PIC\SLIDERS!.SBL
PIC\SPIKE.odt
PIC\SPIKE.SVA
PIC\SPIKE.VGA
PIC\sqd.bdf
PIC\sqt.bdf
PIC\StorageTanksLarge.fds
PIC\StorageTanksAnim.fds
PIC\ss.bdf
PIC\SwitchesLarge.fds
PIC\SwitchesMedium.fds
PIC\SwitchesSmall.fds
PIC\System Default.ftb
PIC\SYSTEM!.SBL
PIC\TANKS!.SBL
PIC\Tanks.fds
PIC\TANKS.SBL
PIC\TanksAnim1.fds
PIC\TanksAnim2.fds
PIC\TICMARKS.SBL
PIC\tm.bdf
PIC\tr.bdf
PIC\tt.bdf
PIC\tx.bdf
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PIC\UpDownButtons.fds
PIC\VALVES!.SBL
PIC\Valves.fds
PIC\VALVES.SBL
PIC\ValvesAnim.fds
PIC\ValvesISAHorizLarge.fds
PIC\ValvesISAHorizSmall.fds
PIC\ValvesISAVertLarge.fds
PIC\ValvesISAVertSmall.fds
PIC\VBARS!.SBL
PIC\view.kmx
PIC\WizLayouts.tpl
PIC\TagStatus\Aa_TS.Grf
PIC\TagStatus\AI_TS.grf
PIC\TagStatus\AO_TS.Grf
PIC\TagStatus\Ar_TS.Grf
PIC\TagStatus\Bb_TS.Grf
PIC\TagStatus\Bl_TS.Grf
PIC\TagStatus\Ca_TS.Grf
PIC\TagStatus\Da_TS.Grf
PIC\TagStatus\DI_TS.Grf
PIC\TagStatus\Do_TS.Grf
PIC\TagStatus\Dr_TS.Grf
PIC\TagStatus\Dt_TS.Grf
PIC\TagStatus\Etr_TS.grf
PIC\TagStatus\Ev_TS.Grf
PIC\TagStatus\Fn_TS.Grf
PIC\TagStatus\Hs_TS.Grf
PIC\TagStatus\Ll_TS.Grf
PIC\TagStatus\Mdi_TS.grf
PIC\TagStatus\Pa_TS.Grf
PIC\TagStatus\Pg_TS.Grf
PIC\TagStatus\Pid_TS.grf
PIC\TagStatus\QuickTrend.grf
PIC\TagStatus\Rb_TS.Grf
PIC\TagStatus\Rm_TS.Grf
PIC\TagStatus\Sc_TS.Grf
PIC\TagStatus\Sd_TS.Grf
PIC\TagStatus\Sqd_TS.grf
PIC\TagStatus\Sqt_TS.grf
PIC\TagStatus\Ss_TS.Grf
PIC\TagStatus\TagControlPanel.grf
PIC\TagStatus\Tm_TS.Grf
PIC\TagStatus\Tr_TS.Grf
PIC\TagStatus\TS.ini
PIC\TagStatus\Tt_TS.Grf
PIC\TagStatus\Tx_TS.Grf
RCC Files
None
RCM Files
None
 
 

Sample BackupRestore.ini

Use the BackupRestore.ini to specify default and custom settings that   appear in the Backup and 
Restore Wizard, and when you run BackupRestore.exe   from a command line. The BackupRestore.ini 
file is located in the iFIX   LOCAL folder. If you installed iFIX to the default location, you can find   the 
BackupRestore.ini in the C:\Program Files (x86)\Proficy\iFIX\LOCAL   folder.

The BackupRestore.ini file can contain information in the following   sections:
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 l [Version]   – used   to determine iFIX product version in archive header signature. This section   is 
required. Do not change this value.

 l [DefaultSubProject]   – used   to determine default sub-project paths for the Create New Project 
option   in the Restore operation.

 l [FactoryDefaultExtension]   – used   to determine which files are included in Factory Default set-
tings.

 l [WizardSettings]   –   used to determine file name and path (if it is different than your iFIX   base 
path) of the Factory Default file when you select the "Restore   default iFIX files before restoring 
your backup files" option during   a Restore operation. 

 l [AddCustomExtension]   – used   if you want to include or exclude any additional files or file types 
in   your custom backup. By default, the AddExtension feature is set to False.   Set AddExtension 
to True to enable this feature. Each category has keys   to include (xxxIncludeExtn=) and exclude 
(xxxxExcludeExtn=) files. The   xxxxExcludeExtn key is used to exclude files from xxxxIn-
cludeExtn key,   not to exclude a default extension. 

The entire key can be up to 2048 characters   long, in total. If you exceed this length, for instance if 
the path is   too long, an error message appears and the custom file or file extension   is ignored 
when you attempt the backup.

IMPORTANT:   Make sure that you do not include the same file or file extension (from   the same loc-
ation) in more than one category.  If   you back up the same file or file type in more than one category, 
you   will experience issues restoring your files. Configure your custom settings   carefully.

By default, TakeExtension is false. Set TakeExtension to True and execute a backup from the com-
mand line, specifying this INI file in order to backup only the specified files and/or extensions and to 
ignore the default extension list, which you can see in the UI. This can be used only when the user 
wants to backup specific files.

By default, the Backup and Restore application references the BackupRestore.ini   file when it runs. If 
you want to change the name of the .INI file, you   must run BackupRestore.exe with the /i command line 
option, and specify   the file name of the custom .INI file. If you create a custom .INI file,   it must follow 
the same format described above. 

The following is an example of the BackupRestore.ini from the iFIX LOCAL folder that includes all   four of 
the sections defined above:

;BackupRestore.ini - Customizing your BackupRestore.ini file
;
;[Version]
; Do not change the Version key.
; If you create your own .ini file using the /I option, this section and key are required.
;
;[DefaultSubProject]
; 1. If you select the "Create New Project" destination option,
;    define the sub-project folders here.
; 2. If you use the /P option during backup, the sub-project folders defined here are archived.
; 3. If you use the /P option during restore, the archive files are restored to the sub-project
;          folders defined here.
;
;[FactoryDefaultExtension]
; If you generate your own FactoryDefault file, use this section to define which files to
;       include in your FactoryDefault backup.
;
;[WizardSettings]
; Use the FACTORYDEFAULT key in your FactoryDefault file when select the "Restore default
;       iFIX files before restoring your backup files" option during a restore.
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;
;       The FACTORYDEFAULT_PATH key is used for your FactoryDefault file path. If this section is blank,
;       your current BASEPATH is used.
; For example: FACTORYDEFAULT_PATH=C:\MySetting (do not add "\" at the end)
;
;[AddCustomExtension]
; If you like to add file type to custom backup, it allows you to define
; additional extension for each categories to include/exclude files to backup.
; To make it enabled, change AddExtension to True.
; AddExtension=TRUE
; Then, add file name or file type for specific key in categories. For example:
; [AddCustomExtension]
; AddExtension=TRUE
; PicIncludeExtn=*.bmp,*.jpg
; PicExcludeExtn=aaaa.bmp
;
; If you like to define specific file or file type to custom backup, it allows you to define
; extensions or actual file name for each categories. Default extension lists will be ignored.
; For example:
; [AddCustomExtension]
; TakeExtension=TRUE
; Database files (*.PDB,*.AAD), PDBPATH
; PDBIncludeExtn=TEST.PDB,AlarmAreas.AAD
; PDBExcludeExtn=
[Version]
Version=6.80
[DefaultSubProject]
LOCPATH=LOCAL
PDBPATH=PDB
NLSPATH=NLS
PICPATH=PIC
APPPATH=APP
HTCPATH=HTR
HTDPATH=HTRDATA
HTRDATA=HTRDATA
ALMPATH=ALM
RCMPATH=RCM
RCCPATH=RCC
AADPPATH=PDB
AADBPATH=PDB
ADDONPATH=ADDON
CFGPATH=CFG
[FactoryDefaultExtension]
ALM_EXTN=*.*
APP_EXTN=*.grf,*.tbx,sqlerr.txt
HTR_EXTN=*.csv
HTRDATA_EXTN=*.*
LOCAL_EXTN=*.json,CONFIGDB\*.json,UA\*.*,iFIX_OpcuaConfigService\*.pfx,OpcUaDefinitions.csv,Serverconfig.xml,Association.dat,RibbonAssociation.dat,default.fmt,FindReplace.csv,SystemTree.csv,default.qry,default.rft,default.srt,logmsg.tov,StandardCategories.txt,*.tbc,*.tbx,*.xbt,*.ico,*.bmp,*.ini,ImportToolbars.txt,autoStartKey.dat
PDB_EXTN=CGW.csv,Default.SM2,empty.pdb,*.tbl,iFixUaClient\*.json,*.json
PIC_EXTN=WizLayouts.tpl,*.fds,*.ftb,*.fxg,*.grf,*.SBL,*.BDF,*.odt,*.SVA,*.VGA,*.kmx,*.CSV,TS.ini
RCC_EXTN=*.*
RCM_EXTN=*.*
ADDON_EXTN=*.ini,*.tbc
CFG_EXTN=*.json,*.pfx
[WizardSettings]
FACTORYDEFAULT=FactoryDefault.IFD
FACTORYDEFAULT_PATH=
;
; CUstom extension
;
[AddCustomExtension]
AddExtension=FALSE
TakeExtension=FALSE
;
;Configuration files (*.SCU,*.INI,*.CFG), LOCPATH
SCUIncludeExtn=

176 © 2024 General Electric Company. All rights reserved.



SCUExcludeExtn=
;
;Picture files (*.GRF,*.FDS,*.FTB,*.LST), PICPATH
PicIncludeExtn=
PicExcludeExtn=
;
;Database files (*.PDB,*.AAD), PDBPATH
PDBIncludeExtn=
PDBExcludeExtn=
;
;Database ASCII files (*.GDB), PDBPATH
GDBIncludeExtn=
GDBExcludeExtn=
;
;Driver Configuration Binary files (*.*), PDBPATH
DrvIncludeExtn=
DrvExcludeExtn=
;
;Database/Driver CSV files (*.CSV), PDBPATH
DBCSVIncludeExtn=
DBCSVExcludeExtn=
;
;Historical Config files (.CFG,*.HGP,*.DAT), HTCPATH
HistConfigIncludeExtn=
HistCOnfigExcludeExtn=
;
;Tag Group files (*.TGD,*.TGS,*.TGE), PICPATH
TagGroupIncludeExtn=
TagGroupExcludeExtn=
;
;Recipe Control files (*.RCC,*.RCY), RCCPATH
RCPIncludeExtn=
RCPExcludeExtn=
;
;Master Recipe files (*.RCM,*.RCX), RCMPATH
RCMIncludeExtn=
RCMExcludeExtn=
;
;Application files (*.*), APPPATH
APPIncludeExtn=
APPExcludeExtn=
;
;Project Toolbar files(*.TBX,*.TBC), LOCPATH
ToolbarIncludeExtn=
ToolbarExcludeExtn=
;
;Event Schedule files (*.EVS), PDBPATH
ScheduleIncludeExtn=
ScheduleExcludeExtn=
;
;Project Global Definition Files(*.FXG), PICPATH
FXGIncludeExtn=
FXGExcludeExtn=
;
;Chart Group Wizard files(*.CSV), HTCPATH
CGWIncludeExtn=
CGWExcludeExtn=
;
;FIX32 Picture files(*.ODF,*.ODT,*.SBL), PICPATH
FIX32PicIncludeExtn=
FIX32PicExcludeExtn=
;
;FIX32 KeyMacro files(*.KMX), PICPATH
Fix32KMEIncludeExtn=
Fix32KMEExcludeExtn=
;
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;Addon files(*.INI,*.TBC), ADDONPATH
AddonIncludeExtn=
AddonExcludeExtn=
;
;CFG files(*.*), CFGPATH
CfgIncludeExtn=
CfgExcludeExtn=
 

Specifying a Batch Execution Project 

If you have Batch Execution installed on your computer, you   can configure the local node by specifying 
a name for the current project   with the iFIX WorkSpace. In Batch Execution, a project   is the entire set of 
files needed to deliver a batch solution. Typically,   a project includes:

 l Pictures 

 l An equipment database   

 l Recipes 

 l Configuration files   

However, a project can also include Word files, Excel spreadsheets,   or documents from other OLE-com-
pliant applications.

Associated with each Batch Execution project is an actual project file.   This file stores project-related 
information. When you specify a project   in iFIX, you are selecting the project file you want to open the 
next   time the Batch Execution Server starts. As a result, you must   restart the iFIX WorkSpace and then 
the Batch Executon Server to load   the project you specify.
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Using the Electronic Books

This section describes how to:

 l Access electronic   books from iFIX. 

 l Use the table of   contents and the index for the document set, and the text and figures   in the 
books themselves. 

 l Search for information   across all iFIX books using the index or full-text search feature. Use   
Boolean, wildcard, and nested expressions for advanced full-text searches.   You can also limit 
the full-text search to previous results, match similar   words, or search topic titles only. 

 l Print individual   topics from electronic books. 

 l Hide or show the   frame that contains the Contents, Index, and Search tabs. 

 l Copy text and paste   it into another application, such as Microsoft Word. 

 l Create a personalized   list of favorite Help topics using the Favorites tab. 

Accessing Information in Electronic Books 

You can access the electronic books:

 l In the WorkSpace   tree, by double-clicking the Help and Information folder.

 l On the Help menu   in any iFIX application, by clicking Electronic Books.

 l For WorkSpace and   Database Manager only: In Ribbon view, from the Help list, located on   the 
right, near the minimize button. 

 l By clicking the Start   button, pointing to Programs, iFIX, and then Electronic   Books.

You can display the Contents, Index, or Search navigation tools in the   left frame by clicking the appro-
priate tab. Text and graphics in the electronic   book appear in the frame on the right side of the screen. Ini-
tially, the    collapsed table of contents is displayed in the left frame and the cover   page is displayed in the 
right frame.

Electronic Book Buttons 

The following buttons are displayed at the top of the electronic book   window.
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Electronic Book Toolbar   Buttons

Hide/Show   – Lets   you toggle the display of the frame that contains the Contents, Index,   and Search 
tabs.

Locate   – Displays   the contents heading that corresponds to the current topic.

Back   – Displays   the last topic that you accessed.

Forward   – Displays   the next topic in a previously viewed sequence.

Stop   – Stops   downloading file information if you are connected to the Internet.

Refresh   – Reloads   the current file if you are connected to the Internet.

Print   – If   the Contents tab is displayed, provides options for printing pages, headings,   sub-topics, or the 
entire table of contents. If the Index or Search tab   is displayed, allows you to print the current topic.

Using the Table of Contents 

You can navigate through the electronic books using the tables of contents.   The Contents tab appears 
on the top of the left frame. 

From the Contents tab, you can:

 l Double-click the   book title to expand the table of contents and display section titles   in the book. 
The closed book icon changes to an open book icon. 

 l Click the plus (+)   icon to the left of a section title to display subsection titles within   that section. A 
chapter or section is completely expanded when the minus   (-) icon appears to the left of the title. 

 l Click a topic title   to display that topic in the right frame. 

You can fully expand the table of contents by right-clicking anywhere   within the left frame and selecting 
Open All from the menu. Likewise,   you can fully collapse the table of contents by right-clicking the left   
frame and selecting Close All from the menu.

The following figure shows a fully-expanded table of contents.
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Electronic Book with a   Fully-Expanded Table of Contents

Searching Electronic Books 

You can search for topics in the iFIX electronic books by using either   the Index tab or the Search tab:

Index   – Lets   you search all iFIX books for topics by keyword. The index displays entries   that match or 
begin with the keyword.

Search   – Lets   you search all iFIX electronic books for a specific text string. A list   of all topics that con-
tain that search string is displayed. 

 To find a topic using the index:   

 1. Open the iFIX Electronic   Books. 

 2. Click the Index tab   to display the master index for the electronic books. 

 3. Enter the keyword   for which you want to display topics. As you enter the word, the topic   list 
scrolls to display the first topic that begins with or matches the   keyword you entered. 

 4. Click Display to   display the topic in the right frame, or double-click the topic. 

 To find a topic using full-text search:   

 1. Open the iFIX Electronic   Books. 

 2. Click the Search   tab to perform a search for a text string throughout all electronic books.   

 3. Enter the text for   which you want to search. For more information, refer to the Refining   Your 
Search section. 

 4. Click List Topics.   

 5. Select the topic   that you want to display and click Display, or double-click the topic.   

Refining Your Search
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When you search for a word in the iFIX electronic books, you obtain   a list of all topics in which that word 
appears. If you enter more than   one word, every topic that includes all of the search words appears in   the 
topics list. There are several ways to refine your search: 
Using Quotes to Define a Phrase

Enclosing multiple words in quotes generates a list of topics in which   that phrase appears.

For example, if you enter the search string:

database blocks

in the Search tab, the topics list includes all topics in which both   words appear. The words can appear in 
any order anywhere in the topic   text.

If you enter:

"database blocks"

enclosed in quotes, the topics list only includes those topics in which   the exact phrase (or slight vari-
ations, such as database block) appears   in the topic text.

NOTE: Be aware   that if the text you search for contains the words AND, OR, NOT, or NEAR,   you must sur-
round the search phrase with quotes, or quotes surrounded   by parentheses.  Otherwise,   these words will be 
treated as search operators, and the expected topic(s)   will not be found in the search.  For   example, both of 
the following search strings should find the appropriate   topics:

"items not supported"
("items not supported")

Searching with Wildcard Expressions

You can use the * symbol to search for multiple unknown characters in   a word or phrase. You can also 
use the ? symbol for a single unknown character   in a search. For example, the entry iW* would display 
iWebServer and iWebCast.   The entry ?DO would display topics for both ADO and RDO.
Defining Search Terms

The AND, OR, NOT, and NEAR operators enable you to precisely define   your search by creating a rela-
tionship between search terms. 
Using Nested Expressions

Nested expressions allow you to create complex searches for information.   For example, "control AND 
((active OR opc) NEAR window)" finds   topics containing the word "control" along with the words "act-
ive"   and "window" close together, or containing "control"   along with the words "opc" and "window" close 
together.   

The basic rules for searching Help topics using nested expressions are   as follows: 

 l You can use parentheses   to nest expressions within a query. The expressions in parentheses are   
evaluated before the rest of the query. 

 l If a query does not   contain a nested expression, it is evaluated from left to right. For example:   
"Control NOT active OR opc" finds topics containing the word   "control" without the word "active," 
or topics containing   the word "opc." On the other hand, "control NOT (active   OR opc)" finds top-
ics containing the word "control" without   either of the words "active" or "opc." 

 l You cannot nest expressions   more than five levels deep. 
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Using Other Searching Methods

There are three other options available for searches at the bottom of   the search window that you can 
click. These options are as follows:

 l Search   titles only: Allows you to search for words in the titles of HTML   files. 

 l Match   similar words: Enables you to include minor grammatical variations   for the phrase you 
search. For example, a search on the word "add"   will find "add," "adds," and "added." This   feature 
only locates variations of the word with common suffixes. For   example, a search on the word 
"add" will find "added,"   but it will not find "additive." 

 l Search   previous results: Enables you to narrow a search that results in   too many topics found. 
You can search through your results list from a   previous search by using this option. If you want 
to search through all   of the files in a Help system, this check box must be cleared. 

Determining Your Location within the Electronic Books

When you select a topic from the Search tab or from the Index tab, the   topic appears in the right frame 
while the left frame continues to display   either the search results or the Index. You can see the relative 
position   of the topic within the table of contents by clicking the Click to Show   Browse Buttons... link, 
and then clicking the Locate button from the electronic   books toolbar.

If you have the Contents tab displayed, the title of the current topic   is highlighted in the table of contents 
as you browse through the book.

Printing Electronic Books 

The steps that follow describe how to print from the electronic books.

 To print a single section: 

 1. Select the topic   that you want to print. 

 2. Click Print. 

 3. Click Print the Current   Page to print the selected topic. 

 4. Select the printer   and printer options, if necessary. 

 To print a topic from the Search   or Index tab: 

 1. Select the topic   or sub-topic from the list. 

 2. Click Print. 

 3. Select the printer   and printer options, if necessary. 

NOTE: If you want to   print an entire book or large sections of a book, use the associated .PDF   file and print 
from Acrobat Reader. Contact your Support representative   for more information on obtaining .PDF files.

Displaying or Hiding the Left Frame 
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You can choose whether or not to display the left frame, which contains   the Contents, Index, and 
Search tabs. To hide the left frame, click Hide.   To show the left frame, click Show.

Copying and Pasting Text from an Electronic Book to Another Application   

You can copy all or part of any topic in an electronic book and paste   it into any application that accepts 
text from the clipboard. For example,   you may want to copy an example from the Writing Scripts manual 
and paste   it directly into the Visual Basic Editor.

 To copy selected text in a topic:   

 1. Display the topic   from which you want to copy text. 

 2. Highlight the text   that you want to copy. 

 3. Press CTRL+C,   or right-click the highlighted text and select Copy. 

 4. Paste the text into   another application, such as Word. 

 To copy all of the text in a topic:   

 1. Display the topic   from which you want to copy text. 

 2. Press CTRL+A,   or right-click anywhere within the right frame and select Select All.   

 3. Press CTRL+C,   or right-click the highlighted text and select Copy. 

 4. Paste the text into   another application, such as Word. 

NOTE: You cannot copy   graphics from an electronic book.

Using the Favorites Tab 

The steps below explain how to add links to the Favorites tab in HTML   Help.

 To create a list of favorite Help   topics: 

 1. Locate the Help topic   you want to make a favorite topic. 

 2. Click the Favorites   tab, and then click Add. 

NOTES:

 l To return to   a favorite topic, click the Favorites tab, select the topic, and then   click Display. 

 l If you want   to rename a topic, select the topic, and then type a new name in the Current   topic 
box. 

 l To remove a favorite   topic, select the topic and then click Remove.
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